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About This Guide

This section describes the changes included in the PTC Windchill 11.0 FO00
release:

Deployment and Configuration—Relevant to administrators who deploy and
configure the target system.

End User—Relevant to administrators or trainers who create training for end
users of the target system.

Optionally Enabled Features—A new property that controls new features that
may impact the default user experience of established end-user capabilities.

~ Note
This area does not have any additions for PTC Windchill 11.0 F000.

PTC Windchill Workgroup Manager—Relevant to PTC Windchill Workgroup
Managers, which support the integration of authoring engineering applications
with PTC Windchill.
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This section of the PTC Windchill 11.0 FO00 PTC Windchill New and Changed
for This Release contains changes that are relevant to administrators who deploy
and configure the target system.
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Attribute Display: Graphical Attributes

Product: PTC Windchill

Benefit

Graphical attributes can be configured to provide “at a glance,” visual
representations of object information.

Additional Details

From the Type and Attribute Management utility, customers can now configure a
calculated attribute to display object information using one of three graphical
representations: a traffic light, progress bar, or percent complete bar:

Traffic Light Percent Complete Progress Bar

@ I I | |
® e N —

1
C:I S0% 25%: 25.0in [0 .. 100
T 0. 100] |
| I

Graphical attributes can represent persisted data, such as the life cycle state of an
object or data resulting from simple or complex calculations. Graphical attributes
can be displayed in tables, information pages, and create or edit windows.

As with any other attribute, users can add graphical attributes as a column on a
table by customizing the table view, remove or reposition the column, or sort the
column by value. If table content is exported (for example, to a spreadsheet) the
graphical attribute value is presented in the exported data as the tooltip text (for
example, Green, Yellow, or Red for a traffic light graphical representation). Users
can search for objects with specific values of the graphical attribute using the
tooltip text.

Business Administrative Change
Promotion Utility
Product: PTC Windchill

Benefit

The Business Administrative Change Promotion utility is enhanced to include
support for administrative objects, such as object initialization rules (OIR) and
Preferences, and improved filtering capability using XML files.

Deployment and Configuration
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Additional Details

The following enhancements have been made to the business administrative
change promotion utility for this release:

Feature PTC Windchill |PTC Windchill
10.2 M030 11.0 FO00
Import/Export Selective Mode Yes Yes
Modes Selective Mode - Yes
Advanced Filtering
Synchronized Yes Yes
Mode
Administrative Policy Access Yes Yes
Object Types Control Rules
Profiles Yes Yes
Preferences — Yes
Object - Yes
Initialization Rules
(OIRs)
Conflicts and Conflict handling |Yes Yes
Reports and resolution
Preview Change | Yes Yes
Report
Import package to | — Yes
multiple targets
Detail Import - Yes
Report
Override default | — Yes
conflict resolutions
on import
Interface Command Line Yes Yes
Scripts

Enhance filtering capabilities through a Spec XML file to export all or specific
administrative changes for all supported objects. In addition to using identity
attributes of an object as filter criteria, you can filter objects at a container level
using a GlobalContainerCriteria tag in the Spec file.

Enhance conflict handling capabilities through a conflict resolution XML file. The
XML file enables you to specify a collection of resolution information for
potential conflicts.
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CAD Data Management: Bulk Build Utility
for Parts Related to CAD

Product: PTC Windchill PDMLink

Benefit

A new bulk build utility enables you to migrate large numbers of parts from
external systems and manage your entire eBOM in PTC Windchill PDMLink with
support for associative links to existing CAD data.

Additional Details

The utility is command-driven, runs in a Windchill shell with the server still
running, and accepts an input file containing a list of either CAD documents or
PTC Windchill parts as the build source. The utility always builds the latest
iteration of a part and does not modify non-latest iterations. This utility is
available on any new or upgraded PTC Windchill 11.0 server.

CAD Data Management: CAD Documents
Revise Only the Latest Version of
Associated Windchill Parts

Product: PTC Windchill PDMLink

Benefit

When a Windchill part is associated to a CAD document with a contributing
image, image, or contributing content link, the CAD document now uses a build
process that updates only the latest part version. This enables you to revise a
Windchill part without having to artificially revise its associated CAD document
to prevent a build error on the next checkin of the CAD document.

Additional Details

This behavior is consistent and supported across all actions that spawn a build
process. Legacy data is supported without the need to upgrade.

CAD Data Management: Configure Auto
Associate to Automatically Find Matching
Windchill Parts

Product: PTC Windchill PDMLink
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Benefit

You can now configure the Auto Associate action to automatically find matching
Windchill parts using the CAD document’s base number.

Additional Details

Two new server-side preferences control this behavior:

* Operation » General » Base Number Regular Expression

e Operation » Auto Associate » Auto Associate Find and Create Part Using Base
Number

If no matching parts are found, a new part is created (if allowed). If the Base
Number Regular Expression is invalid, an error is presented.

CAD Data Management: Creo Design
Exploration Files Supported in PTC
Windchill as CAD Documents

Product: PTC Windchill PDMLink

Benefit
TMU files are fully supported in PTC Windchill as a CAD document object type.

Additional Details

Previously, Creo Design Exploration files were only supported in PTC Windchill
as secondary content that had to be attached manually by the user to the top level
object in the product structure. Now, TMU files are supported as an EPM
document. Support for these files as CAD document objects enables rename and
prevents loss of associativity and design data.

CAD Data Management: Synchronizing a
New CAD Document Number with its
Related Windchill Part Base Number

Product: PTC Windchill PDMLink

Benefit

When creating a new CAD document, a new Same As Part Number checkbox in
the New Part window enables you to synchronize the number of the CAD
document with the base number of its related Windchill part. When selected
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(checked), the resulting CAD document number is set the same as the base
number of the related Windchill part, with or without a file extension, based on a
server-side preference.

Additional Details

If the PTC Windchill preference Drop File Extension from Number is set to No (the
default), then the file extension in the CAD document template (for example, .prt,
or .asm), is included with the part number. Setting this preference to Yes drops
the file extension.

CAD Data Management: Updating CAD
Document Usage Link Line Number and

Find Number Attributes During a Reverse
Build

Product: PTC Windchill PDMLink

Benefit

If you modify the Line Number or Find Number attributes in the Uses tab on a PTC
Windchill part information page, you can now choose to update the same
attributes on the usage link for the accompanying CAD document when the part is
used to perform a reverse build of the CAD structure.

Additional Details

This behavior is only supported for NX and PTC Creo 2, 3, and 4. EPM Service
preferences must be set on the PTC Windchill server to enable this behavior.

Change Associations: Deprecated APls

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill Integrations
for Embedded Software

Benefit

To support change associations, several APIs have been deprecated and several
supported APIs have been updated. Changes have also been made to workflow
events and preferences.
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Additional Details

The following APIs have been deprecated. PTC recommends that you replace
them with the new APIs when you are starting to convert to use change
associations. These APIs are primarily located in WorkflowProcessHelper
and StandardChangeService?2.

Deprecated API

Replacement API

com.ptc.windchill.pdm
link.change.server.
impl.WorkflowProces
sHelper.forcePRsToRe
solved (ChangeRe
quest?2)

com.ptc.windchill.pdmlink.chan
ge.server.impl.WorkflowProces
sHelper.closeChangeChildren (Ob
ject, Map<Class, State>)

com.ptc.windchill.pdmlink.chan
ge.server.impl.WorkflowProces

sHelper.closeChangeParents (Ob

ject, Map<Class, State>)

com.ptc.windchill.pdm
link.change.server.
impl.WorkflowProces
sHelper.setCRResolu
tionDate (ChangeRe
quest?2)

com.ptc.windchill.pdm
link.change.server.
impl.WorkflowProces
sHelper.setECNResolu
tionDate (ChangeRe
quest?2)

com.ptc.windchill.pdm
link.change.server.
impl.WorkflowProces
sHelper.setECNResolu
tionDate (ChangeRe
quest2, String)

com.ptc.windchill.pdm
link.change.server.
impl.WorkflowProces
sHelper.setPRResolu
tionDate (Changelssue)

com.ptc.windchill.pdmlink.chan
ge.server.impl.WorkflowProces
sHelper.setResolutionDate (Versio
nableChangeltem)

18
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Changes were also made to service APIs to support change associations. These
APIs are located in StandardChangeService2. PTC recommends that you
review any extensions or usages of these APIs before you start to use change
associations:

* getAssociatedChanges (ChangeltemIfc, Class)

* getChangeOrders (ChangeRequestIfc, boolean)

* getChangeRequest (ChangeOrderIfc, boolean)

* deleteAddressedBy (ChangeRequestIfc, ChangeOrderIfc)
* saveAddressedBy (ChangeRequestIfc, ChangeOrderIfc)

* getlLatestChangeOrder (ChangeRequestIfc)

* getlatestChangeRequest (ChangeOrderIfc)

* deleteAddressedBy (WTCollection, role)

* deleteFormalizedBy (ChangeRequestIfc, Changelssuelfc)
* getChangeIssues (ChangeRequestIfc, boolean)

* getFormalizingChangeRequest (ChangeIssue ci)

* saveFormalizedBy (ChangeRequestIfc, ChangelIssuelfc)
* getChangeRequest (Changelssuelfc, boolean)

* deleteFormalizedBy(Class, ChangeRequestIfc,
Changelssuelfc)

* getLatestChangeIssue (ChangeRequestIfc cr)
* getlLatestChangeRequest (ChangeAnalysisIfc)

The Change Notice State Change workflow event has been replaced by the
following workflow events:

* Parent Change Object State Change
* Child Change Object State Change

The following change management preferences perform no action for flexible
change items; however, they remain functional for non-flexible change items to
support backwards compatibility:

* Change Request to Problem Report Cardinality
* Change Request to Change Notice Cardinality
* Change Notice without Change Request

* Automatic Change Notice Creation

The following links have been replaced by ChangeProcessLink. When
creating or deleting these links for change associations, use the
FlexibleChangeHelper.getService ().

* AddressedBy2
* AddressedByIlfc
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* FormalizedBy
* FormalizedByIfc

Desktop Integration: Enhanced DTI
Installer
Product: PTC Windchill

Benefit
The PTC Windchill Desktop Integration installer has been updated and rewritten.

Additional Details

The PTC Windchill Desktop Integration installer has been rewritten to provide
more options and better support for updating an existing installation.

Windchill 10.2 M0O30 Windchill 11.0 FOO0
1) Windehill Desktop Integration 10.2 MO30-CPS04 (x54) - TnstallShield Wizard @ 13 PTC Windchill Desktop Integration 11.0 FO0D (x54) Setup o| 2=
Welcome to the InstaliShield Wizard for
Windchill Desktop Integration 10.2 Welcome to the PTC Windchill
MO30-CPSD4 (x64) Desktop Integration 11.0 FOO0D
The Instalshieki(R) wizard wil instal Winddhill Desktop (x64) Setup Wizard
Integration 10.2 MO30-CPS04 (x64) on your computer. To
contnue, dick Next., The Setup Wizard will install PTC Windchill Desktop
Integration 11,0 FOOO (x64) on your computer, Clidk Next to
continue or Cancel to exit the Setup Wizard,
WARNING: This program i protected by copynight law and
ntemational treaties.
PTC
=) (e me () (o)

* Silent and remote installation is still supported, with additional support for
Microsoft System Center Configuration Manager (SCCM).

* A new autoupdate feature automatically prompts the user to update DTI when
the installed version does not match the server version.
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The installation process includes a new step that prompts the user to provide
their PTC Windchill server URL and alias. This step is optional, and does not
appear if a server is already connected and configured.

15 PTC Windchill Desktop Integration 11.0 FO00 (x64) Setup o @

Windchill

Spedfy Windchill server information pTC I

Windchil Server URL: ||

Windchil Server Alias: |

Back ][ Mext ] [ Cancel
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You can now select separate Microsoft Office applications for which you want

to install Desktop Integration:

Custom Setup

‘_ﬁ! PTC Windchill Desktop Integration 11.0 FOOD (:64] Setup

Select the way you want features to be installed.

(=)= =]
pic |

I =l Outlook
(=0~ | Word

B {Qv| Office Integration

o = ~ | PowerPoint
- Q"I Explorer Integration

Click the icons in the tree below to change the way features will be installed.

This feature requires 25MB on your
hard drive. It has 4 of 4
subfeatures selected, The
subfeatures require 40KE on your
hard drive.

Browse...

[ Reset ][

Disk Usage

J

Back ][ Mext J [ Cancel

)

When the installation is complete, a Windchill Documents bookmark is

automatically added to Favorites:

4.7 Favorites
Bl Desktop
& Downloads

Windchill Documents

Benefit

As part of discussion enhancement work, several changes are being implemented
that impact wt.workflow.forum APIs and properties.

~

ﬂ Windchill

L —

Discussions: APl and Property Changes
Product: PTC Windchill ProjectLink, PTC Windchill FlexPLM
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Additional Details

The following changes have been made to wt.workflow.forum.ForumUtil
methods:

API: countPostingsForTopicSinceLastVisit
A new API retrieves the number of new posts since a particular user’s last
visit.
If there are no new posts since the last visit (a count of 0), the API does not
return any data.

/*
* @paramobjects : List of discussion topic objects
* @param userPrincipal : The user to check unread
posts against
* @return List of HashMap : The HashMap key set
is: (LAST POST_DATE, UNREAD POST COUNT, DISCUSSION TOPIC)
* @throws WTException
*/

public static List <HashMap<String, Object>

> countPostingsForTopicSincelastVisit (List objects,
WTPrincipal userPrincipal) throws WTException

With the implementation of countPostingsForTopicSinceLastVisit, the
following APIs are deprecated:

@Deprecated
public static HashMap<String,Object> getUnreadPostDetails

(WTPrincipal userPrincipal,DiscussionTopic topic)

@Deprecated
public static HashMap<String,Object> getUnreadPostDetailsForTopic
(WIPrincipal userPrincipal,DiscussionTopic topic, TopicVisitData topicVisitData)

@Deprecated
public static HashMap<String,Object> countPostingsForTopicSincelLastVisit
(DiscussionTopic topicObject,Timestamp lastVisitedTime)

API: getVisitDataOfUserForTopics
The following API is deprecated:

@Deprecated
public static TopicVisitData getTopicVisitDataByUserAndTopic

(WTPrincipal userPrincipal,DiscussionTopic topic)
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Instead, you can use the existing getVisitDataOfUserForTopics method to
retrieve topic visit data when given a user and a list of topics:

/*

* @param userPrincipal : The user for which to retrieve
visit data

* @param topiclList : List of discussion topic objects

* @return HashMap : Key = DiscussionTopic, Value =
TopicVisitData

* @throws WTException
*/

public static HashMap getVisitDataOfUserForTopics
(List objects, WIPrincipal userPrincipal) throws WTExceptior

The following changes have been made to properties set in wt . properties:

Property: wt.workflow.forum.ReplyToComment.enabled
This is a new property in PTC Windchill 11.0 FO00. This property applies only
to non-FlexPLM systems:

De- false

fault

Synop- | Enable or disable the Reply to Comment action for the Discussions
sis table in a non-FlexPLM system.

De- This property is available in wt . properties and is used to
scrip- |control the Reply to Comment action in a non-FlexPLM system.
tion If set to t rue, users can reply to posted comments.

Property: wt.workflow.forum.TreeViewAndReplyPosting.enabled
This is an existing property; however, starting in PTC Windchill 11.0 F000,
this property applies only to FlexPLM systems:

De- true

fault

Synop- | Enable or disable the Tree View and the Reply to Comment action for
sis the Discussions table in a FlexPLM system.

De- This property is available in wt . properties and only applies to
scrip- |FlexPLM solutions.

tion Use this property to control the availability of the Tree View and the

Reply to Comment action for the Discussions table.

If set to true, users can reply to posted comments and display the
discussion using the Tree View.
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Property: wt.workflow.forum.CreateDefaultTopics.enabled
This is an existing property. Starting in PTC Windchill 11.0 FO00, however,
the default value is false; previously, the default value was true.

De- false

fault

Synop- | Enable or disable the creation of default topics and comments in the
sis Discussions table.

De- This property is available in wt . properties and is used to

scrip- |control the creation of default topics and comments. By default this
tion |property is set to false, meaning that default topics and comments
are not created. When set to t rue, default topics and comments are
created when the Discussions table is viewed.

These default topics and comments are defined in
DiscussionForumTemplate.

Document Management: Java Applet
Upload and Download Mechanisms
Removed

Product: PTC Windchill

Benefit

The Java applet upload and download functionality has now been entirely
replaced by an HTML framework.

Additional Details

PTC Windchill is no longer supporting the Java applet functionality for uploading

and download content files. This affects two preferences available through the
Preference Management utility:

* File Download Mechanism

The Use Java applet functionality to download filesoption has been removed
from the list of possible values.

* File Upload Mechanism
This preference has been removed.

In PTC Windchill 10.2 M020, a new drag-and-drop upload functionality was

introduced. This enhancement allowed users to upload content using drag-and-

drop without requiring a Java plugin. Users who still wanted to use the Java
drop target had the option of setting the File Upload Mechanism
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preference to Use Java applet functionality to select and upload files. Now, the
Java target is no longer an option; instead, all drag-and-drop actions are
supported through basic browser functionality.

¢ Java Console Debugging Information Display

This preference is now obsolete and has been removed.

Download Events Enabled OOTB in

Auditing Administration
Product: PTC Windchill

Benefit

Download events have been turned on out-of-the-box in Auditing Administration,
which enables customers to be more aware of when information is being
downloaded from the system. Increased awareness of download anomalies can
alert customers when their IP may be at risk.

Additional Details

Download and View Representation events are now tracked out-of-the-box in
Auditing Administration for PTC Windchill. Increased download events of
potentially sensitive information from the system can alert customers when their
IP may be at risk from an attacker. Previously, administrators needed to configure
Auditing Administration to track Download and View Representation events.

Error Page Stack Trace Report Off by
Default

Product: PTC Windchill

Benefit

The user error report stack trace option is now turned off out of the box by default.
This change removes visibility of stack trace information to end users and
improves security in PTC Windchill.

Additional Details

Previously, when an end user was presented with an error page, the stack trace
was displayed to provide useful details for troubleshooting. Now, the
wt.servlet.errorPage.omitStackTrace property is set to true out of
the box and stack trace information is omitted from error pages. This change
improves security by making potentially sensitive information no longer visible to
end user.
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ES| Enhancements
Product: PTC Windchill

Benefit

PTC Windchill Enterprise Systems Integration (PTC Windchill ESI) has been
updated to support new capabilities and configurations to enhance your integration
experience.

Additional Details

PTC Windchill ESI now supports integration with SAP ECC6 — EHP7 and Oracle
Applications EBS 12.2.4.

In addition, PTC Windchill ESI provides the capability to publish the following
items from PTC Windchill to ERP systems:

* Variant configuration logic like Option Sets, Choice Rules, and Expressions
assigned to the Bill of Materials (BOM)

* Production BOMs for a resource
» Enterprise data
*  Only material information

* Plant localization links

Also through PTC Windchill ESI, you can configure PTC Windchill in the
following ways:

* Create a baseline while publishing information to the ERP systems

» Filter out subassemblies by making use of business rules while publishing
BOMs to ERP systems

Info*Engine Adapters: DOORS Adapter

Retirement
Product: PTC Windchill

Summary
The Info*Engine adapter for DOORS is retired.

Additional Details

The documentation for this adapter is no longer available in the PTC Windchill
Help Center or on the Reference Documents website for 11.0 and beyond.
Additionally, orderability for this adapter has ceased.
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For an alternative approach, contact your PTC representative to discuss using
Integrity LM as an option to integrating with DOORs.

Interoperability: Configure Scheduled

Synchronization in Projects
Product: PTC Windchill PDMLink, PTC Windchill ProjectLink

Benefit

New configuration options are available to administer the scheduled
synchronization feature for projects.

Additional Details

The following configuration options support the new scheduled synchronization
feature available for projects. For more information on this enhancement, see
Interoperability: Scheduled Synchronization for Shared Objects on page 105.

wt.dataops.sandbox.autoUpdateProject.autoUpdateSchedu
ledTime

Name wt.dataops.sandbox.autoUpdateProject.
autoUpdateScheduledTime

Default 2\:00

Synopsis Sets the time for when shared objects in a project are

automatically synchronized.

Description Projects that are configured to synchronize automatically
are updated on a daily basis. Use this property to set the
time each day that the project should synchronize.

Use a 24-hour format when specifying the time; for
example, to perform the automatic synchronization at 6:45
P.M., enter 18\ :45.

The default value is 2 : \ 00, meaning that the
synchronization job executes at 2:00 A.M.

wt.queue.PoolQueue.ProjectUpdateProcessingQueue. thread
PoolSize
By default, this property is not set. For more information on setting this
property, contact the PTC Technical Support performance tuning team.

Name wt.queue.PoolQueue.ProjectUpdateProcessingQueue.
threadPoolSize
Default <not set>
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Synopsis Determines whether project auto synchronization jobs are
run as single or multi-threaded.
Description This property accepts integer values:

» Ifnot set, or if set to a value less than or equal to 1, the
autosynchronization job is run as single-threaded.

+ Ifsetto a value greater than 1, the auto synchronization
job is run multi-threaded using the specified number of
threads.

~ Note

When configured as multi-threaded, PTC Windchill
attempts to start as many threads as the value
specifies; however, resources might be restricted by
the server operating system, which could result in
fewer threads than specified.

Project Synchronization Users
This is a new out-of-the-box group available at the Site level.

Populate this group with users who can act as the Synchronization User for

projects.

The scheduled synchronization job synchronizes shared objects within the
parameters of this user’s permissions. If the user does not have the necessary
access to a shared object or to newly added dependents, then those objects are
ignored. If necessary, a user with appropriate permissions can later manually
perform the Update, Update Project or Update Selected Shares actions to
synchronize shared objects that have restricted access.

To synchronize a shared object, the user must have the following permissions:

* READ permission for the source PDM context

* READ permission for the source object

*  MODIFY permission for the SharedContainerMap object type (this is
granted by default to members of the Project Synchronization Users group)

~ Note

To share new dependents as part of the automatic synchronization, the user
must have READ, DOWNLOAD, and CHANGE PERMISSION
permissions for the new dependent objects.
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Sharing Folder
This is a new preference in the Preference Management utility. It is located

under Integral Operations.

L}

SItE
Site
Site
Site
Site

Site

that are being shared as part of a shared object

synchronization operation.

» If'the preference is set to a folder that does not exist in
the project, then the default location (root project folder)
is used instead.

¢ The folder name is case-sensitive.

Name Integral Operations » Sharing Folder

Default Root project folder

Visibility Project

Description This preference sets the default location of new dependents

* You can change the folder when performing a manual
synchronization operation.

To share new dependents, the synchronization user must
have READ, DOWNLOAD, and CHANGE PERMISSION
permissions for the new dependent objects.

Launching Applets in Chrome Browser
Product: PTC Windchill

Benefit
Most PTC Windchill applets continue to run in the Chrome browser, despite

recent restrictive changes to Chrome.
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Additional Details

For the Chrome browser, most applets now launch with Java Web Start.

~ Note

The Advanced Table Editor applet does not launch in Chrome. Use a different
browser for this applet.

Manage Security User Interface

Component Migrators
Product: PTC Windchill

Benefit

Members of profiles and roles that were previously able to view the Manage
Security action are able to view the Edit Access Control and Edit Security Labels
actions. Two required migrators set the visibility of the Edit Access Control and
Edit Security Labels actions, which are replacing the Manage Security action,
based on your settings for the Manage Security action in roles and profiles in the
current installation.

Additional Details

Two new migrators are a required part of the upgrade process that transfers your
settings for visibility of the Manage Security action to make the Edit Access
Control and Edit Security Labels actions visible to the appropriate roles and
profiles. The Manage Security window is renamed Edit Access Control and the
Security Labels tab is now a separate window named Edit Security Labels. The
Manage Security action has been removed and the Edit Access Control and Edit
Security Labels actions now appear directly on the Actions menu. For more
information on these user interface changes, see Manage Security Action and
Window Renamed on page 111.
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~ Note

Customers who have security labels enabled saw the Manage Security window
renamed and split into Edit Access Control and Edit Security Labels windows
in PTC Windchill 10.2 M030. Manage Security appeared on the Actions menu
as a label group with submenu actions Edit Access Control and Edit Security
Labels. In this release, these customers will observe that the Manage Security
action has been removed, with the Edit Access Control and Edit Security
Labels actions now appearing directly on the Actions menu.

Administrators are able to separately manage visibility of the Edit Access Control
and Edit Security Labels actions when creating or editing a profile, and when
configuring actions for roles from a team page.

Administrators and developers who work with container templates and
customizations will see changes to the Ul Component element PROJECT _
ACCESS CONTROL, which is the uiComponent element name for the Manage
Security action. It is now replaced with elements named EDIT ACCESS
CONTROL and EDIT SECURITY LABELS.

The following migrators have been added:

Enable Visibility of Edit Access Control and Edit Security Label Actions to
Replace Manage Security Action
This migrator sets the visibility of the new Edit Access Control and Edit
Security Labels actions for roles and profiles within PTC Windchill based on
the settings for the Manage Security action in the current installation.

Split Manage Security Ul Component (UIC) into Edit Access Control and
Edit Security Labels UICs in Context Templates
This migrator updates all context (container) templates to replace the Manage
Security action with the Edit Access Control and Edit Security Labels actions,
within UI component elements defining profile and role-based visibility
settings.

New Recommendation for Encryption Key
Length

Product: PTC Windchill

Benefit

You can better protect sensitive data by implementing PTC’s new
recommendation to increase the length of an encryption key.
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Additional Details

PTC recommends modifying the length of the encryption key used to protect
sensitive information, from 128 bits to 256 bits. The default value for the
wt.intersvrcom.siteSecurity.encryptionKey.keyLength
property must be modified using the xconfmanager utility. This change should
be made immediately after successfully upgrading to or a new installation of PTC
Windchill 11.0.

Options and Variants: Converting
Assigned Expressions to Independent

Expressions
Product: PTC Windchill PDMLink, Platform Structures

Benefit

You can now use a PTC Windchill utility to convert previously created assigned
expressions to independent expression. This utility is available only to members of
the Platform Structures module.

Additional Details

You can now use a PTC Windchill utility to convert previously created assigned
expressions to independent expression. The conversion utility converts only the
dependent expressions assigned to usage links and occurrences for the latest
iteration of the revisions for parts that have assigned expressions. The utility
provides a mechanism for a business administrator to set up a mapping between
configurable module life cycle states and independent assigned expressions life
cycle states. Once you successfully run this utility, the system is configured to
create independent expressions only.

To convert dependent expressions, use the
com.ptc.windchill.option.tools.ConvertToIndependentEx
pression utility.

~ Note

This utility is available only to members of the Platform Structures module.
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Oracle Database Encryption Using

Transparent Data Encryption
Product: PTC Windchill

Benefit

PTC Windchill now supports using Oracle Transparent Data Encryption (TDE) to
protect data at rest.

Additional Details

Protect data at rest by turning on Oracle Transparent Data Encryption (TDE).
Encrypting the data in the PTC Windchill database prevents data visibility from
unauthorized access. This provides an additional layer of protection for your
intellectual property and reduces the overall attack surface of your PTC Windchill
solution.

Both existing and new PTC Windchill databases can be configured to use TDE.

Part Structure: Defining Valid Context
Types for Service Effectivity

Product: PTC Windchill Service Information Manager, PTC Windchill Service
Parts

Benefit

PTC Windchill Service Information Manager allows administrators to define valid
service effectivity contexts. When these contexts are defined, only valid contexts
are presented when searching for context objects in the Manage Applicability
window.

Additional Details

Administrators can define valid service effectivity contexts by entering a type in
the ServiceEffectivityConfig.xml file.

<ServiceEffectivityContextTypes>
<Type>wt.part.WTPart|com.acme.myServEffContext</Type>
</ServiceEffectivityContextTypes>

34 PTC Windchill® What s New



When users apply filters in the Advanced Search option on the Service Effectivity
tab in the Edit Filter window or the Add Service Effectivity window, the Advanced
Search option limits the search to the types corresponding to the properties
defined in the ServiceEffectivityConfig.xml file. If there are no values
in the file, the system defaults to WITPart as the only valid context.

Advanced Search X

Search On: |AII Applicable Types |V|

All Applicable Types -
Number: AL L
MName: Cantent Holde N

D Search Clear
Number Name : : race Code State
oK Cancel

» If'the authoring system is only for InService, it should be configured to only
allow product hierarchy roots and product hierarchy nodes as valid contexts.
This eliminates any confusion or mistakes from authors creating invalid data.

+ If the authoring system is for both InService and other business cases,
customers should include both of these types in the list of supported types.
Data with invalid effectivity contexts is sent to InService. InService ignores
any invalid effectivity records, which could result in invalid applicability
being displayed in the delivery system. Data management processes should be
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implemented to ensure valid data is being sent to the delivery system.
Segregating data intended for delivery from data intended for other purposes
could minimize confusion.

» If'the authoring system is not authoring data for InService, there is no need to
restrict the valid effectivity context unless customers have specific business
processes that call for this.

Part Structure: Thumbnail Images
Product: PTC Windchill PDMLink

Benefit

Now you can add thumbnail images of parts to the attributes under the Structure
tab of part information pages.

Additional Details

The Attributes tab under the Structure tab of a part information page can include a
thumbnail image of the part.

| Attributes | Classification || Visualization |

=l Part Attributes

Thumbnail: ;-
e

Number: GCO00001

Name: GOLF_CART

Version: A2 (Design)

State: In Work - Released - Canceled
Status: Working copy, checked-ocut to you
Meodified By: Site, Administrator

Last Modified: 2015-07-13 08:10 CDT
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An administrator must use the Type and Attribute Management utility to add the
Thumbnail attribute to the part structure attributes layout.

| Acions ~ | % Type - Part Q
Internal Name: whpart WTPart
Display Name: ]
Descripti &
Ieon: I ] @
Yes
N
Layouts
Layouts + 2]
Part Structure Attributes
*Name: *Screen Types:
[ ]
Descriptio
Avaiable Attributes & 7 o e B D

ALL_SOFT_CLASSIFICATION_ATTRIBUT ~ IThumbnal\ | ~ | Group Display Name:

O]

alINonS chemaNlonClassifcationhinus! Organization Name 2| Group Description:

ALLsort scraa aTTBUTEs 2] | e ‘

L]

‘Awaiting Promotion Modified By

BOM Type - Lest Modified
< | Assigned Item Expression

& Manage Quantity of Messures

With the addition of thumbnail images, your site may choose to hide the
Visualization tab on part information pages. For more information, see Part
Structure: Visualization Tab Preference on page 124.

Preferences and Properties
Product: PTC Windchill

Benefit

Several preferences and properties have been changed in, added to, or removed
from PTC Windchill.

Additional Details

The following preferences (listed by functional area) have been changed in, added
to, or removed from PTC Windchill:

Func- Sta-
tional Name Description Default Value
tus
Area
CAD |Auto Associate Configures the Auto
Data Find and Create | New | Associate action to No
Part Using automatically find matching
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Man-
age-
ment

Base Number

Windchill parts using the
CAD document’s base
number. For more
information, see CAD Data
Management: Configure
Auto Associate to
Automatically Find Matching
Windchill Parts on page 15.

Base Number
Regular
Expression

New

Configures the Auto
Associate action to
automatically find matching
Windchill parts using the
CAD document’s base
number. For more
information, see CAD Data
Management: Configure
Auto Associate to
Automatically Find Matching
Windchill Parts on page 15.

[P\ D™

CAD
Document
Structure
Related
Information

New

Show and hides related
information in CAD
document structures. For
more information, see Part
and CAD Document
Structure Related
Information Display on page
116.

The Show button
displays related
parts.

Drop File
Extension from
Name

New

Includes file extension in the
CAD document template
with the part name. For more
information, see CAD Data
Management: Support for
Autonumbering CAD
Documents With a File
Extension Included on page
88.

No

Drop File
Extension from
Number

New!

Includes file extension in the
CAD document template
with the part number. For
more information, see CAD
Data Management:
Synchronizing a New CAD
Document Number with its
Related Windchill Part Base
Number on page 16.

No
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This preference has been

change items to support

Use the new removed. For more
Edit De- |information, see CAD Data N/A
Attachments leted | Management: Edit
Tool Attachments User Interface
on page 25.
Improves performance when
loading and opening large
CATIA gxg (;ad. Cha- CATIAVS ass;:mblies. For
V5 method.upon. | nged more information, see Full
open CATIA V5: Asynchronous
Download Preference Option
on page 179.
Performs no action for
flexible change items;
Change howeyer, they remain '
Request to Cha- functloqal for non-flexible
Problem Report | nged change items to support No
Cardinality back\yards corppatlblhty. For
more information, see
Change Associations:
Deprecated APIs on page 86.
Performs no action for
flexible change items;
Change howeyer, they remain .
Request to Cha- functlon_al for non-flexible
Change Notice |nged change items to support No
ch Cardinality backwards compatlblllty. For
ange more information, see
Associ- Change Associations:
ations Deprecated APIs on page 17.
Performs no action for
flexible change items;
however, they remain
Change Notice Cha- functional for non-flexible
without Change noed change items to support Yes
Request 8% backwards compatibility. For
more information, see
Change Associations:
Deprecated APIs on page 17.
Performs no action for
Automatic Cha- flexible change items;
Change Notice nged however, they remain Yes
Creation functional for non-flexible
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backwards compatibility. For
more information, see
Change Associations:
Deprecated APIs on page 17.

Docu-
ment
Man-
age-
ment

File Download
Mechanism

Cha-
nged

The Use Java applet
functionality to download
files option has been
removed from the list of
possible values for this
preference. For more
information, see Document
Management: Java Applet
Upload and Download
Mechanisms Removed on
page 25.

File Upload
Mechanism

De-
leted

This preference has been
removed. For more
information, see Document
Management: Java Applet
Upload and Download
Mechanisms Removed on
page 25.

N/A

Java Console
Debugging
Information
Display

De-
leted

This preference has been
removed. For more
information, see Document
Management: Java Applet
Upload and Download
Mechanisms Removed on
page 25.

N/A

Intero-
perabil-

ity

Sharing Folder

New

Sets the default location of
new dependents that are
being shared as part of a
shared object
synchronization operation.
For more information, see
Interoperability: Configure
Scheduled Synchronization
in Projects on page 105.

Root project
folder

Object
Actions

Delete

New

Controls the default behavior
for the Delete action. For
more information, see Delete
Preference on page 95.

Delete all
iterations of each
object included
in the table

Move

New

Controls the default behavior
for the Move action. For

Move all
versions of
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more information, see Move |displayed objects
Preference on page 115.
Enables you to select only
those parts you want to view

Incremental LT

oo on the Visualization tab. For
Loading in . )
. o New | more information, see Part No
Visualization g
Tab Structure: Visualization Tab

Incremental Loading on page
123.

Show and hides related
information in part

The Show button

Part Part Structure structures. For more displays related
Struc- |Related New |information, see Part and documents, CAD
ture Information CAD Document Structure documents, and
Related Information Display |replacements.
on page 116.
Hides the Visualization tab
that appears under the
T Structure tab on part
Visualization . .
Tab Display New mformat;on pages. For more |Yes
information, see Part
Structure: Visualization Tab
Preference on page 124.
Enables the launch points for
Product the PSE applet that are now
Struc- |Enable Product hidden by default. For more
ture Structure New |information, see Product No
Explor- | Explorer (PSE) Structure Explorer
er Functionality Included In
Part Structure on page 48.
Ensures that PTC Creo View
representations for the
related top level instances are
regenerated by the PTC
PTC Windchill Visualization
Creo | Update Top New | Service, reflecting the correct | No
Ele Level Instances geometry. For more
ments/ information, see PTC Creo
Direct Elements/Direct Modeling:
Model Improved Top Level Instance
ng Visualization on page 185.
Manage Top Cha- iAllows you to request top Modi fied
evel instance generation
Level Instances |nged Only

irrespective of instance data

Deployment and Configuration
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changes. For more
information, see PTC Creo
Elements/Direct Modeling:
Improved Top Level Instance
Visualization on page 185.

Automatically
lock objects
added to
workspace

New

Automatically locks
checked-in objects in the
Modeling session and the
workspace. For more
information, see PTC Creo
Elements/Direct Modeling:
Locking or Unlocking
Objects in Workspace or
CAD Application on page
186.

PTC
Wind
chill
Cus-
tomer
Experi-
ence
Man-
age-
ment

Aging Bracket

New

Sets the values of aging
brackets. For more
information, see PTC
Windchill Customer
Experience Management:
Aging and Cycling Reports
on page 131.

30, 60, 90,
120

Search

Enable Related
Object Search

New

Displays the Related Object
Search field on the Advanced
Search page. For more
information, see Search:
Properties and Preferences
on page 60.

No

Enable Search
Facets

New

Displays facets with the
Search Results table. For
more information, see
Search: Properties and
Preferences on page 60.

No

Securi-

ty
Labels

Security Label
Changes on
Object Versions

New

Determines which object
versions to which security
label changes are applied.
For more information, see
Security Label Preference for
Object Versions on page 65.

Display all
versions option
not selected

Access
Permission
Configuration

Cha-
nged

Determines if users can see
or update permissions
throughout PTC Windchill.

Hide
(default for the
new Modify
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A new value, Modify
Security Labels, has been
added. For more information,
see Modify Security Labels
Permission on page 113.

Security Labels
value only)

Determines if users can see
or update permissions

information, see Service
Translation: Representation
for Root Included in
Translation Package on page
163.

Access throughout PTC Windchill. Iajf:ult for the
Permission Cha- | A new value, Modify new Modif
Configuration |nged |Security Labels, has been Securit La}lloels
(PDM) added. For more information, value 02]11 )
see Modify Security Labels Y
Permission on page 113.
Includes in the translation
package the default
representation for the service
structure and any default
. representations for the Include th
%ﬁgls(ie Include Cha- | dynamic documents in the drécfalllﬂte ©
lation Representation |nged |structure. For more representation

The following properties (listed by functional area) have been changed in, added
to, or removed from PTC Windchill:

Func- Sta- o
tional Name tus Description Default Value
Area
Enables or disables the
Reply to Comment
wt.work action for the
flow. for Discussions table in a
um.ReplyTo |New [non-FlexPLM system. |false
Comment.en For more information,
Discus- |abled see Discussions: API
sions and Property Changes
on page 22.
wt.work Enables or disables the
flow. for Cha- | Tree View and the
um.TreeVie nged Reply to Comment true
wAndReply action for the
Posting.en Discussions table in a
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abled

FlexPLM system. For
more information, see
Discussions: API and
Property Changes on
page 22.

wt.work
flow. for

Enables or disables the
creation of default
topics and comments
in the Discussions

gm;:rii;e I(fhea(i table. For more false
eltau © g information, see
Ei CZ -ena Discussions: API and
< Property Changes on
page 22.
Sets the time for when
shared objects in a
wt.da .
taops.sand project are
b ’ foU automatically
do}ti ) ‘;u ovb N synchronized. For 2\ :00
aterrojec ®W | more information, see :
t.autoUpda I e,
nteroperability:
teSchedu
LedTs Configure Scheduled
edrime Synchronization in
Intero- Projects on page 105.
perabil- -
ity Determines whether
wt.queue. project auto
PoolQueue. synchronization jobs
ProjectUp are run as single or
dgteProces New multl-_threaded.. For <not set>
sing more information, see
Queue.th Interoperability:
readPool Configure Scheduled
Size Synchronization in
Projects on page 105.
com.p ]Elnab};s 1qdeX1ng f(})lr
te.wind lc;as51 1cat}o? sears es.
chill.oart or more information,
PTC slink Ii)n New |see PTC Windchill true
Wind |4 ) PartsLink: Properties
ex.ena
chill bled and Profiles on page
Part 54.
sLink |com.p Displays all node
tc.wind N attributes as columns £a1
chill.part ®Wlin the Search Results atse
slink.show table, regardless of
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NodeColumn search criteria. For
s.enabled more information, see

PTC Windchill

PartsLink: Properties

and Profiles on page

54.

Determines the
com.p maximum number of
tc.wind suggestions in the
chill. Classification field list
search. on the advanced search
client.max |New page. For more 15
ResultsClf information, see PTC
PickerSug Windchill PartsLink:
gest Properties and Profiles

on page 54.
classifica This property has been
tionTable. removed. For more
defaultCo De- |information, see PTC
lumns.wt. |leted|Windchill PartsLink: |N/A
part.WT Properties and Profiles
Part on page 54.
com.p This property has been
tc.wind removed. For more
chill.part | De- |information, see PTC
slink.max |leted|Windchill PartsLink: | N/A
BrowseCo Properties and Profiles
lumnCount on page 54.
com.p This property has been
tc.wind removed. For more
chill.part | De- |information, see PTC
slink.de leted | Windchill PartsLink: N/A
faultBrows Properties and Profiles
eRootNode on page 54.

This property has been

removed. Replaced
com.p with
tc.wind com.ptc.wind
chill.part chill.search.
slink.floa |D€ floatingPoint N/A
tingPoint leted PrecisionOffset.
Precisio For more information,
nOffset see PTC Windchill

PartsLink: Properties

and Profiles on page
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54.

com.p This property has been
tc.wind removed. For more
chill.part | De- |information, see PTC
slink.refi |loted|Windehill PartsLink: |~/
neCount Properties and Profiles
Threshold on page 54.
Ezmwi}n q This property has been
chill.part ?emoved.. For more
clink . ena De- 1nf.ormaF10n, see PTC N/A
b1leCommon leted Wlndchlll PartsLink:
ValueAttri Properties and Profiles
bute on page 54.
Ezmwlfn d This property has been
chill.part ?emoved: For more
clink . dis De- 1nf'0rmaj[10n, see PTC N/A
playName leted Wlndchlll PartsLink:
Numbe rO Properties and Profiles
£ACLS on page 54.
com.p Deﬁne attributes for'
tc.wind Whlchafumre date is thePersistlIn
chill. %nvahd. Eor more fo.createStamp,
search. fu New |information, see thePersistInfo.
tureDateAt Search: Properties and modifyStamp
tributes Preferences on page
60.
Defines the limit for
com.p the number of objects
te.wind processed when
chill.sear searching on object
ch.rela New ?elationships. For more |<not set>
Search |t3on Query information, see
Limit Search: Properties and
Preferences on page
60.
Enables the keyword in
wt . index.e gontext tpol. For more
nableText |New information, see false
Preview Search: Properties and
Preferences on page
60.
wt.index. Content holder object
supported |New |types that support the wt.doc. WIbocu
TypesFor keyword in context ment
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TextPre

tool. For more

view information, see
Search: Properties and
Preferences on page
60.

com.p Maximum number of

tc.wind results to display under

chill.

an attribute group. For

t.errorPa

stack trace information

search.fa |New |more information, see |5
cet.enum. Search: Properties and
maxItemsTo Preferences on page
Display 60.
com.p Maximum number of
tc.wind

. faceted results to check
chill. .

against access control.
search.fa . .

New | For more information, |500
cet.maxRe .

see Search: Properties
sultCount

and Preferences on
ForAcces ace 60
sCheck pag )
com.p Offset value to use
tc.wind when calculating
chill. tolerance. For more
search. New | information, see 0
floating Search: Properties and
PointPreci Preferences on page
sionOffset 60.

Functionality has been
com.p extended to control the
tc.wind availability of the null
chill. and is not null
search. Cha- | operators in the drop- false
queryBuil |nged|down menu. For more
der.enable information, see
NullCrite Search: Properties and
ria Preferences on page

60.

. Determines the length
wt.1ln .
of an encryption key.
. |tersvrcom. : .
Securi- | - : For more information,
siteSecuril
ty t New |see New 128
y.encryp :
Infra- ; Recommendation for
tionkey. Encryption Key Length
struc- keyLength MY Y g
ture on page 32.
wt.servle Removes visibility of
true
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ge.omit Cha- |to end users and
StackTrace |nged|improves security in
PTC Windchill. For
more information, see
Error Page Stack Trace
Report Off by Default
on page 26.
com.p Sets security labe} By default, this
fe. wind Va}ues on new objects property is not
S - |enitl. using the Workspace |included in
eeurt- Check In window. For |wt .properties. To
ty uwgm.cadx. |New . . . . .
: more information, see |use this functionality,
Labels |checkin.Se .
curityLabe Security Labels Set add the property to
1Editing With Workspace Check wt.properties and
In on page 83. setitto true.
Allows users to toggle
between line number
Service . and name. For more
Struc- | °° ; t IkS)B YL I New information, see true
ture neiumber Service Structure:

Information Structure
Ordering on page 160.

Product Structure Explorer Functionality

Included In Part Structure
Product: PTC Windchill PDMLink

Benefit

Functionality for part replacements and visualization that was previously only in
the Product Structure Explorer (PSE) Java applet is now available from the
Structure tab on part information pages.

Additional Details

Enhanced functionality related to the following areas is now available for the
Structure tab on part information pages:

* part replacements on page 119

* thumbnail images on page 36

* actions on the Visualization tab on page 122

* hiding the Visualization tab on page 124
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Previously, this functionality was available only in Product Structure Explorer
(PSE). As a result, the launch points for the PSE applet are now hidden by default
and are enabled through a preference. Navigate to the Utilities page for the
organization or site and click Preference Management. Select PSE » Enable
Product Structure Explorer (PSE) and change the setting to Yes. (However, this
preference is temporary; in a future release, PSE will be removed from PTC
Windchill PDMLink.)

PTC Windchill Business Reporting:
Cognos Version Support Change

Product: PTC Windchill

Summary

With PTC Windchill 11.0, PTC Windchill Business Reporting now supports
Cognos Business Intelligence 10.2.2.

PTC Windchill Business Reporting no longer supports HP-UX.

Additional Details

After installing 11.0, customers using PTC Windchill Business Reporting must
download and install Cognos 10.2.2 Fix Pack 2.

Customers using PTC Windchill on HP-UX must install and configure PTC
Windchill Business Reporting on a non HP-UX system, such as Windows or
Linux. For more information on supported platforms, see the PTC Windchill 11.0
Software Matrices, available from the PTC.com website here: http://support.ptc.
com/view?im_dbkey=167201.

PTC Windchill CAPA: Access Control

Rules
Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill CAPA

Benefit

Migrators have been added to enable features from previous maintenance releases.
The Windchill Upgrade Manager allows administrators to automatically execute
the migrators for access control rules instead of only being able to load the rules
manually.
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Additional Details
The following new processes have been added to the CAPA module:

* Create actions and initiate them prior to the planning state.
* Confirm the effectiveness of a CAPA after all actions are completed
» Revert the CAPA to the Investigation state when effectiveness fails

Administrators must either manually load the access control rules for the
CAPAActionPlan and CAPAChangeActivity objects or allow the migrator
in the Windchill Upgrade Manager to load these rules into the existing quality
container and template.

Object Group Permission
CAPAActionPlan CAPAREQUESTER ALL
CAPAActionPlan CAPAREVIEWER ALL
CAPAActionPlan CAPAINVESTIGATOR ALL
CAPAActionPlan CAPAMANAGER ALL
CAPAActionPlan CAPAVERIFIER Modify
CAPAChangeActivity CAPAREQUESTER ALL
CAPAChangeActivity CAPAREVIEWER ALL
CAPAChangeActivity CAPAINVESTIGATOR ALL
CAPAChangeActivity CAPAMANAGER ALL

Regardless of whether you manually loaded the access control rules or ran the
migrator, you must manually assign Create, Modify, and Modify Content
permissions. These permissions allow users to create a CAPA request if they add
an action to the Action table in the New CAPA Request window. Previously, team
members had Read and Download permissions for the CAPAActionPlan
object.

Object Group Permission

CAPAActionPlan teamMembers Create

Modity

Modify Content
Read

Download

PTC Windchill Customer Experience

Management: Access Control Rules

Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill
Customer Experience Management

50 PTC Windchill® What's New



Benefit

Migrators have been added to enable features from previous maintenance releases.
The Windchill Upgrade Manager allows administrators to automatically execute
the migrators for access control rules instead of only being able to load the rules
manually.

Additional Details

The Returned Product Processing object is now managed by policy access control
rules. The rules are loaded at the Root level, which grants all users all permissions
to the Returned Product Processing object. You can customize these rules at the
container level.

To use these processes, administrators must either manually load the rules or allow
the Windchill Upgrade Manager to execute the migrator to load these rules.

Object Group Permission
CEDecontamination teamMembers Read
CEDecontamination COMPLAINT PRODUCT RECEIVER ALL
CEDecontamination COMPLAINT MANAGER ALL

Regardless of whether you manually loaded the access control rules or ran the
migrator, you must manually assign Modify and Modify Content permissions.
These permissions allow the customer experience creator to edit the intake node
from the customer experience structure.

Object Group Permission
CustomerExperience |COMPLAINT CREATOR Modify
Modify Content

PTC Windchill PartsLink: Autonaming

Rules
Product: PTC Windchill PartsLink

Benefit

Classification administrators can configure rules to automatically generate
classification part names.
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Additional Details

An Autonaming Rule tab has been added to the classification node information
page:

Actions ~ | R Class - Part 2]

Autonaming Rule

= Autonaming Properties

Autonaming Rule: | |

Rule Measurement System: | |

Enforce Autonaming Rule: | |

From here, you can set the following properties:

Autonaming Rule Enter a rule to use when generating the name for a
classified part.

Rule Measurement The measurement system to use for converting

System attribute values when generating the classified part
name.

Enforce Autonaming You can use this field to enable or disable the

Rule autonaming rule.

Autonaming rules are inherited. You can disable or modify autonaming properties
on child nodes.

When you create a part and specify a node that has an autonaming rule enforced,
the following changes appear in the New Part window:

52

Any text provided in the Name field is removed and replaced with a
(Generated) placeholder:

MName: (Generated)

You can allow users to override the generated name using the Override Name
profile action introduced in 11.0 FO00. For more information, see PTC
Windchill PartsLink: Properties and Profiles on page 54.
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PTC Windchill PartsLink:

ClassificationReportGenerator
Product: PTC Windchill PartsLink

Benefit

The ClassificationReportGenerator API allows administrators to locate parts
that do not comply with autonaming rules.

Additional Details

Now PTC Windchill has autonaming rules for classified parts. For more
information , see PTC Windchill PartsLink: Autonaming Rules on page 51.

To support this, ClassificationReportGenerator allows an administrator to
generate a report that returns all parts that do not comply with an enforced
autonaming rule. For more information on supported APIs, see the Windchill
Javadoc.

PTC Windchill PartsLink:
CSVToXMLGenerator Utility

Product: PTC Windchill PartsLink

Benefit

A new utility transforms a CSV file to the classification structure XML format,
which can then be imported into Windchill PartsLink.

Additional Details

To import a classification structure, the classification structure must be outlined in
an XML file. Now, you can transform a CSV file into an importable XML file.

To transform a CSV file to an importable XML file, execute the following
command from a Windchill shell:

Windchill com.ptc.windchill.csm.csvtoxml.CSVToXMLGenerator <path to CSV file> -verbose

1 Note
* The verbose parameter is optional and should be used for debugging
purposes.

» The utility is not access controlled.
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PTC Windchill PartsLink: Properties and

Profiles

Product: PTC Windchill PartsLink

Benefit

Properties and profiles support new end user features.

Additional Details

To support classification search enhancements, the following configuration
options are now available:

com.ptc.windchill.partslink.index.enabled

Default true
Synopsis Enable indexing for classification searches.
Description When enabled, indexing is enabled for classification

searches.

~! Note

The Find Similar Parts action is not available when
indexing for classification searches is disabled.

com.ptc.windchill .partslink.showNodeColumns.enabled

Default

false

Description

Display all node attributes as columns in the Search Results
table, regardless of search criteria.

This applies to searches performed from the Classification
field on the advanced search page and from the Keyword
field in the classification explorer.

com.ptc.windchill.search.client.maxResultsClfPickerSug

gest
Default 15
Description When using the Classification field on the advanced search

page, a list of suggestions appears as you enter a node
name. Use this property to determine the maximum number
of suggestions in the list.

=l Classification

[Part Classification |v| [FASTENER | £ @ =
|PartC|355ificatic:n |l| m Loy AP
BOLT (@) Part/Mechanical Parts/FASTENER/EOLT

EYEBOLT (6] Part/Mechanical Parts/FASTENER/BOLT/EYE B
TBOLT (0] Part/Mechanical Parts/FASTENER/BOLT/T BOI
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Find Similar Parts

A new Find Similar Parts profile action is available.

Use this option to control access to the Find Similar Parts action through user

profiles.

Override Name

A new Override Name profile action has been added to support autonaming
rules. For more information, see PTC Windchill PartsLink: Autonaming Rules

on page 51.

When this action is enabled, a Preview Name link appears under the Set
Classification Attributes step. From the Preview Name window, the user can
select the Override Name option.

=I Profile Actions

Profile Action Mame

(157 objects )

Search in table e '@
Product Library |Project |Program |Global

View Checked Out Work page on Home tab -
View Hot Links
Manage Global Enumerations |:|
Classification Search
Find Similar Parts |
Owerride Mame r
Wiew Calendar

The following properties are obsolete and have been removed:

classificationTable.defaultColumns.wt.part.WTPart

com.ptc.windchill.
com.ptc.windchill.
com.ptc.windchill.

set (replaced with
com.ptc.windchill

com.ptc.windchill

com.ptc.windchill.

com.ptc.windchill.

Deployment and Configuration

partslink.maxBrowseColumnCount
partslink.defaultBrowseRootNode
partslink.floatingPointPrecisionOff

.search.floatingPointPrecisionOffset)
.partslink.refineCountThreshold

partslink.enableCommonValueAttribute

partslink.displayNameNumberOfACLs

55



Queue Management: Delete Queue Entry

Action Enhanced
Product: PTC Windchill

Benefit

The delete action for queue entries has been enhanced to make the service more
robust and responsive.

Additional Details

Previously, when a queue entry was deleted, the queue itself was stopped to
complete the deletion. Now, the enhanced delete action does not need to stop or
interrupt the queue to delete queue entries. Queue entries that are executing when
they are deleted are immediately removed from the queue, but will run to
completion before the queue moves on to execute the next entry.

Query Builder and Report Builder

Enhancements
Product: PTC Windchill

Benefit

The Report Management and Query Builder utilities are now implemented using
HTML. With this conversion comes a redesigned user interface, updated QML
processing, tools for advanced report authors, and enhanced usability. The Report
Builder and related functionality have also been updated in support of these
enhancements.

Additional Details

The updated QML (query markup language) format provides more seamless
integration with the Report Builder user interface when users run reports and lays
the groundwork for future enhancements.

Report templates authored in previous PTC Windchill releases are automatically
upgraded to use the current QML format when accessed for the first time, either
by viewing the report in Report Builder, or by editing the report template in Query
Builder. No additional action is required from users or administrators to upgrade
report templates to the current QML format.
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The applet-based Report Management utility accessed from the Utilities page of
various contexts has been reimplemented using HTML as the Report Templates
table.

Previously
Report Last Modified Context  Description [ e
Project tasks 20150807 11:52C... Site (This report template is part of ... | «
Project summary act... | 2015-08-07 11:52 C... Site [This report bemplate is part of a...
Project status epp 20150807 11:52C... Site This report template is wtofa...l -1 1 0 FOOO
Project plan delvera.., | 20150807 11:52 C... Site [This report template is part of ...
Project plan activites | 2015-0840'
Praject plan action it...|[2015-080] = Report Templates Defaun (138 obgect
Praject miastones 2015-080] -
Project deiverstles _[wis080] & % ' & & & o se I8 -
Project sctivities 2015080] () Name 1 Last Modified Contedt | Description
Projectaction items _|2015-080] oAt i
Processes Initated ... [2015-080] (L] PartsReportaddQml [}  201509.11 18:13 CDT Site Parts report for testing QML modification
prablem Report Infl... 20150801 () papopeportaddTimerest D) 2015.00.11 1813 CDT Site Parts report flor testing QML modification of time vall
{Chverdue Running Pr.., | 2015-08 40
IOpen Problem Reperts (20150801 [£) partsReportBasicFieiaTest [}  200509.11 1813 CDT  Site Farts report for testing basic fields in Report Builder
e e T Lt | [C] PartsReportClearFormTest [ 20150911 18:13 COT Site Parts report for testing dear form
fOpen Change Notices | 2015-080/ .
+ Reoork - wor.... | 2015-0840 D PartsRepamDateTest L) 201540911 1813 CDT Site Parts report for testing dates
D PartsReportEnumerationsTest L) 201509-11 18:13 CDT  Site Parts report for testing enumeration:
[E) partsReportiayoutTest {) 20050911 1813 CDT  Site Farts report for testing layout of a Report Builder pa
o L/ 0 13y
[E] PartsReportMultipleConstraintTest i 20150911 18:13 CDT  Site Parts report for testing basic fields with muttiple oo
P L 9 L
[F) partsReporthultipleConstraintTestlegac.. (1)  201509-11 1813 COT Site Parts report for testing basic fields with multiple can
D PartsReportNoSectionsLayoutTest 2015409-11 18:13 COT Parts report for testing layout of a Report Builder p

The Report Templates table lists all report templates available from the current
context, and provides the launching point for the Query Builder by creating a new
report template, or choosing to edit an existing report template.

The new Query Builder Maintenance Dashboard, launched from the Report
Templates table, provides administrators the ability to view the upgrade status of
all report templates in a particular context and perform proactive upgrades on
report templates from previous releases.

Query Builder Maintenance Dashboard

I} [Tl upgrade in Legacy Mode | Upgrade in Single Date Mode UndoUpglade] [ValidaleQMl Filter table Q
Report Template Name ~ 4 Upgraded _; Eligible for Upgrade ; Date Upgraded 4 Date Last Modified _ Date Last Run
All Average Change Notice Compl... Mo Yes 2015-09-11 17:40:52 CDT

All Average Change Request Com... Mo Yes 201540911 17:40:52 CDT

All Average Problem Report Comp... Mo Yes 2015-09-11 17:40:52 CDT

All Change Motice Influx And Res... Mo Yes 201540911 17:40:52 CDT

All Change Request Influx And Re... Mo Yes 2015-09-11 17:40:52 CDT

All Open Change Motices Yes Yes 2015-09-15 10:30:45 CDT 201540911 17:40:52 CDT

All Open Change Requests Mo Yes 2015-09-11 17:40:52 CDT

All Open Problem Reports Yes Yes 2015-09-14 10:24:25 CDT 201540911 17:40:52 CDT

All Problem Report Influx And Res... Mo Yes 2015-09-11 17:40:52 CDT
AllReportAttributesFromViewTest  Yes Yes 2015-09-11 19:39:52 CDT 201540911 18:13:36 CDT
AllReportAttributesTest Yes Yes 2015-09-16 03:26:10 CDT 2015-09-11 16:13:42 CDT 2015-09-16 03:20:14 D7
AllReportattributesTest_14420263... Yes Mo 2015-09-11 21:53:38 CDT
AllReportAttributesTest_14420442.., Yes Mo 2015-09-1202:52:14 CDT
AllReportAttributesTest_14421304... Yes Mo 2015-09-13 02:48:01 CDT
AllReportAttributesTest_14422169... Yes Mo 2015-09-14 02:50:40 CDT
AllReportAttributesTest_14423035... Yes Mo 2015-09-1502:52:45 CDT
AllReportAttributesTest_14423900... Yes Mo 2015-09-16 02:54:34 CDT
AllReportAttributesViewTest Yes Yes 2015-09-16 03:47:52 CDT 2015-09-11 18:13:36 CDT

Average Change Notice Completi.. Mo Yes 2015-09-11 17:40:52 CDT
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Additional upgrade modes are available from the Query Builder Maintenance
Dashboard for those report templates from prior releases which administrators
want to be presented as they were in previous releases.

The Validate QML action available from the dashboard validates the QML of new
or upgraded report templates against the current database schema. The dashboard
also displays the date on which a given report template was last run. This
information is useful in determining if report templates have been recently used,
or are unused and can be considered for removal.

The Java applet-based Query Builder utility from earlier releases has been replaced
with a redesigned and enhanced HTML user interface.

Previously

11.0 FOO0

6t Rapeort Tomplats - Project plas scsivitie
[ oo RESCTRTRY oiec o Cumsinn | s | vt | o |

Enhancements to the Query Builder include:

» The Tables and Joins tab provides a graphical interface for adding and viewing
tables and joins in a single tab, including the ability to drag-and-drop tables for
easier viewing.

*  Where available, information and help links are provided when adding types
or report templates to the Tables and Joins tab, providing hover-over
descriptions and links to additional documentation, such as Javadoc or
knowledge base articles.

» The Criteria and Select or Constrain tabs are now presented in a more readable
tabular style.
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The Select or Constrain tab is now used to specify all items that appear on the
Report Builder criteria pane. New functionality is available to control how
attributes are displayed in the Report Builder, including whether they are
available for the user to specify criteria, and whether they are automatically
included in the report results.

On the Tools tab, enabled by a preference, advanced report authors can now
view the QML of the current report template. There is also a query results
preview action, allowing for a quick preview of the currently defined report
template, without needing to run the report in the Report Builder.

The Report Builder has been enhanced to support the updated QML format.
Changes include:

The updated QML on the criteria pane of the Report Builder now supports
parameter values. Parameter values are no longer displayed in a separate Input
Parameters section. They are now included in the main criteria pane, along
with the other reportable items specified on the Select or Constrain tab of the
Query Builder.

Constants specified for items on the Select or Constrain tab of the Query
Builder are now included in the main criteria pane, and no longer segregated in
a separate Constants section.

Time stamps can now also be specified along with date fields in the criteria
pane, if the report template has been defined to include them on date fields.

A Generate action launch point has been added to the results pane, allowing
users to generate updated results without needing to access the criteria pane.

New developer tools, enabled by preference, are available for advanced report
authors to view the QML of the current report, and to view the QML and SQL
as modified by user selections and entries on the criteria pane.

When a report is opened in Report Builder, the attributes in the first section of
the criteria pane are all automatically selected, and so are included in the
report results when the report is generated. If there are no sections in the
report, all attributes are automatically selected. This does not affect saved
reports; only the attributes selected when the report was saved are selected
when the report is run.

Constraint operators such as like and not like can now be used with the pipe
character ( | ) for entering multiple values.

Search: Indexing Administration Utility
Product: PTC Windchill

Benefit

A new PTC Windchill Index Search utility makes it easier to view the status of the
PTC Windchill search index.
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Additional Details

A new Indexing Administration utility has been added to Site = » utilities »
Business Administration.

The Indexing Administration utility is a table that provides an overview of the
index status, categorized by type.

= | Current Index Status M (85 ohjects )
Actions - Search in table | P @
Object Type Processed Remaining Mo Policy Failed Total
Total Objects 1,620 0 0 0 1620 it
EPM Document 46 0 0 0 46 E|
Part 571 0 0 0 571

Document 110 0 0 0 110

Report Template 57 0 0 0 57

Choice 13 0 0 0 13

Product 7 0 0 0 7

Cption 4 0 0 0 4

Exclude Rule 3 0 0 0 3

Parts List 2 0 0 0 2
Variant Specification 2 0 0 0 2 i

This tool is similar to selecting option 7 from the Bulk Indexing Tool. However, it
also provides the following enhancements:

» Indexing number totals are categorized by object type.
» The ability to export the information to different file types.
» The following table views are available:

No Policy Objects—A list of objects that are not indexed because the object
type does not have an indexing policy.

Failed Objects—A list of objects that were not indexed, and the corresponding
error message for each object.

Objects for Which Content Indexing Failed—A list of content holder objects
whose content was not indexed, and the corresponding error message for each
object.

Search: Properties and Preferences
Product: PTC Windchill
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Benefit

Search properties and preferences support new end user features.

Additional Details

To support advanced search enhancements, the following configuration options
are now available:

com.ptc.windchill.search. futureDateAttributes

Default thePersistInfo.createStamp,
thePersistInfo.modifyStamp

Synopsis Define attributes for which a future date is invalid.

Description Use this property to provide a comma-separated list of date

attributes for which future dates are invalid.

As a result, when the attribute is added to the search
criteria, “Tomorrow” is hidden in the drop-down value list.

~ Note

Modelled and soft attributes are supported. Use the
internal name of the attribute when supplying the
property value.

com.ptc.windchill.search.relationQueryLimit
This property has been added to support the new search feature allowing users
to search by object relationships. For more information, see Search: Related
Object Searches on page 154.

Default <not set>
Synopsis Defines the limit for the number of objects processed when
searching on object relationships.

Description This property limits the number of objects processed when
performing a relationship search. If this property is not set,
then the relationship search processes all objects.

This property does not apply when performing a keyword
search or a latest version search.

wt.index.enableTextPreview
This property supports the keywords in context feature. For more information,
see Search: Keywords in Context on page 150.
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Default false
Synopsis Enables the keyword in context tool.
Description This property determines whether the keyword in context

functionality is available to users. When set to t rue, the
Text Preview column is available to users when creating
custom table views from the Search Results table.

The Text Preview column includes a document preview tool
1. Hover over the tool icon * to view a preview where the
keyword appears in file content.

After enabling this preference, you must re-index the data
before the preview tool can be used.

wt.index. supportedTypesForTextPreview
This property supports the keywords in context feature. For more information,
see Search: Keywords in Context on page 150.

Default wt .doc.WTDocument

Synopsis Content holder object types that support the keyword in
context tool.

Description Specity any additional objects types for which the keyword

in context tool is enabled.

When the wt . index.enableTextPreview property
is set to true, the Text Preview column is available to users
when creating custom table views from the Search Results
table.

com.ptc.windchill.search. facet.enum.maxItemsToDisplay
This property supports the new faceted search results functionality. For more
information, see Search: Faceted Results on page 148.

Default 5

Synopsis Maximum number of results to display under an attribute
group.

Description If the result set includes multiple values for an attribute, the

possible values are grouped under the attribute name. If
there are a large number of values to display, the Show All
link is displayed.

Use this property to define how many values to display
before providing the Show All link.

com.ptc.windchill. search. facet.maxResultCountForAcces
sCheck
This property supports access control for the new faceted search results

functionality. For more information, see Search: Faceted Results on page 148.
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Default 500

Synopsis Maximum number of faceted results to check against access
control.

Description This property specifies the maximum number of SOLR

results to check against access control rules before
rendering the search result facets. If the result count is less
than the specified limit, then facets are generated with only
accessible facet attribute values. If the result count is greater
than the specified limit, then facets are generated without
checking against access control rules.

The maximum limit should not exceed the
maxBooleanClauses property specified
in solrconfig.xml.

com.ptc.windch

ill.search.floatingPointPrecisionOffset

Default 0
Synopsis Offset value to use when calculating tolerance.
Description Configure how tolerance should be calculated for Real

Number and Real Number with Unitsvalues.

The tolerance value determines how range is calculated for
numbers.
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com.ptc.windchill. search.queryBuilder.enableNullCrite

ria
Default false
Synopsis Enable the is null and is not null operators in the advanced
search interface.
Description When set to t rue, the is null and is not null operators

appear as options when specifying search criteria from the
Advanced Search page:

aWD ¥ E

|N.3|T'e

|NLII“‘||3E"

i5 nu
Lis not nu

These operators are not valid when performing a
classification search or an indexed search. Instead, an error
message appears.

>~ Note

This property is not new; however, its functionality has
been extended to control the availability of the is null
and is not null operators in the drop-down menu.

Enable Related Object Search
This preference supports the new related object search functionality. For more
information, see Search: Related Object Searches on page 154.

Default

Visibility | Site

Descrip- Set this preference to Yes to display the Related Object Search
tion field on the Advanced Search page.

This field is available when you perform a search for a single
object type. You can use this field to select different reports on
object relationships. Once a report is selected, you are provided
with options to select. The options available depend on the
object and report type.

Enable Search Facets
This preference supports the new faceted search results functionality. For more

information, see Search: Faceted Results on page 148.
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Default No

Visibility | User

Descrip- Set this preference to Yes to display facets with the Search
tion Results table.

When using faceted search results, a Refine Results side panel
appears next to your search results. Use this panel to narrow
your search results by selecting or deselecting available object
attribute.

>~ Note

(Solr) is installed and enabled.

This preference is only functional if Windchill Index Search

Search: Solr and Tika Updates

Product: PTC Windchill

Benefit

Apache Tika and Apache Solr libraries supporting PTC Windchill Index Search
have been updated to the latest release.

Additional Details

Apache Tika toolkit has been updated from 1.6 to 1.9. Apache Solr has been
updated from 3.6.0 to 5.2.0.

Security Label Preference for Object

Versions
Product: PTC Windchill

Benefit

The Security Label Changes on Object Versions preference provides greater
control over how security label changes are applied to object versions.
Additional Details

The new preference Security Label Changes on Object Versions is used to
determine which object versions security label changes are applied to. The
preference is available from the Preference Management table under Security »
Edit Security Labels. This preference has the following options:

* Display all versions option selected
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Displays a preselected checkbox on the Edit Security Labels page. Users can

choose to apply security label changes to all versions by keeping the checkbox
selected or to edited versions by deselecting the checkbox.

Current Settings: Mo dependents, Latest : Warking

=| Object List | Az aList =  Default
BRRER AP RNEONE
__ Mame 1 Mumber ersion
.;"] ACdoc 1429415816928 0000000041 Al
.;"] SLDoc_ 1428812946856 0000000022 Al

(0 objects selected )

Display all versions option not selected

Displays a checkbox on the Edit Security Labels page that is not preselected.
Users can choose to apply security label changes to all versions by selecting

the checkbox or to edited versions by leaving the checkbox deselected. This is
the default value.

=| Object List Az alList *  Default

BRBRRBAYDHE R LK D T
Mame f

] Mumber Version | Legal Infom
.ﬂ ACdoc 1429415816928 0000000041 Al Mull
.ﬂ SLDoc 1428812946856 (000000022 Al Mull

( 0 objects selected )

Apply security label changes to all versions of the edited objects

* Always apply to edited versions

No checkbox or message is displayed. Security label changes are always
applied to edited objects.

66 PTC Windchill® What s New



Current Settings: Mo dependents, Latest : Warking

=| Object List Az 5 List = Default

LR APDHESLRABLYXZH R
__ Mame 1 Murmber Version |Legal In
IE] ACdoc 1429415816928 0000000041 Al Mull
IE] SLDoc_ 1428812946856 Q000000022 Al Mull

1

( 0 objects selected )

* Always apply to all versions

Displays a message on the Edit Security Labels page that security label
changes are applied to all versions of the object.

Current Settings: Mo dependents, Latest : Warking

= Object List  As 3 List *  Default -
BEBBAP DO D W E D N5 %3 U0 N H G o §
MName t Murnber Version |Legal Information Need To Know Exprort Contro
[E] ACdoc 1429415816928 0000000041 Al Mull |:| Null

[E] SLDoc 1428812946856 0000000022 Al Mull |:| Null

4

(0 objects selected )

(ﬁ The security label updates made in this table will be applied to all versions of the objects in the table rather than only the listed \.-ers'or)

Service Parts: Generic Parts Lists
Transformed to True Parts Lists When

Using Templates

Product: PTC Windchill Service Information Manager, PTC Windchill Service
Parts

Benefit

You can choose a service structure template in PTC Windchill Service Information
Manager when you are creating a new information structure or a new publication
structure.
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Additional Details

When a service structure is generated from a template and there are parts lists in
the structure, generic parts lists are transformed to true parts lists and inserted into
the structure.

Support Changes: Browser Support

Product: PTC Windchill

Benefit

To take advantage of new features and capabilities introduced with new browser
versions, and to remain current with browser versions that are no longer supported
by their own vendors, PTC routinely updates its list of supported browsers.
Additional Details

The following browsers are supported with PTC Windchill:

* Internet Explorer 11
* Mozilla Firefox ESR 38
*  Google Chrome 64-bit

Support for Internet Explorer 10 has been dropped, as Internet Explorer 10 is no
longer supported by Microsoft on our supported client operating systems.

For more information, see the PTC Windchill 11.0 Software Matrices, available
from the PTC.com website here: http://support.ptc.com/view?im dbkey=167201.

Support Changes: Database Support

Product: PTC Windchill

Benefit

Oracle and SQL Server database support with PTC Windchill has been updated to
align with current release levels and functionality.

Additional Details
Oracle Database 12¢ Release 1 (12.1.0.2) is supported with PTC Windchill.
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SQL Server database support updates:

* SQL Server 2012 and 2014 both allow a database instance to use a different
collation from the database master.

* Certain database columns have changed data types to align with SQL Server
support and recommendations:

0  The PTC Windchill BLOB and InlineBLOB data base columns now use
the varbinary (max) data type, replacing the image data type
deprecated by SQL Server.

O  The PTC Windchill Date, Time, and Timestamp database columns now use
the datetime?2 data type, rather than datetime, following the SQL
Server recommendation.

* SQL Server 2014 is now supported and bundled with PTC Windchill PDM
Essentials.

* SQL Server 2008 R2 is no longer supported.

For more information, see the PTC Windchill 11.0 Software Matrices, available
from the PTC.com website here: http://support.ptc.com/view?im dbkey=167201.

Support Changes: Java Support

Product: PTC Windchill

Benefit

To take advantage of new features and capabilities introduced with each new Java
release, and to remain current with Java releases that are no longer supported by
their own vendors, PTC routinely updates its list of supported Java releases. Each
Java release is fully tested on all PTC Windchill server platforms.

Additional Details

The following Java release is now supported on all platforms supported by PTC
Windchill:

» Java 8 (JDK and JRE)

For more information, see the PTC Windchill 11.0 Software Matrices, available
from the PTC.com website here: http://support.ptc.com/view?im_dbkey=167201.

Support Changes: Platform Support

Product: PTC Windchill
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Summary

To take advantage of new features and capabilities introduced with each new
platform release, and to remain current with platforms that are no longer
supported by their own vendors, PTC routinely updates its list of supported
platforms.

Additional Details
For this release, note the following supported server platform changes:

*  Support added:

© Red Hat Enterprise Linux (RHEL) 7 (64-bit)
O Solaris 11.2
* No longer supported:

O Red Hat Enterprise Linux (RHEL) 5
O Solaris 10 and 11

For this release note the following supported client platform changes:
*  Windows 10 is planned for post-release certification with 11.0

For more information on the most current server platform support, see the PTC
Windchill 11.0 Software Matrices, available from the PTC.com website here:
http://support.ptc.com/view?im_dbkey=167201.

Support Changes: Web Server and
Serviet Engine Support

Product: PTC Windchill

Benefit

PTC HTTP Server (powered by Apache) now uses Apache HTTP Server 2.4. PTC
Embedded Servlet Engine (powered by Apache) now uses Apache Tomcat 8.
Oracle iPlanet, also known in previous releases as Sun Java System Web Server
(SJSWS), and Microsoft Internet Information Server (IIS) 32-bit are no longer
supported with PTC Windchill.
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Additional Details

PTC HTTP Server (powered by Apache) now utilizes Apache HTTP Server 2.4,
the most current version.

1 Note
HP-UX systems must still use Apache HTTP Server 2.2.

PTC Embedded Servlet Engine (powered by Apache) now utilizes Apache Tomcat
8. Additional steps are required to configure the embedded servlet engine to
respond to remote hosts.

All new and upgraded installations of PTC Windchill are now configured with the
PTC HTTP Server. The previous ability to reconfigure an installation to use
Oracle iPlanet or the 32-bit version of Microsoft Internet Information Server (IIS)
is no longer present.

For more information, see the PTC Windchill 11.0 Software Matrices, available
from the PTC.com website here: http://support.ptc.com/view?im_dbkey=167201.

Terminology Update for Adobe Product

Product: WVS

Summary

Adobe changed the name of their product from Adobe LiveCycle to Adobe
Experience Manager.

Additional Details

The terminology change has been implemented in the Ul and in Installing and
Configuring Adobe Experience Manager Software topics in the Advanced
Configurations section in the PTC Windchill Help Center.

Type and Attribute Management

Enhancements
Product: PTC Windchill

Benefit

The Type and Attribute Management utility has been enhanced by moving
functionality previously in applets into the main HTML utility. Related
terminology has also been clarified.
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Additional Details

Enhancements include:

72

The Manage Reusable Attributes functionality is now accessed from the
navigation bar of the Type and Attribute Management utility. Previously, this
functionality was the Manage Global Attributes applet, and was launched from

the Manage Global Attributes icon -2 in the navigation pane toolbar.

Previously
Administratos k]
Boas sctons = | ] Type - Document
#  Mansge Types Internal Name: wit.doc WTDocument 9
22 Manage Global Attributes - Windows Intermet Explorer provided by IT GDS - j

Maﬂawe Global Alributes
BEX/ +R @

2% Altribute Roo
5 g A

11.0 F000

Hame: PFTC_GTOL_ALLAROUND_SYMBOL

o, " n r-a———

Administrator al

P Actons~ | Reusable Attribute - All Around Symbol
» Manage Types +
. *Internal Name: F

ﬁ Manage Global Enumerations  +

N Display Name:
40 ] Manage Reusable Attributes - R

= [Zg Root - Description:
# g 1123

3 ADW_DM_Attributes

3 Customization_Example_Att . -

~ Enterprise Data Logical Identifier: PIC_GIOL ALLAR

3 OVDemas

~3 PowerSystem Data Type: Boolean

) PTC_SYSTEM_ATTRIEUTES
.| All Argund Symbol

Allow jon rride

I e

The Name field from the applet is now named Internal Name.

As Organization is the only class is supported for reusable attributes with
Reference data types, the selection in the Data Type drop-down list when
creating a new reusable attribute has been renamed from Reference to
Organization Reference, and the Class Name field has been removed from the
user interface.

Along with this user interface change, the terminology has been clarified so
that the attributes defined through the Manage Reusable Attributes window are
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referred to as “reusable attributes,” while an attribute added to a type that is
based on a reusable attribute is referred to as a “global attribute.” The
organizers for reusable attributes are now referred to as “attribute organizers.”

The Manage Measurement Systems functionality is now accessed from the
navigation bar of the Type and Attribute Management utility. Previously, this
functionality was launched from the Manage Measurement Systems icon @ in
the navigation pane toolbar.

Previously
| Manage Measurement Systems | i
XS @
— 11.0 FO00
WKS Hame: CGS
gl Administrator [<]
uscs Actions = | Measurement System - CGS
# Manage Types +
" Name: CGs
B} Manage Global Enumerations |+
Description: " ¥
_{] Manage Reusable Attributes |+
N _a Manage Measurement Systems —

Electrical Current:

kas

MES Luminous Intensity:
* 5l

Mol ™ aadl o
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74

The Manage Quantities of Measure functionality is now accessed from the
navigation bar of the Type and Attribute Management utility. Previously, this
functionality was launched from the Manage Quantity Of Measures icon & in
the navigation pane toolbar.

Previously
Manage Quanlity of Measures
#X/S @
Acceleration -
Acthity | | Name: Acceleration
Angle - Plang . .
Angle - Solid Description:
-‘mqulal':’:ctelemﬂﬂﬂ Display Units: | Maasurement System Default 11.0 FO00
Angular Velocity CGS cmis**2
Area
Binary Size Administrator | i .
Capacity - Dry = - 2 Actans = | Quantity of Measure - Acceleration
Capacity - Liquid i .
Charge — HName: ACCEleration
= Manage Global Enumerations +
E"““‘ Description:
W L] Manage Reusable Attributes *

.-_a Manage Measurement Systems |+

Display Units
é} Manage Quantities of Measwre | -

© |acceleration -
5 Activity =

Angle - Plane Measurement System Default Ohwerride
© Angle - Solid T vt
= Angular Acceleration

fgum
Angular Veloeity — Ll

] sI 2
8j .
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Relationship constraints are now managed from the Relationship Constraints
tab of the information page for link types which support relationship
constraints. Previously, this functionality was found in the Manage
Relationship Constraints applet launched from the Manage Relationship

Constraints icon €2 in the navigation pane toolbar.

Previously

Addeminstrator 3|
dog s

w  Mansge Types

Actons * 0] Type - Document

Internal Name: wi.doC WITDocument

=4 8 Manage Relationship Constraints - Windows. Internet Explacer provided by IT GDS.

Manage Relationship Constraints

Dat Parert Type Child Types

e
a e VNSV

3 & Pan G pan 11.0 FO00
Daserine Link |
g;.sl-:l Adminstratos L
C e Acsers= | Type - Part Usage
e Rewis o MRS Tipes
i 5 I | Hame: wi BaAL WTPSAL Eagel
5 Do HUSI00 | estion e rnal Name: B ariLipgelink
#- gl Hanging Chiange Li .
5L ingats H Paet Depenibeg Link Dinplary Hasme: L]

+ i Part Ingtance

# (g Part Master Drescription: &

L Fart Referemte Link

& 4 Part Requiest

+ £ Fart Substitute
Part Usage

# ) People or Paces * Instantiable:

# ] Feople o Faces Address

+ WY Person Resunce

& Gl Pan

Parl Describe Link
Part Reference Link
Pan Usage
Relevant Reguest D

leone

Subityprabie: = |

# @ Pan Ressurce lé
- dﬁcdld:dw:d testPropOnTypeWithExchde Typefillter:
(o Predicted Fadure Moo . T
5 recictea Faaune e Owalag Ovgealzytion:
& A Predicted Faslime Rate
% [MProsiem Report T rcbtviomhip Comtraint
# =3 Proveds
% [ Process Plsn
# g, Proceid Pan b
% [ Precess Pian Localization Link Pe— ——
 E Prosut mapnit Type  Child Typés
# | Preduct Actiity Fean Ehpan

* [ Product Dutaity

+ o Preduct Family

;ﬁ:humnnm Hattes 0 objects selected

Additional terminology clarifications:

O The organizers for global enumerations defined in the Manage Global
Enumerations window are now referred to as “enumeration organizers.”

O  The attribute type previously known as “standard attributes” is now
referred to as “local attributes.”

The calculated attribute functionality has been enhanced to support more
complex computations. Customers can implement a custom
BusinessAlgorithm class, and use it in the formula for a calculated
attribute.

Multiobject APIs for retrieving and modifying business objects with improved
performance are now supported through the BusinessObjectHelper
APIs. For more information, see the BusinessObjectHelper Javadoc.
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Workflow: Complete Task Transition
Product: PTC Windchill

Benefit

A new transition type invokes an expression when upon task completion. This
allows workflow template administrators to complete tasks on the first reject
without using a separate synchronization robot.

Additional Details

A new Complete Task transition is available from the Transitions tab in the
workflow template editor.

If the transition expression is true, an individual task associated with the activity
node completes.

) Review (o] @ )]

General | Activity | Participants | Desdine | Varisbles | Routing Transitions | Execution Options | Role Setup |

Transition: : 2

Start
Disable
Enable
Suspend
Resume
Skip
Complete
Terminate
Abort

Complete Task
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New API supports tallying votes by individual roles:

/*
* @param self : WfAssignedActivity ObjectReference
* @param eventToMatch : Routing option to tally
* @param assigneeRole : Role for which you want to tally
the routing option
* @param locale : The locale in which you have specified
the assignee role
* @return int : Number of votes fromuser in the specified role
* @throws WTException
*/

public static int count (ObjectReference self,
String eventToMatch, String assigneeRole, Locale locale)
throws WTException

New API supports tallying votes by routing event:

/%

* @param self : WEAssignedActivity ObjectReference

* @param eventToMatch : Routing option to tally

* @param int : Number of votes for the routing event in
the activity * @throws WTException

*/

public static int count (ObjectReference self,
String eventToMatch) throws WIException

New API supports activity completion when conditions are met:

/*
Supported API : True
Method to complete the activity
* @param self : WEAssignedActivity ObjectReference
* @param events : Routing event to follow
* @throws WTException
*/

public void completeActivity
(ObjectReference self, String events) throws WTException
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This section of the PTC Windchill 11.0 FOO0 PTC Windchill New and Changed
for This Release contains changes that are relevant to administrators or trainers
who create training for end users of the target system.
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Action Groups on User’s Home Page
Product: PTC Windchill

Benefit

Action groups allow users to perform common actions directly from their Home
page.

Additional Details

With action groups, users can now perform common actions directly from their
Home fil page.

=l Actions

|Examp|e—Part£ ‘v|

For: ‘ D3_0000000061, Front Door;l\z:en‘i v| Select: (i) View Information J‘—__lcheck In [YCheck Out # Check Out and Edt F_‘r Undo Checkout | L[5 Copy Strke-through

Some actions groups are provided out-of-the-box with certain products, such as
PTC Windchill Quality Solutions. If action groups are available, they can be

added to the user’s Home il page by selecting Actions from the Customize menu.

Applicability for Parts Lists

Product: PTC Windchill Service Parts

Benefit
You can assign applicability to a parts list object.

Additional Details

Applicability based on ATO (option/choice selection) or Service Effectivity
(information such as date or serial number) can now be assigned to a parts list in
two ways:

» Applicability settings for a BOM part are copied forward to the parts list it
generates during a Generate Parts List action in PTC Windchill Service Parts

* Option/choice selections can be configured for a parts list object with the
Manage Applicability option in a service structure

The selections can be defined with basic expressions (simple selection) or
advanced expressions (AND, OR, and NOT statements).

The items in the parts list will be affected when a filter based on applicability is
applied to the parts list.

82 PTC Windchill® What's New



Applicability (ATO and Service Effectivity) settings for a parts list are
synchronized between the parts list and its associated content holder in a service
structure. The link between the parts list and the content holder is made when you
insert a Parts List Information Element into a structure. Once the link is in place,
the synchronization of applicability settings between the two objects takes place
with two types of actions:

» Editing the parts list’s applicability settings in PTC Windchill Service Parts,
then checking in the parts list

+ Editing the applicability settings for the relevant parts list content holder in the
service structure, then checking in the content holder

Multiple parts lists with different applicability values can be maintained in a
service structure in this way.

Security Labels Set With Workspace
CheckIn

Product: PTC Windchill

Benefit

Users can efficiently set security label values on new objects using the Workspace
Check In window.

Additional Details

Users are now able to set security labels on New objects in the Workspace Check
In window. To enable this functionality, the
com.ptc.windchill.uwgm.cadx.checkin.SecurityLabelEdit
ing property must be added to the wt . properties file and set to true. On
the Collect Objects step on the Check In window, select a table view that displays
All Security Labels columns. After the first checkin, security label values can only
be set on an object using the Edit Security Labels window.

Check In Q
fre

Collect Objects  Set Options

Current Settings: All dependen
= Object List 2ss
File« Edite
e dH il t 28 -
a Legal Information  (Need To Know |Export Contro Secrecy Labe Context Based Labe!  Third Party Proprietan
| &% al B | N N
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CAD Data Management: Applying
Security Labels from a CAD Authoring

Environment is No Longer Supported
Product: PTC Windchill PDMLink

Summary

Previously, security labels could be applied from certain CAD authoring
environments using a parameter or a property. This feature is no longer supported.
Additional Details

Security labels are still available in CAD via read-only system parameters for use
on drawings and annotations. Security labels are applied from the client- or server-
side workspace using a Check In or Edit Security Labels action.

CAD Data Management: CAD Document
Drawings with a Calculated Windchill Part
Association After Revise Are Now
Supported

Product: PTC Windchill PDMLink

Benefit

A CAD document drawing that is associated with a Windchill part now retains its
relationship when the Windchill part or CAD model is revised.

Additional Details

When
com.ptc.core.collectionsrv.engine.isCompatibleDrawingAl
waysEnabled is set to true, the system considers Windchill parts revised
without the related model CAD document still compatible with the new part
revision.

Previously, when a user revised a Windchill part and its related drawing only, the
calculated associations were maintained from the Windchill part to the CAD
document drawing, but not from the CAD document drawing to the Windchill
part. Now, a CAD document drawing that is associated with a Windchill part
retains its relationship when the Windchill part or the CAD model is revised. This
is achieved using a system-calculated association.
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CAD Data Management: Choose Whether
to Build Associated Parts Upon Check In
of CAD Documents

Product: PTC Windchill PDMLink

Benefit

When checking CAD documents into PTC Windchill, you can choose whether to
set associated part structures to build (update) using options available from the
Edit menu in the Check In window.

Additional Details

Upon selecting a build option, a related build icon displays in the Build Status
column to indicate the build type that is set to commence upon completion of the
checkin. This feature does not support building associated CAD structures of
Windchill parts that are being checked in.

To enable the build options to display in the Edit menu of the Check In window,
the server-side preference Build After Check In should be set to A11 (with the
preference unlocked) or None. The following figure shows the build options
enabled:

&3
Check In

1 (8

Collect Objects  5et Options

Current Settings: Required dependents
= Object List AsaList - Al .

File = |Ed.ﬁ "I
#y l-_l sSet Location

|:| Keep Checked Out File Name Version |Collection Rule

] Set for Check In 0000007739, prt Al Initially Selected

Set for Single-Level Build

Set for Multilevel Build

(0 objects selected )

When you choose Auto Check In from the CAD tool, the behavior of building
parts upon checkin follows the current setting of the server-side preference Build
After Check In. In other words, build selection is not available during Auto Check
In. You can either always build or never build associated part structures.
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CAD Data Management: Edit Attachments

User Interface
Product: PTC Windchill PDMLink

Benefit

The older Edit Attachments user interface has been retired. The newer applet-free
user interface is now fully supported in both embedded and standalone browsers,
and no longer requires you to set a preference to activate it.

Additional Details

The server-side preference Attachments » Use the new Edit Attachments Tool,
previously implemented in PTC Windchill 10.2 M030 to activate the newer
applet-free user interface, is removed as part of the server upgrade to PTC
Windchill 11.0.

For Creo releases that are supported in PTC Windchill 11.0, but do not support the
new user interface, the message "Command is not recognized by current client
application, either upgrade your client or use standalone browser for same
procedure" is presented, indicating that you should either use a standalone browser
or upgrade Creo.

CAD Data Management: New Reference
Link Between Dynamic Documents and
Windchill Parts

Product: PTC Windchill PDMLink

Benefit

A new reference link is available that relates a model item created by a dynamic
document to a Windchill part.

Additional Details

The link enables one dynamic document to link to multiple Windchill parts and is
preserved when standard business processes are executed such as check in, check
out, revise, and purge. A model item is created for each Windchill part that is
referenced or crossreferenced inside the dynamic document. The Windchill part is
not iterated when a link to a dynamic document is added or removed. This new
link enables a dynamic document to maintain a general reference to a Windchill
part. The new reference link is fully supported when using Windchill Import and
Export.
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CAD Data Management: Part Subtype
Selection is Now Possible During an Edit

Association or Auto Association Action
Product: PTC Windchill PDMLink

Benefit

During an Edit Associations or Auto Associate action for a CAD document and a
new Windchill part, a default part subtype is now displayed in an Object Type
column.

Additional Details

The default part subtype is based on the type of CAD document being associated,
however, you can modify the default type and select any part type available for
creation. For existing Windchill parts, the Object Type value is read-only.

CAD Data Management: Rename Support
Using a Same Base Number Scheme for
Related CAD Documents and Windchill
Parts

Product: PTC Windchill PDMLink

Benefit

You can now rename single or multiple CAD documents and Windchill parts such
that each object, and all related objects, are renamed using the same base number.

Additional Details

The base number is calculated using a default or a user-defined expression stored
in the server-side preference Operation » General » Base Number Regular
Expression. This feature is supported for all PTC Windchill 11.0 workgroup
managers as well as the server commonspace. Rename conflicts regarding non-
compliance of naming conventions as set by a Windchill Administrator are
tracked and reported in the Event Manager. All objects involved in the rename
must reside on the same server and be in a checked-in state.
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CAD Data Management: Revise Single or
Multiple Design Objects

Product: PTC Windchill PDMLink

Benefit

You can now revise either single or multiple design objects with a content or a
calculated association in PTC Windchill; for example, you can revise just the
Windchill part when making a change to the material type.

Additional Details

Design objects that are not revised retain their association links to related objects.
New versions of design objects remain associated to all related Windchill parts; in
other words, their links are preserved.

CAD Data Management: Starting a New

Promotion Request During Checkin
Product:PTC Windchill PDMLink

Benefit

A checkbox for starting a new promotion request is available in the Check In
window.

Additional Details

When enabled and upon successful checkin of the selected objects, the New
Promotion Request window opens to help you complete a promotion request
action as part of the checkin process. When enabled, if the checkin fails, the
promotion request is not launched. When enabled, if the checkin succeeds, a new
promotion request is created with all objects that were checked in treated as
"initially selected" objects for the request.

CAD Data Management: Support for
Autonumbering CAD Documents With a

File Extension Included
Product: PTC Windchill PDMLink

88 PTC Windchill® What's New



Benefit

You can autonumber CAD documents with a standard file extension included in
both the name and number of the object based on a server-side preference.

Additional Details

This feature is available with the following actions from both the workspace and
the commonspace:

* Save As

* Rename

*  New CAD Document

* New Part (CAD document only)

The PTC Windchill Drop File Extension from Number and Drop File Extension from
Name preferences control the behavior of this feature. For more information, refer
to the descriptions for these preferences located in the PTC Windchill Preferences
Utility. Previously, autonumbering provided a generated number without a file
extension.

Change Associations

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill Integrations
for Embedded Software

Benefit

Change associations enable users to configure relationships between change
objects (for example, a manufacturing change notice to an engineering change
notice, a problem report to a change notice, or an item-specific change request to a
block change request). This capability allows the PTC Windchill system to better
align with the actual change management processes in a company instead of
having to customize the system to meet these needs. Additionally, if a closure
mechanism is enabled, an organization can configure closing of processes based
on states specific to the type and process. The new Associated Process Objects
table renders associated changes with parent and child relationships for a context
change in one consolidated table. This consolidation makes it easier to view and
manage change management objects. Previously, these changes were rendered in
different tables for parent and child relationships for each type of change.

Additional Details

Now, administrators can create, read, update, delete, export, import, and perform
other actions on change association rules under Utilities » Business Administration
» Business Rules. The Change Association Rules table gives administrators the
ability to dictate how change objects can associate to one another through both the
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user interface and the Windchill services; for example, the objects in this table can
allow linking of change requests to change notices, variances to change requests,
and problem reports to change requests:

PTC’ Windchill
Administrator

E
3]

asmoug |West b [

[Pat Doaument, cA 0. J] [Search [B]v] [Ouick Links -
A site | Recertly hecessed =
= RuleSets Al Ll {5 objects )
Yui (b= | Actions= Find in tree v i@
Key 1 Hame Contert Enabled Oueridable ard Description
3 CHANGEABLE FRERELEASE  Changs Pre-Release Validation e e e Busine s Rule Set used befare objects wre released as prt of the change process
CHECKOUT AULE Checkout Rule Ste Yes ed out objects. I checked out objects are found, then the rule wil fal. Other
RELEASE TARGET Release Torget Aule Ste Yes that the specified release target on the resulting abjects s valid o
SPROMOTION BUSINESS RUL.. Promotion Request Business Rule Set Site e vas Busines Rul bifore bjects are pramoted
PROMOTION_CHECKOUT... Checkout Rule Ste e This rule detetrnines if there are checked out abjects, 1 checked aut objects re found, then the rle il Fsl. Other
@ New Change Assaciation Rule - Mozl Firefo: ===
g bl-otto ilfgtei/assaciationRules/createPunique_page number=5E510541210076_1AjssEnabl
New Change Assodiation Rule
= Change Association Rules Al -l (6 objects )
= ; nta 2
ERIA- R = Type Attributes tabl LPE-@
B ¥ Bszocistion . R ; Conte)
8 Humber Association Type Enabled _Fole AType 1 Role BType 1 Conte] Contoxt: Sie L
: hangs Pr @l hange Reques hange Hor E + Aesociatic =
[T Change Process 1 Change Request Change Hatice te Association Type: [Changs Frocass
o oooz Change Reference  [#]  Flesble Change lem  Fleble Change em  Site
= a 2 “ “ *Role A Type: Wikhingekequesi? [
( 000005 Change Reference ] FULL PR Variance site
D 9 *Role B Type: WiChangekequesti 1 [
B oooos Change Process @l Problem Report Change Request ste
] to008 Change Pre wl 1B PR SMB N sit
L g process ‘ < Instance Attributes
© oot Chang F o Varance Change Request Site
Cardinality Type: [ 1emary =
(0 objects selected ) Ouwning Role Type: [Role 2]
Required Role Type: [Mane [~
Link Type: Change Frocesslink =]

Note

*Indicates required fields.

Test Change Prﬁss Assacistion

QK. Lancel

PTC Windchill provides some rules by default, and these rules are identical to
the existing change object relationship model. You can create change
association rules at any time in PTC Windchill 11.0; however, to make the
PTC Windchill system enforce the rules, the system must be in Mixed or
Flexible mode. If the system is still in Legacy mode, then the association rules
changes make no changes to the system.
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The business rules determine which objects can be linked in the Associated
Process Objects and Associated Reference Objects tables. Process links support
closure through a workflow process, so the objects can be closed at the same time
if each object is in the correct state. Reference links are references to other objects
and do not support closure through a workflow process.

PTC' Windchill' -y [B]v) (Quisk Liks -
raminiserator
Recently Accessed
pen @
Attributes | More Attributes | Attachments | Annotations | Affected Objects | Affected End Items | Associated Process Objects | Associated Reference Objects
= Associated Process Objects A -E {1 objects )
B PE-@
(=] Ientity 1 Name Category pricrity State Need Date Complexity
5 oo D MMCRI00 Cost Reduction Low Open CrangeTransitionProduct
(0 objects
- {2 objec
25-@
N P st N o
D Mmoo Open Fast Track
E i
2 D MM-PR100 Cost Reduction Low Open
&
F
E

The Associated Process Objects table renders associated changes in one
consolidated table on the Details tab of the information page. This table supports
problem reports, variances, defects, change requests, and change notices, along
with several quality objects. The table defaults to the All view. Customers can
define a unique set of table views for the associated changes table in the
information pages and windows of the following change management object

types:

* Problem reports

* Variances (deviations and waivers)
* Change requests

* Change notices

The Associated Process Objects table replaces the following related tables in the
Details tab of a change object:

* The Change Requests table on the problem report information page
» The Change Requests table on the variance information page
* The Change Requests table on the defect information page

* The Issues and Variances and Change Notices tables on the change request
information page

» The Change Requests table on the change notice information page

If these components are used in custom tabs of information pages or in the
configurable workflow task form templates, PTC recommends that you replace
these components with the new Associated Process Objects component.

For information on how these changes apply to quality objects, see PTC Windchill
Quality Solutions: Linking Quality Objects on page 147.
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Change Management: Annotation Table
Enhancements
Product: PTC Windchill, PTC Windchill PDMLink

Benefit

Several enhancements have been made to the annotation tables on change objects,
including additional configurable columns, consolidated views, a new right-click
Remove action, and a new default view.
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Additional Details

The annotation tables for change objects are now easier to use and configure:

The change annotation picker table and the change annotation table have been
consolidated into one table with consistent views. The previous views with
and without thumbnails have been replaced by one default view:

Add Annotations

| Q All annotations for the affected object are listed below. Select the annotations you would like associated to the affected object.

= Related Annotations Default -l
Identity Thumbnai Description State Created On
’ See-through Parts

2015-01-28 20:06 CST

’ See-through CAD Parts 2015-01-28 20:06 CST

’ Golf Cart Deluxe showcase 2015-01-28 20:06 CST

, Disassembly Animation 2015-01-28 20:06 CST

(0 objects selected )

* There is a new right-click Remove action on the annotation table for
convenience:
= Associated Annotations Default - L_l]
b = d
Identity Thumbnai Description State Created On
#  See-through Parts - 2015-01-28 20:06 CST
End User
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* Configurable columns for Identity, Description, Created On, and State are now
available for the annotation table:

New View

Set Name Choose Object Types Sef Filters Set Column Display 5Set Sorting

Available Calumns Selected Columns
All Security Labels value a éDb_iec: Type Indicator -
General Status EAc:icrs
Object Type Identity

iThumbnail
Description
{Related Affected Data
Created On

State

3|2
(G > [

! Freeze column | 1T |

Changed Interference Detection
Terminology
Product: WVS

Benefit

In the Interference Detection Settings, under Calculation Mode, the term
“Approximate” replaces “Quick”, which describes the option more accurately.

Additional Details

There is no change in the process, and no change in user behavior is required.

Common Parent Level Column in

Interference Results Tables
Product: WVS

94 PTC Windchill® What s New



Benefit

The common parent level provides an indication of how deeply nested an
interference may be.

Additional Details

Common Parent Level is a new column added to theRelated Interferences report.
The deeper the common parent level, the more likely it is to resolve the
interference easily. The column is sortable.

Delete Preference
Product: PTC Windchill

Benefit

A new preference controls the default behavior for the Delete action, allowing
sites, organizations, contexts, or users to select the default behavior used most
frequently.

Additional Details

Three options are available from the Delete window:

* Delete all iterations of each object included in the table
* Delete all revisions of each object included in the table
* Delete latest iterations of each object included in the table
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Previously, the default selection was always Delete all iterations of each object
included in the table. Now you can set a preference to select one of the other
options as the default. In Preference Management, navigate to Delete » Collector »
Default Collection.

= Preference Management Standard - &
CAr

Name 1 Value Description

@ Business Rules
@ Change Management Change Management preferences
@ Create and Edit

d Delete Delete preferences
& Collector Delete Collector Rule Values
Default Collection Delete all iterations of.. Allow user to spedfy default version selection during delete.
Display collected objects As a List Allow users to change the way collected objects are listed in the table.
Include Associated Parts Lists None Allow the user to specify which associated Parts Lists will be added to the collection by default.
Include d Delete (7]
Include ¢
Include Current Settings: No dependents, Latest : Design, Working,
— = Object List asa Lst - [Anttem ect
Include LBRPRUADLPE RS D | € Dependents- % % 28
Include H ) Name 1 Number File Name Collection Rule Revision Cantex Stat
Indude A [ {G o1-51318pn WCDS00008! Initially Selected A Drive System InV
Include H
Include ]
Indicates required fields oK Cancel

Desktop Integration: User Enhancements
Product: PTC Windchill

Benefit

Several enhancements have been made to PTC Windchill Desktop Integration.

Additional Details

The following enhancements are now available to PTC Windchill Desktop
Integration users:

* Desktop Integration now uses a common local cache for documents opened
from PTC Windchill. Previously, local versions of documents were saved to
different directories depending on whether they were downloaded from a web
browser or accessed from the Windchill Documents node. Now, all documents
are saved under a common folder in your default file path.

* The General tab in the Windchill Desktop Integration Configuration window has
been replaced by the User and System tabs.
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You can use the Save As action to create a new PDF document in PTC

Windchill. Previously, this was only available when performing Save As from
a Microsoft Office document:

'@Save.ns

XS

Savein: ] Drive System

- 0 mEr
I MName ‘ MNumber Version State

""3‘ @Accepted Submission 0000000009 A0 In Work
Recent Places

Desktop

Type

Document

=l
Libraries

A

S

v

Computer

@
LY | 1 Sef

3 Settings...
Metwork

File name: Proposal Reqs pdf -

Save as type: [Adobe PDF Fileg {*pdf) v] [ Cancel ]

The right-click actions menu for folders has changed:

© The Manage Security action has been renamed to Edit Access Control.
O You can now delete one or more folders at once.

. Archived Requests

Archived Requests
. Design Documen’ Design Document:
Edit =2 |
#X Accepted Submis k L Accepted ‘_'»ul:ar'mssslh 2oz
() Additional Costs De'lete (&) Additional Costs Analysis-1
@) Atul_docl Edit Access Control &) Atul_docl
@) Atul_docl Windchill Search

@] CR-2018-9

The right-click actions menu for documents has changed:

O The Edit Access Control action has been added to the right-click actions

menu of documents. If security labels are enabled, Edit Security Labels
also appears.
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©  You can now delete multiple files at once from Windows Explorer.
Previously, users could only delete one file at a time.

| Archived Requests
. Design Documents
@Accepted Submission

@JAdditional Costs Analxsis-l

@) Atul_docl

@) Atul_docl

@] CR-2018-9
https://google.com

@]lnputs_Outputs Req U!

(] Milestones

Open

View Information
Download Primary File
Check In

Check Out

Check Out and Download
Check Out and Edit
Undo Checkout

Edit

Revise

Rename

Set State

Delete

Reassign Life Cycles
New Promotion Request
Edit Access Control

Edit Security Labels

Ly

Compare Document Versions

Compare Documents

, Archived Requests

. Design Documents

|1 Accepted Submissior

(@) Additional Costs Anj >t >t2te

|@_]Atul_dod | CheckIn

@) Atul_docl SIZENEL

@) CR-2018-9 Undo Checkout
https://google.com | Delete N

lE_]lnputs_Outputs Req U5679 o

(] Milestones

A new configuration option allows users to display a confirmation prompt
when dragging and dropping documents between folders or contexts under the
Windchill Documents node. The prompt asks the user to confirm that they want
to copy or move the document. This helps prevent users from unintentionally
moving or deleting documents in Windows Explorer:

Windchill Desktop Integration Configuration @

| Server5| User | System | Compare Tools. I About ‘

Auto Connect

Prompt for File Overwrite

Prompt for Checkout and Checkin

|:| Promptwhen moving Windchill documents using drag and drop

SetWindchill Preference to use DTl for download
[F] Windehill Context Menu for Windows Explorer

[] Windehill ©verlay Icons in Windaows Explorer

Windchill Desktop Integration 3

N
|el Are you sure you want to move the selected objects?
b 4

Windchill Desktop Integration 3

[ OK ] ’ Cancel

PTC Windchill® What s New



* The Revise action under the Windchill tab now displays the current document
version:

Y% 8y 3

Check Set  Revise Promote
Out~ State
Edit

* The Shared Status column can now be added to the Windows Explorer
detailed view:

-~

Name Shared Status Number Version State

. Archived Requests

. Design Documents

T Accepted Submission Shared to a Project 0000000121 A0 In Work
&) Additional Costs Analys... 0000000124 AQ In Work

Enhanced Ability to Copy, Cut, and Paste
in Manufacturing BOMs

Product: PTC Windchill, PTC Windchill PDMLink, Windchill MPMLink

Benefit

The ability to modify BOM structures using PTC Windchill MPMLink has been
enhanced with improvements to how parts can be moved from upstream to
downstream BOMs.

Additional Details

Cut and paste data in the context of a single tree (upstream or downstream) using
Associative Structure Browsers. Copy and paste data in the context of a single tree
(upstream or downstream) using Associative Structure Browsers. This allows
users to continue to restructure BOMs until all data management expectations
have been met, with the corresponding increases in productivity.

Typically, a manufacturing engineer uses an existing upstream, or design BOM to
transform it into a downstream, or manufacturing BOM. Then, to restructure the
downstream BOM, you can move (cut and paste) or duplicate (copy and paste)
nodes from one parent to another. With PTC Windchill MPMLink, restructuring
nodes in a given tree in this fashion preserves the associativity between upstream
and downstream objects, preserves usage information, and recalculates absolute
positioning information in the 3D Mock-Up (if necessary).
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Filter Manufacturing BOMS by Paths

Product: PTC Windchill, PTC Windchill PDMLink, Windchill MPMLink,

Benefit

The capability to filter BOMs by identifying specific nodes in the structure is
critical for all manufacturing activities supported by PTC Windchill MPMLink,
and is now supported by PTC Windchill MPMLink.

Additional Details

In order to efficiently define their work (for example. process plans, work
instructions, operations), manufacturing engineers need the ability to focus this
work context in any given PTC Windchill MPMLink BOM. Many manufactured
products have large and complex BOMs and it is therefore of great importance to
be able to restrict the work context to specific BOM nodes (or 3D components).
You can now:

* Populate a path filter in usage mode
* Populate a path filter in occurrence mode
» Display path filters in all locations where a product filter is displayed

« Set a path filter in all PTC Windchill MPMLink filters where the plant is
displayed

e Define the filter criteria when nodes ares selected either in tree or in 3D

» Display in the tree only the filtered paths (including the children of them if
they exist)

* Define a path filter in conjunction with other filters
» Save path filter for later reuse

* Add or remove new paths in the filter

* Enable or disable the path filter

Find Participants User Interface
Enhancements
Product; PTC Windchill

Benefit

A new Find Participants window has been introduced that unifies the features
found in other participant selection tools throughout PTC Windchill.
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Additional Details

A new participant selection window has been introduced that will eventually
replace all participant selection applets throughout PTC Windchill. It provides
additional search capabilities that allow the user to more accurately and quickly
identify and select the appropriate participant. PTC Windchill customer
administrators and developers are able to configure the new participant selection
user interface to use in PTC Windchill customizations. It is being used in the
Calendar Management and Team Administration functional areas.

New features include:

» The ability to search for roles.

» Previously, users could select one or all types. Now, they can pick and choose
multiple participant types to include in their search.

* In some configurations, users can choose the LDAP service they want to
search in.

* In some configurations, users are presented with a simple search field with
auto-suggest capabilities for fast searches. Users can choose more search
options to expand their search.

Import/Export User Interface

Enhancements
Product: PTC Windchill

Benefit

The Import/Export Management utility has been updated with an HTML client that
features a few minor updates to the user interface that make it more intuitive to
use.

Additional Details

The HTML user interface was introduced in PTC Windchill 10.2 M030 as an opt-
in feature; in PTC Windchill 11.0 F00O, it is the default Import/Export
Management client, so no additional steps are required to enable it.

The HTML Import/Export Management client features an updated user interface
that is more intuitive to use, but remains mostly similar to the Java applet user
interface that it is replacing.
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~ Note

The HTML Import/Export Management client may already be familiar to you if
you are upgrading from PTC Windchill 10.2 M030 to PTC Windchill 11.0
F000 and your administrator opted to enable the HTML Import/Export
Management client in PTC Windchill 10.2 M030.

* The buttons across the bottom of the Export window have been streamlined:

Java Export Interface HTML Export Interface
|£| Export ‘E 1= é Export
[ | [ — Sike -]
Source Content: “Site™ Export Settings
aport o
Expost File Name: Erowse. e
Export Rule File Browse Export e fle
mr— | Policy files
Expoat Policy File ) Export action: ot ~]
| ® Exponl Action None -
Expoit top level objects in jar of jars
] Detailed Log %r:{um
Configuration Specification
Set Config Spec
Objects for Export Fitters
Objecs -k
Add ric Fiters cdded
Delete
Filters.
= pert Situs og
Delete
Export Status Log
4 | »
Predew || Submit Save log. Exit Help Lo - oport

O Submit has been renamed to Export.

O Exit has been removed. Instead, you can close the window using the
browser Close button (this also cancels the current export task).

O Help has been replaced with an online help icon @ at the top right corner
of the HTML window.

* In the Java applet Export window, you specify a file name in the Export File
Name field and click Browse to select a location to save the JAR file:

Export File Name: | | Browse...

In the HTML export window, the Export File Name field has been removed and
the JAR file is saved to your browser’s default download location, or you may
be prompted to select a location:
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Export Settings
Export file: The exported JAR file is downloaded to your default download location. You might see a window prompt to save the file,
depending on your browser setting.

The Filters box in the HTML Export window has two icons that replace Set
Config Spec that is in the Java applet user interface:

o Edit filter icon ¥ opens an HTML Edit Filter window with a Configuration
Specification tab.

o Current filter icon % opens the Current Filter window which displays the
current configuration specification settings.

In the Objects for Export and Filters boxes, Add and Delete have been replaced
with the add T and remove = icons.

The Detailed Log checkbox has been renamed Generate detailed status log and
moved to the Export Status Log field.

The Export Status Log in the HTML Export window functions slightly
differently from the Java Export window. When exporting large sets of data,
the Export Status Log field may display a web link instead of the complete log.
Clicking the link allows you to download the complete log for your current
export job from the PTC Windchill server.

The Import user interface in the HTML window has also been enhanced to provide
a more intuitive experience.

The buttons across the bottom of the window have been streamlined:

© Submit has been renamed to Import.

O Exit has been removed. Instead, you can close the window using the
browser Close button (this also cancels the current import task).
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O Help has been replaced with an online help icon @ at the top right corner

of the HTML window.
Java Import Interface HTML Import Interface
|2 import b (=) —
Default Target Context: “Site Diefault target Context: e 9
Impart file name: Browse—.
Imipait File Name: Browse.
Irnport Seftings
Iengoet

Import Rule File: Browse. Import nade file: Browse.
Context-mapping fle EMOWsE. Context-mapgping file: Browse

Detalled Log

| Predew Submit Save g, Ext Help

» The Detailed Log checkbox has been renamed Generate detailed status log and
moved to the Import Status Log field.

* Import Status Log in the HTML Import window functions slightly differently

from the Java Import window. When importing large sets of data, the Import
Status Log field may display a web link instead of the complete log. Clicking

the link allows you to download the complete log for your current import job
from the PTC Windchill server.

Interference Results User Severity
Product: WVS

Benefit

A user-defined interval scale to determine task priority within the team.

Additional Details

You can view and manually edit User Severity for one or more selected
interferences. You can sort and filter interferences according to the severity
ascribed to them. When editing user severity, selected interferences must have the
same user severity.

Internet Explorer Support
Product: PTC Windchill
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Benefit

When using Internet Explorer, PTC Windchill pages perform according to the
capabilities of the Internet Explorer release you have installed.

Additional Details

Previously, when using Internet Explorer, PTC Windchill pages used Internet
Explorer 8 capabilities even if you had a later version installed. Now, PTC
Windchill pages perform according to the capabilities of the Internet Explorer
release you have installed.

Interoperability: Scheduled

Synchronization for Shared Objects
Product: PTC Windchill PDMLink, PTC Windchill ProjectLink

Benefit

Automatically synchronize shared objects based on a schedule and designated user
permissions.

Additional Details

Previously, project members were required to manually synchronize out-of-sync
shared objects using the Update Project action. Now you can configure a project to
automatically perform this action.

Two new fields have been added to the Create Project and Edit Project windows:

Synchronize |« Scheduled synchronization—Allow automatic synchronization
Sharing of shared objects.

* Manual synchronization only—Only allow manual
synchronization of out-of-sync shared objects.

Synchroniza- | Select a user for whom the scheduled synchronization is
tion User performed. By default, this is the project owner.
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New Project

*Type: Project

= Attributes

*MName:

*Template:
Description:

*Owner:
Phase:

* Private Access:

Invitation Message:

Number:
Category:
Business Unit:
Site:

Budget:
Scope:

Sharing Filter:

|dema

| Kickoff [+]

| Project Members Only |ZI

| General IEI

]

L]

Synchronize Sharing: | Manual synchronization only |E|

Synchronization User: I :

Allnw sharing to other projects and programs
Identify out-of-sync shared objects
Start project and send invitations to team

Execution Control: @ Manually control project execution

& Automatically execute activities and deliver tasks

Link deliverables with project activities

* Indicates required fields.

oK H Cancel ]
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For information on new configuration options to support scheduled
synchronization, see Interoperability: Configure Scheduled Synchronization in
Projects on page 28.

Scheduled Synchronization
Scheduled synchronization works the same as if the Synchronization User
were to manually complete the Update Project action; therefore, the same rules
that apply when using the Update Project action also apply for scheduled
synchronization.

* Enabling automatic synchronization does not prevent individual users from
performing manual synchronization for shared objects.

* Scheduled synchronization is only executed when the project is in the
Running state.

* The project Details page now includes the following fields:
O Synchronization User—The user for whom the scheduled
synchronization is performed.

O Synchronize Sharing—Indicates whether scheduled synchronization is
enabled.

O Last Auto-Synchronized—The date and time in which the project was
last synchronized using scheduled synchronization. Manual updates do
not affect this field.

* By default, synchronization occurs once daily at 2:00 A.M. This is
controlled by a property and can be changed by administrators.

* An automated notification is sent to project managers if a scheduled
synchronization job fails.

Synchronization User
The purpose of selecting a user is to determine which permissions are applied.
Only objects to which the user has the required permissions are synchronized.
Objects that are not included in the scheduled synchronization can still be
manually updated by a user with appropriate access.

Candidates for this field are users who have been added to the Project
Synchronization Users group. By default, this is the project owner.

~! Note

Your synchronization selections are included when performing a Save as
Project Template or Save as New Project operation.

This functionality is not available for programs.
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Initiating Change Objects for Interference

Results
Product: WVS

Benefit

You can now initiate change objects from interference results to send interference
results for review.

Additional Details

You can initiate the creation of change objects from one or more interferences in
interference tables. The tables can be from Interference Reports, Related
Interferences, Assigned Interferences, and Compare Interferences. This applies to
the all Change Objects (Change Request, Problem Report, Change Notice,
Variance).

License Usage Report Plugin
Product: PTC Windchill

Benefit

A new License Usage Report plugin has been introduced that can be used to
collect data and generate license reports.

Additional Details

A new category, Windchill License Usage, is added under the SCC categories. The
Windchill License Usage contains the License Usage Report plugin. Use the
License Usage Report plugin to collect data and generate a license report. The
report contains information about application usage for the various license types
for each user that logs on to the system.
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= System Configuration Collector Categories

i 7 = Bp X
|J Marme
|:I M Customization Collects data for customization issues, such as those pertaining to)
E & Migration fram Pro/INTRALINK 1o Windchill Ca 7 istues related to migrating from Pro/INTRALINK
| teqration
] H File Vauiting ontert Replication d vault configurations, vauiting r
|:I M General System Informaticn Collects basic Windchill 2rd third party application information, i
] HInatalation
] 3 POM (Business lssues)
[} 4 Performance
(] HWindchill Business Reparting
(]} & Runtime | suEs)
El H Search and Windchill Index Search
[} H Upgrade Collects data related to moving from cne maior release of Windc
|_.| HVisualization Collects data for visualization issues, such as publishing problems
|:| J'Windchil License Usage Collects data refated 1o Windchil license usage

Licenss Usage Report Ganerates a Winachill kcense ussge report for the gaven tme per
(| H'Windchill Directory Server Coilects diata related to the Windchill Directory Server.
1E] H'Workfiow and Queves Collects data for workfiow and gueue issues, such as gueus eniry
= H'Workgroup Mansgers Collects data for issues related to warkgroun managers and work:

License Type Usage Tracking
Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink

Benefit

Three license types are now tracked in PTC Windchill PDMLink and PTC
Windchill ProjectLink, allowing administrators to determine if a site is in
compliance with license usage.

Additional Details

The following three license types are tracked based on user actions and group
memberships in PTC Windchill PDMLink and PTC Windchill ProjectLink:

* PDMLink
* ProjectLink
* View and Print Only

License usage can be viewed in the Performance Advisor for PTC Windchill or in
a report generated by the License Usage Report plugin for the System
Configuration Collector. License usage reporting is only one function of the
Performance Advisor for PTC Windchill and customers can choose whether that
functionality is enabled. At the customer’s discretion, license usage data can be
sent to PTC.
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Manage Alternate BOMs with Common

Enterprise Data
Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill MPMLink

Benefit

You can now manage enterprise data that is common for all revisions and
iterations of a part.

Additional Details

View-Specific Enterprise Data without creating the corresponding View-Specific
Part. Common enterprise data consists of attributes and related objects that are
shared across all revisions and iterations of a particular master. View-specific
enterprise data consists of attributes and related objects that are shared across all
revisions and iterations of a particular view.

View the associated process plans for all alternate BOMs in the Manufacturing
Associative Product Structure Browser, through Enterprise Data objects. In the
Manufacturing Associative Product Structure Browser, a new process plan tab has
been implemented for both upstream and downstream BOMs. This tab allows you
to view the associated process plans of each part in the structure.

You can view the history of how this enterprise data has evolved over

time. Enterprise data includes attributes that capture textual or numeric values, as
well as related objects. You can also manage enterprise data that is common for all
revisions and iterations of a particular view of a part. As with enterprise data that
is common at the master level, you can view the history of how the view-level
enterprise data has evolved over time. With enterprise data, you can define
planning information at a global level so that this information can be consumed at
any facility. Some customers spend between 6 to 9 months moving the production
of a particular product from one plant to another partly because of the absence of a
global layer that is separate from the ERP or MES systems that are tied to specific
plants. PTC Windchill can alleviate this problem by managing this common
enterprise data.

Manage Consumption Links Using PTC
Windchill MPMLink

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill MPMLink
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Benefit

The ability to define the upstream/downstream equivalency link at an occurrence
level, or what is known as a Consumption Link, enables you to model the
consumption of parts from the upstream BOM into the downstream BOM. This
can now be done in the 3D mock-up, where the part occurrences can be displayed,
identified, and selected most intuitively.

Additional Details

The quality and efficiency of BOM transformations job is increased by exposing
the status of Consumption Links. The precision of eBOM / mBOM equivalency is
refined by tracking granular changes within subassemblies (position, addition/
removal of constituents). The 3D mock-up becomes a greater focal point for the
manufacturing team, which facilitates communication with the engineering design
team.

Manage Security Action and Window

Renamed

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink,
PTC Arbortext Content Manager

Benefit

Customers with security labels enabled are now able to separately control the
visibility of the Edit Access Control and Edit Security Labels actions that now
appear directly on the actions menu and replace the Manage Security action group,
which has been removed. For customers without security labels enabled, the
Manage Security action and window have been renamed Edit Access Control to
provide a consistent experience for the user by matching the name to the
functional area that it manages.

Additional Details
» For customers without security labels enabled:

The Manage Security window is renamed Edit Access Control and the Manage
Security action is replaced with Edit Access Control. Previously in PTC
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112

Windchill 10.2 M030, Actions » Manage Security opened the Manage Security
window from which access controls are managed.

Without Security Labels Enabled

Windchill 10.2 M030 Manage Security @
15} Gooo0ts, ACTUATOR_LOCK, Demo Organization, A1 (Design)
State: In Work - Released - Canceled
=2 Manage Security Access My Access - abiect
5 subscribe + = ! 2i-e
E] participant Permission
[E] site, Administiato h [ Fun contrat jam [ reaa Tl povmicaa Clmoaity (I mocity content Clr..
Jecte
oK Apsly Gancel
H H Edit Access Control
Windchill 11.0 FO00 @
1 ooooo1s, ACTUATOR LOCK, A.1 [Design)
State: In Work - Released . Canceled ]
5 Access | Al Defined Access
Edit Access Contro & - - @
d Subscribe
] hocty
]
| sty
>
v
QK Apply Lancel

For customers with security labels enabled:

Previously, in PTC Windchill 10.2 M030, when security labels were enabled,
the Edit Access Control and Edit Security Labels actions were submenu actions
under the Manage Security action group, which was available from an object’s
Actions menu. The Manage Security window was renamed Edit Access Control
and the Security Labels tab from the Manage Security window was separated
into a new window named Edit Security Labels. Now, customers with security
labels enabled will observe that the Manage Security action group has been
removed and the Edit Access Control and Edit Security Labels actions now
appear directly on the Actions menu. In addition, when configuring actions for
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roles or managing profiles, visibility of the actions can be controlled

separately.

Security Labels Enab

led

Windchill 10.2 M030

Manage Security

,_-I Subscribe

Windchill 11.0 FO00

Edit Access Control
Edit Security Labels
\;EI Subscribe

—

\

Edit Access Contral ]
4 6000016, ACTUATOR_LOCK, Dema Ovganization, A.1 (Design)
State: InWork - Released - Canteled Al |l
= All Defined Aceess (8 ohjects
b Edit Access Contral Accese | Al Defined Acres 8 objects) |
& o= o= . |
Edit Security Labels -0
2 (=] Participant Permissions f
g (s Vigw 8nid Print Onky ) Cleun contrel 410 Ol read Ol nownioad ) modity Clmaaity [ f
) Bl ., —— n B 2 Moaty FMadity I
Edit Security Labals @ | Reaa Tl pownicad ] meairy Cmodity f
Current Settings: No dependents, Latest : Design, Waorking, = {
~
= Object List Asalist = | Detautt ™ (1 ef1 sbjects f
HBRBHAPNSIR RN F NI TN » !
oK Apply Lancsl
=] Mame | Humber Version Heed T Know Expart Contro
4] gk acTuaToR LOCK GOO00016 A D il I}
< >
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oK cancal
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>
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|
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Modify Security Labels Permission
Product: PTC Windchill

Benefit

The new Modify Security Labels permission provides more precise control to
administrators when specifying which users can modify security labels.
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Additional Details

Previously, a security label could be modified by participants who were granted
the Modify permission, provided they were also an authorized participant for the
security label value on the object. Modify Security Labels is a new permission that
determines which participants can change security labels values. This allows
administrators to separately manage access controls for modifying security labels
and other object attributes. Now, participants must have the Modify Security
Labels permission instead of the Modify permission in order to modify security
labels; however, the participant must still be an authorized participant for the
object’s security label value that the participant wants to modify.

Modify Security Labels permission has been added to permission tables
throughout PTC Windchill, including the following areas: Policy Administration
utility; Edit Access Control window; workflow, life cycle, and container templates;
and object creation windows.

Edit Access Control 7]

“j 0000000006, SLpart_1428812946856, Demo Organization, A.1 (Design)
State: In Work - Released - Canceled

| Access Al Defined Access - B objects

Visibility of the Modify Security Labels permission can be controlled with two
Security preferences in the Preference Management utility. Access Permission
Configuration and Access Permission Configuration (PDM) determine if users can
see or update permissions throughout PTC Windchill.

Four data migrators have been introduced in the upgrade process that by default
grant the new Modify Security Labels permission to participants in PTC Windchill
11.0 who were granted Modify permission in previous releases. Previously, if a
participant had either the Modify or Full (All Control) access control permission
on an object and they were an authorized participant for an object’s security
labels, then the participant was able to modify security labels on that object.
Similarly, if the participants were denied or absolutely denied Modify permission,
then they are denied or absolutely denied the new Modify Security Labels
permission.
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The migrators check for access control rules in the following areas in PTC
Windchill:

* Policy access control rules defined in the Windchill system

* Ad hoc access control rules defined for individual objects in the Windchill
system

* Policy and ad hoc access control rules specified by container templates
* Ad hoc access control rules specified by variables in workflow templates
* Ad hoc access control rules specified by life cycle templates

~ Note

Optionally, you can configure the migrators to check for access control rules
with a permission other than Modify, when adding the new Modify Security
Labels permission.

Move Preference
Product: PTC Windchill PDMLink

Benefit

A new preference controls the default behavior for the Move action, allowing sites,
organizations, contexts, or users to select the move behavior used most frequently.
Additional Details

Three options are available from the Move window:

* Move all versions of displayed objects
* Only Move versions of displayed view
* Only Move displayed versions
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Previously, the default selection was always Move all versions of displayed
objects. Now you can set a preference to select one of the other options as the
default. In Preference Management, navigate to Integral Operations » Move
Collector » Default Collection.

Move @
Current Settings: No dependents, Latest : Design, Working,
= Collect Objects Asa List ~ | All Objects - 1 of 1 objects
S Preference Management [Standard GRELYNORFREI L R AR UDYEIASE B IUNE S
=f=| a8 _Name ¢ Number File Name Version Collection Rule | Location New Location
. B igh 01-51374cprt WCDS000389 A2 (D... Initially Selected Drive System =]
Name 1 v
«
- {0 obj lecte
andling
@ Business Rules
@ Change Management
@ Create and Edit
@ Delete
@ Display
@ Display Related Manufacturing Objects “Indicates required fields x Sncel

tion preferences. Contains preferences lice Move, Add to Project and Send to PDM collector.

Add to Project Collector Rule Valugs

Collector Rule Values

@ Convert te Share Collector Convert tto

Default Collection Only Move displayed ... Allow user to specify default preference selection during moving object.

New Status Column on Interference
Results Tables
Product: WVS

Benefit

Clarification of type of change made between an existing interference and the
previous interference, and whether the interference is new or not.

Additional Details

Additional states of interferences added to new and previously found interference
states. The new states indicate if parts in an interference were modified, and
whether the modification is of location or part geometry.

Part and CAD Document Structure

Related Information Display
Product: PTC Windchill
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Benefit

Now you can easily show and hide related information in part and CAD document
structures, including a new preference to select the related information that
displays automatically in the structure or when you click Show.

Additional Details

Previously, you manually selected the related information displayed in each
individual part and CAD document structure:

Viewing New/Add To Filter

Show/Hide Related Information @ x
Show/Hide

- | Choose the related information you want displayed in the structure.

Show Related Information

— j D Documents

1 |:| CAD Documents

O Replacement Parts

0K |  Cancel

Now, you can set the following preference for the related information to display in
all part and CAD document structures: Structure » Related Information.

= Preference Management Standard -

»-|
Name Value Description

& Received Delivery

# Reports
#l Revise Revise Preferences
4 Save As Save As operation preferences
# Search
# Security
= Structure Common Structure preferences
Expansion Limit 5000 Used to provide a limit on Expand All Levels operations within structures.
Incremental Loading in Visualization Tab No Allows incremental loading of 3D geometry in the Visualization tab of a structure
Inline Add Search Results Limit 50 Inline Add Search Results Limit
Maximum Number of Search Results 200 Maximum Number of Search Results
J Related Information Preferences that control the display of related information for a structure.
CAD Document Structure Related Info... Parts: Show Controls the display of related information for a CAD document structure.
Part Structure Related Information Documents: Show Controls the display of related information for a part structure.

CAD Documents: Show
Replacements: Show
AML/AVL:
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From these preferences, you determine the following settings:
* Related information that displays with the Show button

* Related information that displays automatically when initially navigating to a
structure

Show and Hide are now two separate actions in the Structure tab toolbar:

Viewing

iewing
Views - iﬂ Views »
Show/Hide _IDESDIay ¥ _I Display

You can still manually modify the related information that displays in individual
structures. Use the following options:

* Right-click actions menu, including these new actions:

O Show My Related Information

O Show All
O Hide All
1
Show/Hide Related Information b Show My Related Information
Add Related Information 2 Show All
Add to 4 Hide Al
Update Distribution Targets
Documents
CAD 4
CAD Documents
Open in B Replacement Parts
Select in Visualization Distribution Targets
Select in Uses Table AML/AVL
Compare 4 %Q Manage Related Information

* New Show drop-down menu:
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Viewing N

|<l>5how 'ltHg]Vrewsv %

Show All

Documents
CAD Documents

¥ Replacement Parts
Distribution Targets

AML/AVL

Manage Related Information

Part Replacement Enhancements
Product: PTC Windchill PDMLink

Benefit

Replacing parts on the Structure tab of a part information page is quicker and
easier.
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Additional Details

Three new actions are available under the Replace menu when you right-click in a
part structure:

Action Description
Replace with Alternate/ Opens a window displaying the alternate and
Substitute substitute parts defined for the current part. Select a
part and click OK.
1 Note

If the parent part is not checked out, launching
the Replace with Alternate/Substitute window
checks out the parent part.

Replace with Existing Opens a window from which you can select an
existing part to use as a replacement.

~ Note

Use this action for parts that are not defined as
a replacement (alternate or substitute) for the
selected part. This action is similar to a remove
and insert action. It does not create a
replacement relationship.

Replace with New Opens the New Part window from which you can
create the part to be inserted into the structure as
the replacement of the selected part.

- Note
This action is similar to a remove and create
action. It does not create a replacement
relationship.

~! Note

The Manage Replacements action remains available in the right-click menu.
Now it appears below the Replace menu. From this window, you add alternate
and substitute parts for the existing part. These replacement parts are then
available when you select Replace » Replace with Alternate/Substitute.
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- []45# GCO00031, WHEELS_AS

[7]4% GCOOOO38, RT_ARM, De
[958 GCO00039, LT_ARM, De

i) View Information

[} Check Out

Eh Revise

Insert
=2 Remaove
Edit

Replace

Manage Replacements

L[] Copy

-

Attributes |E

= Part Attribut:

Number:
Organization IC
Name:

Version:

State:

Status:

f Replace with Alternate/Substitute
E? Replace with Existing

} Replace with New

Part Structure: Move Action
Product: PTC Windchill PDMLink

Benefit

To move an entire structure or large portions of a structure into a new folder or
context, the Move action is available from the part structure.
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Additional Details

Now, the Move action is available from the Edit menu and the right-click actions
menu on the Structure tab of part information pages:

' Details l Structure | Related Objects l C

Editing Che
gP Insert Existing == Remove U Check Out

%6 InsertNew + [ 2 Edit =] | | Checkin
/7 Edit Part

Find in Structure

Identity «
4 GHWCDS00000| Tl Rename

{88 wcpsoo( "® Move

Identity « Context Locatior
4 3WCDs000{ [ Check Out Drive Sys... /Drive S
iEsweps| Drive Sys... /Drive S
{8 WeDS{ Bl Revise Drive Sys... /Drive S
- {C8 WCDS Drive Sys... /Drive S
- Insert 2
{08 WCDS Drive Sys... /Drive §
o == Remove ) )
' 'L';} WCDS Dirivie Sas Mirive S
- Edit 2 :
. {i}WCDS Replace 4 "{';3 Edit Usage Attributes
Manage Replacements '.’_J Edit Common Attributes
L[] Copy I?l_] Rename
=| Paste W Move

Part Structure: Visualization Tab Actions
Product: PTC Windchill PDMLink

Benefit

New actions related to viewing, shading, and measuring 3D images are available
from the Visualization tab for part structures.

Additional Details

The following toolbar actions, previously only available in the Product Structure
Explorer, are now available on the Visualization tab for part structures:

122 PTC Windchill® What s New



Identity + Context | Location Attributes ||| Uses | IR Crell| Occurrences || Supersedes ||| Classification |

4 GHWCDS000001, 01-10000.2sm, AL (Desi Drive Sys... /Drive Syst P . )
& .asm, Al (Design) rive Sys... /Drive Syst¢ IR R % O A kD LGB s d X

S mencnnnnna A 84 P Fvivin o MPiciin Suares

Part Structure: Visualization Tab

Incremental Loading
Product: PTC Windchill

Benefit

On the structure of a part information page, now you can select specific parts or
assemblies to appear in the Visualization tab of a part structure. This improves
performance and allows you to more easily visualize the parts you are interested
in.

Additional Details

When this functionality is enabled, checkboxes appear in the part structure pane
under the Structure tab, enabling you to select only those parts you want to view
on the Visualization tab.

‘ Editing Check Out/In Clipboard Viewing New/Add To Filter Tools Reports
0O & |* ) - [l 3% : .
S O % B[O ;:ﬂ v Ay v T'./}‘J 33 = - 49

G- /- 0-0
i BT & B
Identity m CT LBl Occurrences ||| Supersedes ||| Clas|
+ [w] g3 WCDS000001. 01-10000.asm. A1 (Design) |
o O 21k @B 1O
{5} WCDS000098. 01-33110.prt. A1 (Desigr) 1
{5} WCDS000124, 01-40000.35m. A.1 (Design)
{38 WCDS000316, 01-70000.asm, A1 (Design)

{5} WCDS000334. 01-33100.prt. A1 (Design)
W] {3 WEDS000465, 01-50000.25m, A1 (Design)
] {3% wcDs000534, 01-20000.36m. A1 (Design)
4‘;} WCDS000542, 01-31000.asm, A.2 (Design)

-7 T =T T — T
; o L
“ﬁwcnmlm.ol-wmmumw SR e e e (D (A BEB HMQALIKE

GAWCDS000038, 01-33110pre. A1 (Design)
£ WC08000124, 01-40000.1sm. AL Design)
3 WCDs000316, 01-70000.35m. A1 (Design)
3 weosooo3s, 01-33100
3 wepsooniss, 01-50000.
WeDsooos 34, 0120000
3WCD5009542, 0131008 36, A2 (Design)
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This option must be turned on using the following preference: Structure »
Incremental Loading in Visualization Tab. By default, the preference is set to No.

) Tip
Preferences are set in the Preference Management utility available from the

Utilities page for the context, organization, or site. Users can set preferences
from Quick Links » My Settings > Preferences.

= Preference Management Standard ™
v (b=
- = = N
imfm!m(m (= Set Preference - Windows Internet Explorer provided by IT GDS { == é}
& EPM Service Preferences i
Set Preference (> =
& Integral Operations
# Managed Collections
@ Operation Name : Incremental Loading in Visualization Tab |
Description : When this preference is set to Yes, the Visualization tab associated with a structure loads as a user sele
3 Options and Variants associated with parts in the structure tree pane. The default value is No, where all parts in the structure|
@ Packages { is selected.
Context : User - wcadmin (Administrator: Site)
A o
& Part Management Value L e
4 Project Planning T No
# Promation Process Comments : =
3 PSE
# Reports
4 Revise
4 Save As
4 Search
& Security o = | »
& Structure
Default Related Information * Indicates required fields. Revert fo Default | oK | Cancel | —
Display of Related Information
Incremental Loading in Visualization Tab Yes Allows incremental loading of 3D geometry in the Visualization tab of a structure

Cheu tanlhar hittan Arnim kasdare Vaz Cheur trnlkhar bittan araim hasdars

Part Structure: Visualization Tab

Preference
Product: PTC Windchill

Benefit

Through a preference, you can hide the Visualization tab that appears under the
Structure tab on part information pages, which may improve performance and
reduce the time to display the part structure.
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Additional Details

By default, a Visualization tab appears under the Structure tab on a part
information page:

LTSIl Related Objects ||| Changes ||| History ||| Where Used raceability ||| AML/AVL ' Relationship Explorer ||| New Tab1 x

Editing Check Out/In Clipboard Viewing New/Add To Filter
dh Insert Existing == Remove [‘r Check Out % Revise I:'lj _.I ég Views = ate 4},3 1{‘/ IEE Current
[ = 0 e T L
10} Insert New - / Edit ~ 4. Checkin = [ My Checkouts | paste Copy | Show/Hide D Display * || New Addto Edit Filter ?I‘.] Saved F
Find in Structure |ﬂ] F il
Identity « { Occurrences

This tab can be hidden using the Structure > Visualization Tab Display preference:

= Preference Management |Standard T
- Find in tree
Name 1 Value Description
[ Meeting
8 Operation e = e N
- Moz (5] g
 Options and Variants .; Set Preference - Mozilla Firefox —
[ Packages @ 15295-vm9.ptenet.pte.com/Windchill/ptcl/preference/edit_preference?definition=wt.preference PreferenceDefiniti
@ Part Management Set Preference e
# Project Planning
[# Promotion Process
BpsE Name : Visualization Tab Display
Description : Determines whether the Visualization tab displays under the Structure tab on a part information page. The
 Quality default value is Yes.
1) Received Delivery Context + Product - GOLF_CART, Demo Qrganization
Biepors vae @ e
@ N
# Revise °
Comments :
[ Save As
1 Search
[ Security
@ Service Information Management
@ Service Parts Locked  :[]
= Structure
Default Related Information
Display of Related Information No e et Revert to Default oK Cancel
Incremental Loading in Visualization Tab Mo
Show toolbar button group headers Yes s = 9 oo
Show toolbar button labels Yes Show toolbar button labels
Sort Order ASCI sort order Specifies whether structures use natural or ASCIL sort order.
Visualization Tab Display Yes Determines whether the Visualization tab displays for a part structure.
[# Tahlac

YV Tip
Preferences are set in the Preference Management utility available from the

Utilities page for the context, organization, or site. Users can set preferences
from Quick Links » My Settings > Preferences.

Parts: Multiple Rename
Product: PTC Windchill
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Benefit

You can rename multiple parts at once to save time and ensure consistency.

Additional Details

Previously, if you wanted to rename parts, you had to launch the Rename action
for each part individually. Now, you can select multiple parts and rename them all
at once. Multiselect for Rename is available from the Search Results and Folders
tables.

Rename @
Current Settings: No dependents, Latest : Design, Working -
= Object List Asa List ~  Default ” (4 of 4 objects)

#'(; fig] ?é g_fj % @‘ EJ O N & [‘:,\.\ 3 Dependents~ T& B Search in table | _l:l_J -

B Name 1 New Na... File Name New File Name 'Number New Num... Collectio

B U Enclosure Base Assem... l:l l— D3_0000000082 l:l Initially ¢ E

(] {@ Endosure Rear Assem... [ | D3_0000000068 [ itialy ¢

(=] {G  Endosure, Right Asse... |:| D3_0000000075 |:| Initially ¢

(] i Endosure Shelf Asse.. [ | D3_0000000093 [ itialy ¢

< [ 1 b H
| (0 objects selected ) -

OK Cancel

Performance Advisor for PTC Windchill

Product: PTC Windchill

Benefit

A new Performance Advisor for PTC Windchill utility has been introduced to
collect and send diagnostic data to PTC.

Additional Details

The Performance Advisor for PTC Windchill utility validates the user identity using
the Service Contract Number (SCN) and login credentials. You can then configure
the utility to collect diagnostic data periodically and send it to PTC. You can also
download the data locally and review it before sending the data to PTC. The
utility collects the following types of data:

*  Windchill System Information

* License Reporting
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PTC® Windchill

Administrator
@ site
.
s System Administration
H Calendar Management Provide the abilty to schedule nan-working days and delegate wark.
= Adapters Administration Manage life cycle templates state mapping for the Requirements Management integration with Integrity.
File Server Administration Set up file server sites,

=
g
IE
]
w

Import/Export Management Manage the exchange of file data and metadata with other systems via XML files.

Info*Engine Administration View, create and modify directory service entries,

Mapping Management Manage mappings to be used during package import.

Personal Cabinets Administration List the set of personal cabinets whose users have been delsted and delete those personal cabinets,
Configure and review dta sent by Performance Advisar for PTC Windil.

Purge Management Creste and manage purge jobs.

Queue Management Manage background gueues and queue entries.

Performance Advisor for PTC Windchill @
| Validation

Transport Mechanism Validation
Enter SCN [Service Contract Number): 2A162460

If you do not have the SCN, please enter your pte.com
credentials in order to receive the SCN.

Username [Email Address): ~ petedarr@yahoo.com

Password” sernee

Test Transport | Validate SCN

Precision Column Added to Interference

Results Tables
Product: WVS

Benefit

When viewing interference results, you can see which interferences were
calculated using accurate precision, and which by approximate precision.

Additional Details

Precision is a new column added to theRelated Interferences report. Approximate
precision is indicated by ~, whereas accurate precision displays no symbol. You
can sort the column by precision type.
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Project Management: Plan Templates
Product: PTC Windchill ProjectLink

Benefit

Create and manage plan templates using new actions and additional Templates
table functionality.

Additional Details

Previously, to create a plan template, you were required to export a project to a
ZIP file and then extract TAG-plan-1.xml.

Now, the following actions are available from the Plan table and from the Actions
menu available from the plan information page:

Save as Save a copy of the plan template and add it to the Templates
Template table.
Export as Export the plan template to a ZIP file.
Template
Pl ) [Acions =) 3 Plan - Example Project
=) an Entry v
— ‘ 7 Edit F
B @ % @ % b Atons~ L
= @ j ':J A o Reschedule Plan
ID 1t Name Dur
. — - %l Export as Template
@ 0 GJ SExample Project 1) View Information o I
Y Il Save as Template
@) 1 N Project Start 7 Edt di
@ 2 a Draft Contract fﬂ R T e e TaTn di
D = 3 a Reaiearchillens I Save as Template o
4 'Pﬁ Contract Signed Iy o vd

These actions are available for project, program, and product plans.
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When exporting or saving a plan template, you can select which elements to
include:

Export Plan Template @

Plan Mame: Demo Project
* Plan Template Name: |Demo Project Template

Description:

Select the objects to be copied to the new plan:
¥ pian Activities [V Deliverables
Resource Assignments Assigned Resources
Unassigned Resources

| QK &L QEII'IDE' |

The Templates table view named Product Plan Templates has been replaced with
the Plan Templates view. The following actions have been added to the Plan
Templates view:

* Delete

* Import from file

e Enable
* Disable
* Edit

*  Download

Promotion Requests: Need By Date
Product: PTC Windchill, PTC Windchill PDMLink

Benefit

Promotion request contains a new Need By attribute, which can be used to indicate
when a promotion request must be completed. This attribute helps communication
and transparency between promotion request approvers and reviewers.
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Additional Details
The Need By attribute appears in three layouts by default:

e The New Promotion Request window:

New Promotion Request @
@ ? )
Set Attributes Select Promotion Objects  Select Participants
Product: GOLF_CART
*Type: Promotion Request v
*CAGE Code: |Demo Organization | e
= Attributes
* Name: UPPER_BAG_HOLDER, GCO00028, A1, 23:5.1
Description:
* Location: ' Autoselect Folder {fGOLF_CART)
® Select Folder [/GOLF_ CART/D
I P
Apply default collection: |_]
* Indicates required fields. Back Next Finish Cancel

» The Details tab on the information page:

Actions» | [ o) Promotion Request - 00016, Demo Organization

Httrihutes| More Attributes | Promotion Objects

= Attributes

MName: UPPER_BAG_HOLDER, GCO00028, A1, 2015-03-24
Promotion State: Released

Description:
I Meed By:

2015-03-26 |
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* The configurable workflow task attribute layout:

Actions - | 55 Task - test, 0000000003, A.1, 2015-03-241427228117161-Approve Promotion Request

Detaits |

Attributes| Subject Attributes | Process Status | Task Completion
= Subject Attributes
Name: test, Q000000003, AL, 2015-03-24

Description:
| Need By:  2015-03-31 |

PTC Windchill Customer Experience
Management: Aging and Cycling Reports

Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill
Customer Experience Management

Benefit

PTC Windchill Customer Experience Management has been updated with new
aging and cycling reports to assist with managing customer experiences.

Additional Details

The aging report shows how long each workflow task (workitem) of a customer
experience is in the Running state. This time is calculated as the duration between
the start date and the current date along with the aging bracket they belong to. The
values of aging brackets can be set using the Aging Bracket preference. You can
set the preferences for the aging report under Preference Management » Reports >
Query Builder » Aging Bracket. The values for the Aging Bracket are sect to 30, 60,
90, 120 by default. These values correspond to the duration of the workflow state
in days.

The cycling report shows the total workflow cycle days of each workflow task
(workitem) of a customer experience in a particular state, along with the workflow
cycle time between the Intake and the Closed state of a customer experience.

PTC Windchill Customer Experience

Management: Audit Trail Enhancements

Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill
Customer Experience Management

Benefit

The audit report has been updated so these users can quickly search for individual
field changes over time.
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Additional Details

On the Timeline tab, in the History table, click the audit trail journal icon &1, The
audit trail appears for the customer experience object:

= Audit Trail Journal |User view 1 @

01! 2193315
2015-09-02 19321ST
2015-09-02 19321T
2015-09-02 1932 15T

C-37\C-7-PIA-16\Customer Experien.. Customer Expe
CANCETPIALS
<37

CANCETPIALG

C-3NC-37-PIA-16

C-3\C-37-PIA16

201344 Initiated Date 2015:09-02 1359300 GMT
201340 Name c-37-PIA-16

00022

Only users in the customer experience manager and quality system manager roles
can access this function. Users can customize and create views for the audit trail
table. The table sorts by the Date field in ascending order by default. Users can
export the information from the table to an Excel spreadsheet. Select Actions »
Export to Excel. Users can quickly search for individual field changes over time;
for example, if a user wants to find out when the reporting date was changed and
by whom, they can search by the Date field and filter by user. The date is
important because it can alter the regulatory reporting requirements for the
customer experience.

Previously, customer experience managers and quality system managers had to
look through each audit report for a customer experience to determine when a
given field was changed or who had changed it.

PTC Windchill Customer Experience
Management: Enhancements for Part

Instances and Documents

Product: PTC Windchill Customer Experience Management, PTC Windchill
Quality Solutions

Benefit

Functionality has been expanded to allow users to associate part instances and
documents to a product.
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Additional Details

Previously, when you were selecting objects in the Find Objects window to add to
the Related Products table, you could only associate parts to a product. Now, you
can select other object types in addition to parts. Out-of-the-box, you can select

parts, documents, and part instances.

& Find Objects - Mogilla Firefox

cE|

e bwharryll. ptonetpte.comMWindchill/pte lfcemy/addProductDetail Punique_page_number=58324914831328_1&AjaxEnabled=rowstablelD =table_cem.productDetai

Find Objects

= Search Results =8|

o

g &é
Gl 3]
B &

(0 objects celected )

Type: Al Applicable Object Types Add/Update

HNumber: 1234
Wame: [ |
Revision: @ Select [Latest [¥] O species [ |

Murnber
12345909080

12345508080
12345707070

Narng

Caritest
GOLF_CART
GOLF_CART
GOLF_CART

fsion Last Modified

2015-06-23 09:30 MDT
2013-06-23 09:30 MDT

2015-06-23 09:29 MDT

shineble B1H - @

@

Search Clear |

(3 objects )
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@ New Customer Experience - Morilla Firefox

bwharryl prenet pic.com/Windchilljpte1fcemicreate_complaint?unicue_page_number=38524914955748 DBavizardActionClass=com pc.qualiymanagement.cem processors CreateCustomerExper enceForr
New Customer Experience 2]
" @

Set Attributes  Set Attachmerts

= Relatad Personnel and Locations (0 objects )
- = o 3
e . 0 - -

71 Type *Marne Atemate Hentfier  Phone Tite  *Primay Contest

dhladd by Altemate pacld by Name

(0 objects selected )

= Related Products (3 abjects )
tos<a -
B Number *Narm sevisbcliumber | Unique (dentifer QU0 Other Lot/Bateh Number “Quantity Unit “Prirmary

1 @ 2001 High Performance Cart 12345102070 1235878307070 1 [ ][ ] : o : i)

£ cconn.. sOLF_CaRT [ [ ] [ =l == a

[ 5] ooooon... 3500 Documert it [ [ ] [ j o j a

o

(0 objects selected ) =

= Additional Cocles (0 abiects )
a B-

1 Trending Categary

0 objects selected )

* [ndicates required fields Bach et Save Finish Cancel

* In the Find Objects window, you can search for and select one or more objects.
The search defaults to all applicable object types. To limit the search to
specific object types, click Add/Update, select the object types, and click OK.

o If'you know the part number, but not the serial number of the product, you
can search using the part number. You can enter the serial number
manually when you know it later, or you can advance the workflow
without it.

O If you know the part number and serial number, you can search on either
number.
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O If you do not know either the part number or the serial number, use the add

as reported product icon 4 to record the information you have in the
Related Products table.

» To control the object types that appear in the Find Objects window, edit the
selections in the Relationship Constraints tab for the Reported Against type in
the Type and Attribute Management utility. The default object types are parts,
part instances, and objects.

Eile Edit Miew History Bookmarks Tools Help

| 13| Type - Reported Against x W

é % bwharryOl pronetpic.comAVindchill fnetmarkets/fjsofadmin istrations/shel| jsprcontainerQid=0Rwtinf.contain
demno _ﬂ
o Actions = | o) Type - Reported Against

| Internal Name: wi.changeZ.Reportedhgainst

o Manage Types

= %Pcrsun Resource = Display Name: i 8
-_—

+ P

“}‘I 3 Description: L]
+ g Plan Resource -
2} qpredicted Effect
H @F‘l:di:l:d Failure Made
# _APredicted Failure Rate Ieon: ctrmarketsfimageadlink_object gif | &
- .'},'F'rubltm Fepart
+ &S Process *Instantiable: (@) yas
+ AdProduct He
+ g Product Activity

Buihtrnaablas I 1

+ ﬂ'Pwduct Details
H E.Prnduct Farniky Mermber
+H bproduc: Farnily Member Master
+ .3Pruduc:]nucshgatlnnAl:wt}f
+ :]Projcct
ot aijcct.ﬂctMty[Clussit:l
H _I_E'Prommion Request
- "’"-1 wality Contact
(L Quality
# | Received Delivery
H HJR:I evant fequest Data
+ | Replication Package

:'. Artributes "La'_\,-'our_-: Relationship Constraints

o

B Parent Type Child Types
LR Custorner Eqperience T|If,ln:u:u"\e*t

wd Part

4 Part Inztance
{0 objects selected )
+ 1| Beplication Package Master 4 —
=+ -ﬂﬂeport
e __,JReporter,l Against

*  When you select an object type, the system automatically completes certain
fields in the Related Products table. This saves you from entering this
information manually.

O If'the object is a part instance, the system completes the Serial/Lot Number
field.

O If the object is associated with a unique device identifier, the system
completes the Unique Identifier (UDI) field.

» After you have added a part or part instance to the Related Products table, you
can assign a failure code. If a failure code is added to a part instance, the
failure code is reported against the part and not the part instance. You cannot
enter failure codes for other objects, such as documents.

End User 135



You need to create your own part instances. You can create part instances for
every product or specific products you choose.

* When creating the part, create it as an end item and set the default trace code
to Serial Number, Lot, or Lot/Serial Number.

*  When creating the part instance, enter the Serial Number, Lot, or Lot/Serial
Number to make the part instance searchable in the quick lookup and in the
Find Objects window.

To configure attributes on the Related Products table, update the
CEProductDetail object using the
CEM.ProductDetailAttributePopulator.properties.xconf file
located in <Windchill>\codebase\com\ptc\qualitymanagement\
cem\xconfs.

* The property name value in the file contains a concatenation of the type,
period character, and internal name of an attribute that exists on the From

type.
* The property default value contains the internal name of an attribute that
exists on the CEProductDetail type.

* Any Changeable?2 type and attribute combination can be defined in the
property name value.

* AllCEProductDetail attributes can be defined in the property default
value.

» All attributes are supported on both the From types and the
CEProductDetail type.

» For example, the out-of-the-box entry for mapping the
uniqueIdentifierNumber from a part instance to the
uniqueIdentifierNumber attribute on the CEProductDetail type
is

<Property name="wtpart.WTProductInstance2.uniqueldentifierNumber”

default="uniqueldentifierNumber”/>
To add an Organization attribute to the Product Details window, do the following:

1. Create a calculated attribute on the Product Details (CEProductDetail)
type. The data type should be String.

2. Add the calculated attribute to the layouts where you want to display the
organization.

3. Right-click the new attribute in the layout and select Edit Group Attribute
Properties. In the Data Utility Id field, enter
productDetailOrganizationDataUtility.

4. Save the changes to the layout. The organization appears on the windows
where you added the calculated attribute.
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PTC Windchill Help Center Changes

Product: PTC Windchill

Benefit

A number of enhancements have been made to the PTC Windchill Help Center for
PTC Windchill 11.0 F000.

Additional Details
Highlights of enhancements to the PTC Windchill Help Center include:

« All of the PTC Windchill Workgroup Manager documentation, formerly in its
own help center, is now combined with the PTC Windchill Help Center. You
can access the PTC Windchill Help Center directly from the PTC Windchill
Workgroup Manager client by selecting Help > Help Center.

* To increase findability and organization, PTC Windchill Workgroup Manager
New and Changed entries are now at the same table of contents level as the
PTC Windchill New and Changed entries.

» To enhance usability, much attention was given to topic title quality in this
release, including improvements in:

© Removal of duplicate titles
o Consistency, clarification, meaningfulness, disambiguation
©  Enhancement and restructuring of topics with too-thin content

These efforts are on-going for PTC Publications as we work to make the PTC
Windchill Help Center more functional and streamlined.

* The Info*Engine adapter for DOORS is retired. As a result, documentation for
this adapter is no longer available in the PTC Windchill Help Center or on the
Reference Documents website for 11.0 and beyond. For more information, see
Info*Engine Adapters: DOORS Adapter Retirement on page 27.

PTC Windchill PartsLink: Classification

Search Integrated with Advanced Search
Product: PTC Windchill PartsLink

Benefit

The Classification Search utility has been fully integrated with the core PTC
Windchill advanced search.
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Additional Details

You can now use the PTC Windchill Advanced Search page to search for
classification parts using node and attribute values. Previously, you could specify
classification nodes in the Criteria field; however, if you wanted to search for
classification parts using attribute values, you had to use the Refine Search table
that was only available from a separate Classification Search utility.

Windchill 10.2 M030 Windchill 11.0 FO00
Classification Search search [
Start > B Refi S h
art> Browse > Refine seard Search History and Saved Searches | Advanced Search | Classification Explorer @
Exact Matches: 3| View All
Narrow your results by entering attribute values below Save This Search
Classification: --no other matched classes -- Keyword:
Sourang Context: | [=]
= Type
- N . 1] AnTypes
= Refine Search: Mechanical Parts (4 objects)
My Favarite Types  Add
searchintable |2 @
1 part
Attribute Operators Value Range
[ctomotuc =]
 Context
= Classificati
Obtained Safety Standard uucsa[=] assification
Part Classification [¥] Mechanical Parts | Rz
= Criteria

[ (Obtained Safety Standard = 'UL/CSA/EU') AND (Application Industry = ‘Automotive] ]
Wit

[Obtained Safety Standard || = [=][uncsaeu]=]

[Application Industry ][ = [=][Automotive [=]

Search| Save This Search

When an applicable part type is selected, a new Classification field appears in the
Advanced Search window. Use this field to specify one or more classification
nodes:

=l Classification

[Part Classification lv| [FASTENER | R @
|Electrica| Classification |1| |CHIF'5ET |,D<£ qr
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Once a node is specified, the criteria selection menu refreshes to include relevant
attributes:

=l Classification

Part Classification |1| |B|C]LT |.;:-" & 4P

=l Criteria

o= MR

Configurable Module &
. Created By -
Created On
Default Trace Code
Default Unit

End Item

m

Full Length

General Description

Head Diameter

Iteration .{b
Last Modified

Maedified By

Marme il

» The Classification ficld does not appear if the Type field includes ineligible
object types.

* The node name field supports predictive search:

=l Classification

[Part Classification lv| [FasTENER | P2 +
|F'artCIassificatiu:un Ill ﬁ -’O & r
BOLT (9) Part/Mechanical Parts/FASTEMER/BOLT

'EYE BOLT 6} Part/Mechanical Parts/FASTENER/BOLT/EYE B
TEBOLT [0) Part/Mechanical Parts/FASTENER/BOLT/T BOI

* Ifyou specify more than one node, they are joined using an AND operator.
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As part of this enhancement, classification search results now appear in the core
Search Results table. Previously, classification searches appeared in a separate
Classification Search Results table.

To support this change, the Search Results table is now compatible with
classification attributes:

Windchill 10.2 M030

Classification Search
Start> Browse > Refine Search > Results

Sourcing Context: | [=]

= Classification Search Results : Electronic Parts (7 objects)
43 | Actions ~ search intable |2 @
Name Humber Version Source  Assembly Mode RoHS Compliant

{:ﬂ} Part_test05  00000027... AD (Design) Make Separable Yes il
{3 FinalPatl 00000026, AD (Design] Make Separable Yes |;
{} Finalatz 00000026 AQ (Design] Make Separable Yes m
{3 Parttest0d  00000027... A (Design] Make Separable Yes

e O v -

m_ = - ] »

P Windchill 11.0 FO0Q

Search History and Saved Searches | Advanced Search | Classification Explorer @

<< Edit Search Criteria Start a Mew Search Save This Search

Criteria: Type=Part;Part Classification=Electronic Parts;Context=All Contexts; Sourcing
Context=Default

= Search Results Default Part View M (12 objects)
D o ¥ % 75 | Actons~ searchintanle |2 F - @
Number Name Version State Part Classification

3 0000000023 EPRD-MEPart-Red-.. (i) A3 (Design] Released Part/Electronic Parts/CAPACTOR/ADIUSTA *
¥ 0000000015 EPRDSIdPart3 i) A2(Design) Inwork  Part/Electronic Parts/RESISTOR/POTENTION E|
% 0000000014 EPRD-SidPart2Blue (i) A2 (Design) InWork Part/Electronic Parts/RESISTOR/POTENTION
5% FACET_CLF_SUBTYPE_... Facet_CIf_SubType 0. () Al (Design) InWork Part/Electronic Parts/CHIPSET, Part/Mec
{0} FACET.CLF 002206  Facet CIf 002206 D AlDesigni  InWork  Pari/Electronic Parts/CHIPSET, Part/Mec _
s i | v

(0 objects selected )

* You can create custom table views that include classification attribute
columns. This is restricted to searches that only use one classification attribute
and corresponding node value.

* You can use the new search facets utility to filter by classification nodes and
attributes. For more information, see Search: Faceted Results on page 148

* You can also launch the Find Similar Parts search action from the right-click
actions menu.

To browse through classification parts, you can use the enhanced classification
explorer available from the PTC Windchill Navigator.

PTC Windchill PartsLink: Enhanced
Classification Explorer Available from the

Navigator
Product: PTC Windchill PartsLink
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Benefit

Access the classification explorer from the PTC Windchill Navigator. From here,
you can use a new tree panel to browse the classification hierarchy.

Additional Details

Previously, the classification explorer was part of the Classification Search page.
Now, classification search is fully integrated with PTC Windchill advanced
search. For more information, see PTC Windchill PartsLink: Classification Search
Integrated with Advanced Search on page 137.

As part of this enhancement, the classification explorer is now available from the
Search tab of the PTC Windchill Navigator:

Windchill 10.2 M0O30
ZIC Windch [Documen it [ [search... [Pl (QuickLinks~ |

Recently Accessed -

Classification Search

5

| Lpaes

To find item using keywords, type keyword and lick the Search button.

aso.g

¢ Keyword: | | [ search @

| searcnFor 7 B ooy () B Manutacturer part 7] 15 Vendor part

To browse for item, either click Search button to view criteria or click on image to browse classification,

Part

i T AS Q
é@ Search I

Windchill 11.0 FO00

- .
Electronic Parts (7) Mechanical Parts (2) Search History and Saved Searches | Advance: dSearch | Classification Explorer @
CHIPSETZ), eCizssli mCassiz i
= Tree Classification Search B
g =
s Classification: | Part Classification (Part) | To find item using keywords, type keyword and dlick the Search buttan. =
2 [ =
s E| (6 objects) =
sl ( Keyword: ]
/ = Search @
=R
Class To browse for item, either dlick Search button ta view criteria or dlick on image to brows:
= Part (28)
Part > Electronic Parts
S Electronic Parts (12)
s
B CAPACTTOR (1)
B RESISTOR (5)
— i —
3 Mechanical Parts (18) S
CAPACITOR (1) CHIPSET (6) RESISTOR (5)
ADIUSTABLED POTENTIOMETERS)
z
g
=
@
-3
g
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This change includes the following enhancements:

* A new Classification Explorer link is available from the Navigator. Click this
link to open the Classification Search page. You can also continue to use the
link available from the global search drop-down menu:

PTC" Windchill

Example

Search

|Part, Document, CAD D... ‘v|

Search ... |p‘v‘ Quick Links ~

Search History and Saved Searches | Advanced Search | Classification Explorer Q

Search History

Saved Searches

Manage

View Search History and Saved Searches Becd >

Advanced Search

I Classification Explorer I

*  You can continue to perform keyword searches from the Classification Search
pane. When you click Search, the results are displayed in the core PTC
Windchill Search Results table. Previously, classification search results were
displayed in a separate Classification Search Results table.

* A new Tree panel allows you to navigate the classification hierarchy by
expanding and collapsing node groups:

©  When you click the link in a parent node, the visual explorer automatically
updates to display your selection.

O When you click the lowest level node in a group, the Search Results table
opens to display all applicable parts.

o Click the collapse action [<]to hide the Tree panel.

Tree
Classification: |Part Classification ( Part) Vl

= (14 ohjects )
-:-= i::-z\) ¥
Class

= Part (28)

& Electronic Parts (12)
= Mechanical Parts (18]
[ BEARING (4]
= FASTENER (14)
THREADED INSERT (0}
© BOLT 9)
= NUT (5)
= PIN [0)
® PLUNGER [0}
& RIVET (0
 SCREW (0]
HWASHER [0)
H SPRIMG (0)
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Classification Search

To find item using keywords, type keyword and click the Search button,

Keyword:

2]

To browse for item, either click Search button to view criteria or click on image to browse <l

Part > Mechanical Parts > FASTEMER

T Search

/
BOLT (%)
EYE HEAD) . EYE BOLT®E

&

NUT (5)
HEXAGONE
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PTC Windchill PartsLink: Find Similar
Parts

Product: PTC Windchill PartsLink

Benefit

Launch the Find Similar Parts action from various locations in PTC Windchill.

Additional Details

Classification search has now been fully integrated with the core PTC Windchill
advanced search. As part of this change, there is no longer a separate
Classification Search Results table. For more information, see PTC Windchill
PartsLink: Classification Search Integrated with Advanced Search on page 137.

End User
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Previously, the Find Similar Parts action appeared as a column in the Classification
Search Results table. Now, it is available from the following locations:

* The right-click actions menu in the Folder Contents table, Search Results
table, and the structure browser
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* The Actions menu on the part information page

ai;' View Information

Cpenin 3

Check Qut

Check Qut and Edit

Edit Common Attributes

Revise

P\ LI\

Mew 3

3 Copy
JG] Save As

% Find similar Parts

ﬂ"a Supersede with Existing

{X;ﬁ Supersede with Mew

?,] Rename

= Maove

Eq Set state

'f-' Export

ﬁ Export Importable Spreadsheet
X Delete

E Reassign Life Cycles

Reassign View

Add to [

Compare 2

Edit Access Control

=| Subscribe

Selecting this action opens a new Find Similar Parts window. There are no other
changes in functionality for how the Find Similar Parts action executes.
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~ Note

You can control the visibility of the Find Similar Parts action using profiles.
For more information, see PTC Windchill PartsLink: Properties and Profiles
on page 54.

PTC Windchill Quality Solutions: Batch
Printing
Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill

Customer Experience Management, PTC Windchill CAPA, PTC Windchill
Nonconformance

Benefit

PTC Windchill Customer Experience Management, PTC Windchill CAPA, and
PTC Windchill Nonconformance have been updated with the ability to print
multiple customer experiences, CAPAs, or nonconformances at the same time.
Previously, you had to manually print each item.

Additional Details

If you have multiple customer experiences, CAPAs, or nonconformances, you can
now print them as a batch to save time. You can print one type of batch (for
example, customer experiences) at a time. From the Actions menu, select Batch
Print or Batch Print With Audit Trail Journal. When the report is complete, the
system generates an email with an attachment. An email address must be
configured on the user account. If you do not receive an email with your report
within a few hours, look in the system log to determine if there is an error. Only
users in the quality system manager role can print batches of quality objects.
Quality objects can be printed through the history report in Cognos and the audit
trail on the Timeline tab. Some items that do not appear in Cognos might appear
on the audit trail. The Cognos report is intended to be a company-configured
electronic record, but the audit trail prints all fields. The date in the footer can
differ from the individual report date. The footer prints the date and time when the
batch started. The header for each record prints the date and time that the report
for that complaint ran.
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PTC Windchill Quality Solutions: Linking
Quality Objects

Product: PTC Windchill, PTC Windchill Quality Solutions, PTC Windchill
Customer Experience Management, PTC Windchill Nonconformance, PTC
Windchill CAPA

Benefit

PTC Windchill Quality Solutions allows users to link customer experiences,
nonconformances, and CAPAs to each other. Users can now easily see a list of
similar issues so they can provide consistent responses to customers. This
functionality also helps track duplicate issues, similar solutions to a problem, or a
problem with multiple solutions.

Additional Details

Customer experiences, nonconformances, and CAPAs can be associated with
multiple quality objects (for example, customer experience to customer
experience, CAPA to nonconformance, and so on) at any state in their life cycle.
Data is not copied between the objects. You can view data for each object on the
information page, Structure tab, History table, and query builder reports.

To add a link to the other objects, use the Associated Process Objects table and
the Associated Reference Objects table:

* Use the Associated Process Objects table for links that have processing
associated with them. When you close one object, the other object closes
automatically if all processing has been completed.

» Use the Associated Reference Objects table for links that have no process rules
associated with them. This table is simply a reference to another object.

» For information on using these tables with change management objects, see
Change Associations on page 89.

Available objects depend on the business rules defined in your system. By default,
you can link any flexible change item (customer experience, nonconformance, or
CAPA) to any other flexible change item. If you create a CAPA from an existing
nonconformance, customer experience, or CAPA, the existing object appears in
the Associated Reference Objects table for the new CAPA.

Search: Dynamic Result Columns
Product: PTC Windchill
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Benefit

The Search Results table automatically includes a column for each additional
attribute included in the search criteria.

Additional Details

Previously, the default search results displayed a standard column set. To view
additional attribute information, users were required to create a custom table view.
If a search included multiple object types, only common attributes were displayed
and could not be added with a custom view.

Now, the default Search Results table view automatically includes a column for
each additional attribute specified in the search criteria, even if a search includes
more than one object type:

Criteria: ( (Assembly Mode = "Separable’) AND (File Name = "*¢*’) );Type=Document. Part;
Context=All Contexts

= Search Results Default - (247 objects )
1y @ ¥ %y 3 | Actions - searchintable 2|2 - @
\:‘ Number Mame Context 1 Version r-‘-sser'rlbl-,.' Mode File Name h
| ] ‘f e FYuuuuul FIUUULLVIEW UE... L FIOUULLVIE... A.L [Uesygn) Acpdiduie -
D {e} # Pvoooo02 ProEngine i) ProductVie.. A.l [Design) Separable
D {E} = PV000003 Worldcar i) ProductVie.. A. (Design) Separable
(] E = 0000000022  Testdoc2 i) SearchTestP.. Al Chaitanya project.doc
(] _J =] 0000000021 Testdocl i) SearchTestP.. Al Five-steps-to-make-search-...
[} {E} 0000000025 MBO11 i) SearchTestP.. A.l (Design) | Separable
D f} 0000000026 ME0111 i) SearchTestP.. A.l (Design) Separable
D f} FACET002206 Facet_New_Prod.. (i) SearchTestP.. A.l [Design) Separable
(] j T'j 0000000006 Agenda Template (i) Site Al Agenda_Template.doc
D j @ 0000000004 MS Project Plan ... (i) Site Al MS_Project_Plan_Template.... =
(] E = 0000000002  Requirements Te... (1) Site Al L Requirements Template.doc  J-

(0 objects selected )

Search: Faceted Results
Product: PTC Windchill

Benefit

Faceted search results allow users to narrow their results by selecting from a list of
applicable object attributes.

Additional Details

You can now narrow your search results by selecting attributes available in the
current result list. When enabled, a Refine Results pane appears next to the Search
Results table. This pane displays attribute groups that are relevant to the objects
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already returned by the search. Select the desired attributes to further narrow the
search results. Faceted results are only available to users with PTC Windchill
Index Search installed and enabled. By default, faceted results are disabled.

searcn 2
Search History and Saved Searches | Advanced Search @
) @
<< Edit Search Criteria Start a Mew Search Save This Search
Refine Results
( ; T)’Pevm ) Criteria: Keyword=*00%Type=All Types;Context=WCQA
i3 part
D lﬁ CAD Document [ Filter: Type: Part % Clear All ]
=) Search Results Default - Lu] (10 objects )
P Created On
B 3 | Actions + Searchintable 2|2 -
b Last Modified D X EHh £-0
b Assembly Mod Number MName Version |
sembly Mode
{@} 0000000075 TwoByTwo-third.sdpc i) B.D (Design) ar
P Created By
i 0000000078 Rotor-3.sdpc i) A3 (Design)
P Modified By
ﬁ'}} 0000000801 Alternate-01 i) Al (Design) =
» Source .
{Jé} 0000000077 Substitute-01 i) Al [Design)
w5 lier Locati ™
gp fer Location ﬁ'}} 0000000802 Substitute-02 i) Al [Design)
China
&l {@} 0000000803 Elades.sdac i) Al (Design)
Germany
: i 0000000800 AlternateRotor.sdac i) A0 (Design) il
[T india
(0 objects selected )

To support faceted results, new configuration options are also being introduced at
11.0 FO00. For more information, see Search: Properties and Preferences on page
60.

Search: Find Field Removed
Product;: PTC Windchill

Benefit

As part of the advanced search redesign, the Find field has been removed.

Additional Details

The Find field on the PTC Windchill Advanced Search page has been removed. It

is replaced by the AND and OR options that are part of the redesigned Criteria
field:

» All keyword search strings are now joined by the AND operator.

*  When performing an indexed keyword search—To use an OR operator
between keyword strings, users must set the Search Mode preference to
Advanced. Once enabled, users can explicitly specify the AND and OR
operator between strings.

*  When performing a keyword search without indexing—Use a semi-colon (;) to
signify OR.
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Windchill 10.2 M030 Windchill 11.0 FO00

=l Criteria =l Criteria
Add < [ (State = "Accepted’) OR [View = ‘Manufacturing’) )
State EB‘AE(EptEd E [}:[ - -
{OR 41490 151 T3
VlewEB Manufacturing Fe) e = i =8

DR Il” = El Accepted lzl
Find: With all of these criteria = leB Manufaduring £

‘With all of these criteria

Search| Save This Search

‘With any of these criteria

Search| Save This Search

Search: Keywords in Context
Product: PTC Windchill

Benefit

When performing a keyword search against indexed content, the Search Results

table includes a tool that allows you to preview the keyword as it appears in the
file.

Additional Details

A new column named Text Preview is available from the Search Results table.
Hover over the keyword icon lto view a preview of the keyword as it appears in
the context of the file text. The preview displays the first time the keyword
appears in the file content. PTC Windchill Index Search must be installed and
enabled. The Text Preview column does not appear by default. You must create a
custom table. This feature is not enabled by default. An administrator must enable
it using the wt . index.enableTextPreview property. By default, this
functionality is only available when searching for document objects. To include
more content holder object types, use the
wt.index.supportedTypesForTextPreview property.

Criteria: Keyword=collect™;Type=Document; Context=All Contexts

= Search Results Text Preview Custom View - L_.J (3 objects)
SE]| _L-,f o @ﬁ E Actions ~ Searchintable |2 ﬁ - @
__Narne 1 Text Preview MNumber ~Context Version
@ Inputs_Outputs Req ... 0000000061 L) Power System Al
@ CR-20189 0000000025 1) Power System Al
B  Additional Costs An... nnnnnnnn2a i\ Dawer Suctem 87

Text Preview

(0 objects selected } Sheetl
5000 Satellite tracking for GPS units

3000 Collecting area for samples, requesting feedback

| oy
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Search: Nested Queries and Enhanced
Attribute Selection

Product: PTC Windchill

Benefit

A fully redesigned Criteria field provides multiple enhancements, including the
ability to perform nested attribute searches and greater usability when adding,
removing, and specifying attribute criteria.

Additional Details

The Criteria field on the PTC Windchill Advanced Search page has been
redesigned to include several new actions and enhancements.

Users can now perform nested search queries using AND and OR operators.

Windchill 10.2 M0O30 Windchill 11.0 FO00
=l Criteria =I Criteria
Add~ [ (Mame = "CL1*') AND (Last Modified = "Yesterday) AND [ (File Mame = "*3.doct’) OR (File Name =
“*3.xIsx’) OR [ (State = 'In Work') AND (Organization Name = 'Demo Organization’}}})
Last Modified -I=
L B | Y - R— [awofe] %414 12317
- w1
State [= =] [in Work Last Modified [ = [][ vesterday [=]
Organization Name EB IDemo Organization pel
ity
[ 7 5 Y rr-a—
T 7 5 - a—
==
State [ = [=][1n work -]

| Demo Organization Fel

The following actions have been added:

o) Open the Attribute Selector window. From here, you can select
one or more attributes to include in the search criteria.

ok Add a single attribute field.

= Add a nested attribute group.

= Remove a nested attribute group.
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It is now easier to change your attribute selections:

» The criteria field now accepts predictive text searches:
=l Criteria

(]

[anD =] %414k %5175
|Def == |
Default Trace Code EE' |

" Default Unit

* You can add multiple attribute fields at once. When selecting multiple
attributes, the Attribute Selector window opens. This window also provides
guidance as to which object types are applicable for an attribute. Previously,
users did not have an option of adding multiple attributes at once.

* You can change your attribute selections using a drop-down menu. Previously,
users were required to add or remove attributes when changing their criteria
selections.

Windchill 10.2 M030 Windchill 11.0 FO00

=l Criteria =l Criteria
(]
Add ¥
Created On [ano=] %31 180170
Last Modified
Mame
Number
Mare 4 Assembly Mode Checked Out By v
Checked Out By Collapsible Attribute Selector
Collapsible Configurable Module
Configurable Module Created By = All Attributes (26 objects)
Created By Created On =
Searchintable | P|F -
Default Trace Code Default Trace Code
Defult Unit DataType  Attribute Type
Default Unit =ey Created By Document,Part -
- Description
Desaription ) Created On Document,Part
End Item i
End Item ] Default Trace Code Part !
File Mame £
Format [F Default Unit Part L4
—_— Format B
IEELEE Description Document
§ Tteration D "
Modified By i End ftem Part
Organization Name O File Name Dacument
Owner (4] Format Document i
Project Share Status
(0 objects selected )
Revision
Source
State
QK | Cancel |
Title
View
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A new Explain action is available. This action appears when advanced search

criteria is applied to more than one specific object type. Click the Explain link to
open a window providing a breakdown of how search criteria is applied based on

object type:

[ Al Types
D My Favorite Types  Add

._'IDo(umem: {g}Part
# Context
=l Criteria

[ (Name = "CR*) AND (Assembly Mode = ‘Inseparable’}) AND (Format = "Microsoft Office

= sk 00k |

[anD[=] #4140 185175
x
MName v‘ = -ICR*
Assembly Mode || = [=][mseparavie [=] Typewise Query Builder Criteria
‘EE Micros oft Office Excel worl 42
I N ([Mame = 'CR*) AND [Assembly Mode = 'Inseparable’) AND
[ Criteria String (Format = ‘Microsoft Office Excel workbook’) ) ]
»
>
Search Types Applicable Query Builder Criteria
{ (Name = 'CR*'} AND {Format = ‘Microsoft Office Excel
Document .
waorkbook’) )
Part ((Name = 'CR*'} AND [Assembly Mode = ‘Inseparable’} }

This feature is not available when All Types is selected under the Type ficld.

When specifying attribute criteria, you can now use null and is not null operators
for applicable attribute types. Previously, only the equal to and not equal to

operators were available.

[anD v] #4546 1fg1Tg

|Name |v| = T |

|NLII"I|3E' |V| :
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~ Note

Use the enableNullCriteria property to control whether null and is not
null appear. By default, they are disabled.

The null and is not null operators are not compatible when performing an
indexed search or a classification search. Instead, an error message appears.

Note the following when implementing the nested criteria redesign:

» Saved searches created in previous releases are still supported.

» The Find field has been removed and is replaced by the AND and OR options.
For more information, see Search: Find Field Removed on page 149.

Search: Related Object Searches

Product: PTC Windchill

Benefit

A new advanced search utility allows users to perform searches based on object
relationships.
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Additional Details

A new Related Object Search field is available from the Advanced Search page.
This field uses PTC Windchill report management to execute searches based on
object relationships; for example, you can perform a search for all parts that have
an associated document:

Search History and Saved Searches | Advanced Search @

Save This Search

Keyword: |

= Type
[] &1 Types
|:| My Favorite Types Add

D éDocument {:':':}Part

= Context

All Contexts  Mare Options

[] My Favorite Contexts  Add

=l Criteria
[ (Mame = 'P*7])
(anp[=] #4414k 185175
[Name N-EF

=l Related Object Search

Report Template: |Described By Documents Ill

Document Mame like = *spec” |
Document Number ke | |
Document State equals ~ | v
Document Created between ~ [2015-05-03 & - |2016-01-3:1 |[F
Document Last Modified  between ~ | & -| =

Search | Save This Search
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The Related Object Search field appears when the following conditions are true:

* The Search » Enable Related Object Search preference is set to Yes. This
preference is set at the site level.

* Only one object type is selected.

» The selected object type has at least one associated report template that is
available for advanced searches. To support this, the query builder now
includes the following options:

O  Available for use with Advanced Search—You must select this option to
make the report template available from the Related Object Search drop-
down menu:

Edit Report Template - Described By Documents

_ 4] T2 = Tables and Joins | Select or Constrain | Criteria | Sort

*Name pescribed By Documents

Description A parts that have an associated document using the Described By link.

Created On 2015-06-16 15:36:15.0
Modified By Administrator
Modified On 2015-06-16 16:38:09.0

Expose As Report @
(| Add Time to Date Fields (i ]
[:'fj Available for use with Advanced Search @ ]
Use as a Join Model @

I pistinct @
[ Group By @
|| Bypass Access Control @

» Additional Properties

View Report | Save As Apply | Close
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O Main Type—Use this field to designate a main object type for the report
template. The Related Object Search field appears when the main type is
selected on the Advanced Search page:

Edit Report Template - Described By Documents
GG | Tables and Joins | G a1 LHET N WaG CE
|T| Main Type: Part 7< Remove Unused Tables and Joins
| Part J
‘ Document J
View Report | Save As ‘ | Apply ‘ Close |
~ Note

Report criteria is joined by the AND operator and can be included in saved

searches.

Security Label Columns in Custom Table

Views
Product: PTC Windchill

Benefit

You can quickly skim all security label values set on a list of objects in a table by

selecting the All Security Labels column when creating or editing a custom table

view.
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Additional Details

Security label values can now be viewed in custom table views. This allows you
to quickly view all security label values set on an object. To add the security label
columns to a customized table, select All Security Labels from the Available
Columns list when creating or editing a table view.

New View @
@ @ G, O @
Set Mame Choose Object Types Set Filters Set Column Display Set Sorting
Available Calumns Selected Columns
Actual Finish
Actual Start ~

Adapter Name
Address

ADW Block Library Path
ADW Flow Type

ADW Managed Design
ADW Metadata Version
ADW Root Design

Allgwr Lipke [Totaprifyl
Allow Traces (Integrity]
Approval Code
Approval Date

7\
- m%
=

E3
L
e

f4| 4|k M

D Freeze column

*Indicates required fields Back Next Finish Cancel

A column displays for each security label that is configured for your site, in
addition to the other columns you select when creating the custom view.

= Updates Table with All Security Labels - L_I]

By E
LegaIInformation Meed To Know Export Control Secrecy Label Context Based Label  Third Party Proprietary ,

Changes made to a security label attribute column, such as width and height
adjustments, designating it as hidden, or removing the column, are not saved when
you save the view if it was added to the table by selecting All Security Labels. If
you hide a security label column and save the view, the security label column will
appear the next time the view is accessed. Changes to other column types are
saved.

An individual security label attribute column can be selected from the Available
Columns list if the AvailableAttributesSite.xml file has been
configured to make the security label attribute available for your site. If the
security label attribute has been selected individually, then changes made to it are
saved when the table view is saved.
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Service Publishing: PDF of Source
Languages

Product: PTC Windchill Service Information Manager

Benefit

You can publish a PDF of the source language content for a publication structure.
When choosing Publish Representation, select the Publish untranslated source
checkbox, which publishes the service structure and its content in all authored
languages.

Additional Details

Publishing untranslated source is disabled for XML bundle publishing. Previously,
a user was required to choose specific languages, which made it more difficult to
publish only multilanguage source content.

Service Publishing: Setting an
Applicability Expression

Product: PTC Windchill Service Information Manager

Benefit

You can set filtering for both the service structure and inline applicability within
dynamic documents using the Filter action set on the toolbar of the Structure tab;
for example, you can publish a publication structure to PDF with filtering applied
from the Filter action set on the toolbar of the Structure tab.

Additional Details

Publishing applies the filters to the publication structure and to inline applicability
for its dynamic documents. You can save the filter to make it available for future
publishing jobs. The rootApplicabilityExpression publishing rule
parameter overwrites the applicability expression defined in the Filter action set on
the toolbar of the Structure tab.

Service Structure: Content Attribute and

Content Holder Attribute Synchronization

Product: PTC Windchill Service Information Manager, PTC Windchill Service
Parts
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Benefit

In PTC Windchill Service Information Manager, the presentation of content
information has been simplified by ensuring common attributes between the
content and content holder are synchronized after updates.

Additional Details

Information in content holders and content objects is synchronized. This includes
parts lists, information elements, and WTDocument types.

Changes to one object are reflected in the other object, including the following:
* Name

* State

* Description

* Version

* Checkout state

Exceptions include the following:

» If the life cycle templates are different, the state is not synchronized

* The description attribute for a dynamic document cannot be edited after
creation

» If'the content and content holder are not using the same versioning scheme,
versioning is not synchronized

+ If'the content object is a textual content information element and the holder is
a textual content holder, the checkin and checkout states are not synchronized

Service Structure: Information Structure
Ordering

Product: PTC Windchill Service Information Manager, PTC Windchill Service
Parts

Benefit

In PTC Windchill Service Information Manager, information structures can be
reordered using line numbers.
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Additional Details

* Line numbers are now assigned for all object types:
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@\; 2 8
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Clipboard
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Viewing

- H }‘u - _] -

Copy | Vews  Display

Actions~ | i Information Structure - 0000000003, SIM, Demo Organization, A.2 (Service) o

structure ©

[Part, Document, cAD D.

[ [searcn

Rlv] |Quick Links+

Save As/Add To
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.y,
Save As Add to

RS tnormation Element List

L2

A

Number
0000000003
0000000001
0000000002
0000000004

0000000005

o nw > |z

Filter

?</ % CurentFiter +

]
Edit Fiter 4 Saved Fiters ~

Publish
‘a

Representation

Recently Accessed +

inwork @

Tools Reports

Openin | Reports

2@

H-0
State
In Work
In Work
In Work
In Work

In Work

O A line number is automatically assigned to any new object added to the
information structure using the following actions:

*

L 4

L 4

L 2

Insert New

Insert Existing

Copy and Paste

Replace with Local Copy

O Objects are added as the first child of the selected node by default. Objects
can be moved by changing the line number value.

O If siblings need to be renumbered on an insert, only the siblings with
existing line numbers are renumbered. Items with no line number remain
unchanged and are sorted alphabetically.

O Line numbers are numbered in increments of 1000.

O When Insert Existing is used, new line numbers are added for the existing

object, but its children remain unchanged.

¢ [fits children have objects with line numbers, those line numbers are
retained.

¢ [Ifits children do not have objects with line numbers, new line numbers
are not included.

* The Line Number column for an information structure is now displayed out-of-

the-box.

* The default sort column for the information structure tree is the Line Number

column.

* Users can toggle between line number and name. The toggle can be
configured by administrators using the sort ISByLineNumber property in
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the site level xconf file. This property is set to t rue by default to sort by
line number. Setting the property to false sorts by name by default.

» Users can edit the line number on any object within an information structure.
The line number can be set to any integer value. If a user sets the value to an
existing line number, the line numbers automatically recalculate to avoid
duplication.

*  When generating a publication structure or a new information structure from
an existing information structure, the line number is copied. Line numbers are
generated to reflect the order of the information structure.

O If all siblings have line numbers, all line numbers are carried over from the
information structure.

O If only some of the siblings have line numbers, all siblings are
renumbered. They are sorted by line number, then by type, then by name.

O Ifnew items are added to the publication structure and these items do not
have a line number, these items are inserted as the first or last child within
the publication structure.

Service Translation: Improved Support
for Pivot Languages

Product: PTC Windchill Service Information Manager

Benefit

PTC Windchill Service Information Manager translation users who use pivot
languages can now see the path from each source to target language and can
cancel an in-progress translation package, even if it is a pivot language.
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Additional Details

PTC Windchill Service Information Manager Translation Dashboard now displays
a Path column that shows the path from source to target language, including a
pivot language if one is configured. In the following example, French is a source,
and its pivot language is English:

PTC" Windchill'
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A1 E_AN_ AR A28 T

M Products > Soil Compactor, Deme Organization Recently Accessed -
actions = | 38 publication Structure - 0000000073, Soil Compactor Maintenance Manual, Demo @
Organization, A.2 (Service) Released

Representations Translation Dashboard = @

Translation Dashboard Customize +
= Translation Dashboard (39 objects)
¥ | Actions = Searchintable | P ﬁ - Q

Language f Status Path Last Refreshed

Arabic Mot Requested en-=ar, fr-»en->ar 2015-09-09 16:30 CDT Il
Bulgarian Mot Requested en->bg, fr->en->bg 2015-09-09 16:30 CDT
Catalan Mot Requested en->ca, fr-ren-»ca 2015-09-09 16:30 CDT

Previously, in-progress translation packages could not be cancelled if the package

in translation was a pivot language for another target. Now an in-progress package
can be cancelled for pivot languages as well. Any target languages that are waiting
for the pivot to be translated will also be cancelled when the pivot is cancelled.

Service Translation: Representation for
Root Included in Translation Package

Product: PTC Windchill Service Information Manager

End User

163




Benefit

When a PTC Windchill Service Information Manager translation package is
created for a publication structure or information structure, the default
representation for the root of the service structure is included in the package.

Additional Details

The translation package now includes the default representation for the root of the
service structure, if one exists. Having a default representation such as a PDF may
be useful for translators who want to see the published version of the full
document; for example, there might be a PDF default representation for the
service structure published in its source language. Translation packages previously
included only the default representations for dynamic documents if they exist, and
these are still included. The Include Representation translation preference now
applies to both cases.

Shared Interference Detection Definitions
Product: WVS

Benefit

The new Shared Interference Detection Definition enables the user to view
generated interference results from different analyses related to same or similar
assemblies and subassemblies.

Additional Details

The Shared IDD is a type of interference detection definition that contains a
unique name that groups interference detection results together. This enables the
recognition, for example, of an interference between two instances of Part A and
Part B from definition X and interferences of Part A and Part B from definition Y
where both definitions have the same share name. In the regular interference
detection definition, each set of interference detection results is independent of
others.

Support for Variant Specs in Interference
Detection Definitions
Product: WVS

Benefit

Save time and steps by filtering variants within the interference detection
definition.
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Additional Details
Bypass the need to filter results from possibly long lists of filters.

System Quality Agent Renamed to
Performance Advisor for PTC Windchill

Product: PTC Windchill

Summary

The System Quality Agent under Preference Management has been renamed to
Performance Advisor for PTC Windchill.

Additional Details

There are no additional details for this change.

Team Templates Page Enhanced to

Replace Team Administration Java Applet
Product: PTC Windchill PDMLink

Benefit

The enhanced Team Templates page user interface provides a unified user
experience for managing team templates throughout PTC Windchill and replaces
the Java-based Team Administration utility to resolve usability concerns stemming
from the use of Java applets with changes to JRE 7 and later, which prompts
multiple security warning messages.

Additional Details

The Java-based Team Administration utility from earlier releases has been replaced
with HTML user interface elements on the Team Templates page. In previous
releases, and after changes to Java 7 and later, users frequently encountered
security prompts when opening the Java Team Administration utility. The Team
Administration link on the Utilities pages for Products, Libraries, Organizations,
and Site now opens the Team Templates page. Additionally, the Team Templates
view on the Templates page for Products, Libraries, Organizations, and Site has
the same team template management functionality as the Team Templates page.
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Java Team Template Page
Team Administration Applet PTC Windchill
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The Java-based team template create and edit windows have also been replaced
with HTML user interfaces: New Team Template and Edit Team Template.

Updating Parts Lists after Changes to
their Source
Product: PTC Windchill Service Parts

Benefit

Parts lists display indicators when changes to their source Service BOM or generic
parts list (template) have been made, so the Parts List Author can update any
associated or generated parts lists.
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Additional Details

When changes to a Service BOM have been made and checked in, any parts lists
that are associated to the BOM display an Update Required flag. The flag indicates
that there are changes to the BOM that could be replicated in the parts list.

=]
The flag is shown as an icon or column = in these locations for a parts list
associated with the updated BOM:
* The Details page for the parts list

Actions» | 2= parts [ jst - 0000000003 (Manual Author Generic), A.2
Structure €
* The Information Element List of an information structure

You can customize the view of the Information Element List to expose the
Update Required column.

Sl Information Element List

3 A o @
Mumber Mame « __\r'crsion __S:atc

2 gooooonon2 Gen From BOM Generic oAz T Wiork

£ goooooono3 Manual &uthor Generic D a2 Inwork ‘Iﬁ

'"Update Required |

* Folders view
You can customize the view of Folders to expose the Update Required column.

You can also run a report that lists the parts lists in an information structure that
need an update after changes to the source BOM. Select the Reports > Parts Lists
Requiring Update menu option from the Structure tab of an information structure

to generate the list.

Adiens~ | 1% [nformation Structure - 1T Demo Organization, A.2 (Service) nwork @
I svuctere it |G
Editing Check Qutfin Clipboard Viewing Save AsfAdd To Filter Publish Tools Repoits
b Insert Exisling ~ = Remove | [ Check Out ™7} Undo Checkout | (B || B B ] &y Current Fiker a -
o o o c c - = .| Rl
it InsetNew~ P EGR v | Q| Checkin ([ Checkouts v | Pagie  Copy | Views Disply | Seveds Addto | EdtFiler 76 SavedFilers - | Representabon | Openln | |Repotts
DERY 2 @
N Parts Lists Requiring Update
Name <1 Line Hunibe.., SEEEN itormation Element List
a1 Templatels @ y Iy o @
“fparstists 100 mber Neme version state
[ Gen From BOM 000 = Gen From 8OM Generic Doa2 In'Work
) Gen From BOM Generic 1000 2= ooooonooos Manual Author Generic Doa2 Wk 7Y
4 [ Manual Author 2000
5| Manual Autnor Generic 1000

You can select the Compare to Part Structure option from the context menu for a
parts list’s source BOM to outline the changes that were made to the BOM.
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You can decide whether to update some, all, or none of the parts lists associated

with the BOM. Two options available in the PTC Windchill Service Parts Ul

confirm which action has been taken for each parts list:
* Update Completed
The option is available from these locations for a parts list:

© The Check In window (named Update Complete)

Checle In

Checking n: 0000000003 (Manual Author Generic). 4.2

Cormmeants:

: Feep checked out after checkin

ri Update Complete

| DK

Cancel

O The Actions menu
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0 The context menu

¢ Update Not Required

The option is available from these locations for a parts list:

O The Actions menu

O The context menu

Both of these actions remove the Update Required flag from each parts list.

After completing an update for a parts list that was the generic parts list (template)
source for any generated spare part parts lists, the spare part parts lists display a
Regenerate Required flag. The flag indicates that the spare part parts lists can be
updated to match their source generic parts list (template).

The addition of a Regenerate Required flag depends on the current setting for the
Service Parts preference Parts Lists Auto-Regeneration. The

preference has two values:
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* Yes — Spare part parts lists are regenerated automatically when their source
generic parts list (template) has been updated.

* No (default) — Spare part parts lists have the Regenerate Required flag set
when their source generic parts list (template) has been updated

Affected spare part parts lists can be regenerated manually.
PTC Windchill Service Parts provides a report that lists the parts lists in an
information structure that need to be regenerated.
The Regenerate Required flag is shown as an icon or column =2 in these
locations for a spare part parts list:

e The Information Element List of an information structure

Information Element List

“ A H- @
Mumber Mame « Wersion Sake

& onoononil Gen From BOM Generic oAz In Waork

‘; oonooooo12 Manual Author Generic i Az In'Wark tt}

| Regenerate Required |

You can customize the view of the Information Element List to expose the
Regenerate Required column.

* Folders view

You can customize the view of Folders to expose the Regenerate Required
column.

You can also run a report that lists the spare part parts lists in an information
structure that need to be regenerated after an update to the generic parts list
(template). Select the Reports » Parts Lists Requiring Regeneration menu option
from the Structure tab of an information structure to generate the list.

~ Note

The Parts Lists Requiring Regeneration menu option is only available from
PTC Windchill Service Information Manager when PTC Windchill Service

Parts is installed.
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You can decide whether to regenerate all or none of the spare part parts lists.
Choosing the Regenerate action from the context menu for an information
structure regenerates spare part parts lists from any generic parts lists (template) in
the structure.
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The action removes the Regenerate Required flag from each parts list.

Workflow: Process Manager in HTML

Product; PTC Windchill

Benefit

The workflow Process Manager has been rewritten in HTML and no longer
requires Java.
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Additional Details

The Process Manager also includes the following enhancements:

» Use toolbar actions to zoom in and zoom out:

BEE ) M| (o) (o) | 0|

\

)

* Double-click to expand or collapse the graphical process display:
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L )
* Process: Problem Report Workflow_00001

* Activities

Expand All

* Process: Problem Report Workflow_00001

* Activities

k—-) Expand All

Previously, the Process Manager utility was launched as a Java applet. Now, the

Process Manager renders in HTML.
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Optionally Enabled Features

In PTC Windchill 10.2 M030, PTC provided a new property that controls new
features that may impact the default user experience of established end-user
capabilities.

~ Note

This area does not have any additions or changes for PTC Windchill 11.0
F000.
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PTC Windchill Workgroup
Manager

Autodesk Inventor: Manage Spreadsheets related to Inventor Models as CAD

Do o1 4 1= 0 ) < P 177
Autodesk Inventor, NX, SolidWorks: Mapping Attributes with Unit Support................... 177
Autodesk Inventor, NX, SolidWorks: Out-of-Date Notification.................ccoooiiiiinnn. 178
Autodesk Inventor, NX, SolidWorks: Replace Assembly Components Without

Closing/Reopening Entire ASSEMDIY.........covuiiiiiiiiiee e 178
CATIA V5: Abstraction Builder Enhancements ...........c.oooiiiiiiiiiiiiieci e 179
CATIAV5: Asynchronous Download Preference Option ...........ccoeevviiiiiiiiiiiiiiiiicces 179
CATIAVS5: Larger Toolbar and Menu lcons in CATIAVS.......iiiiiiiiiieeeeeeceee 180
CATIAVS5: Performance Testing GUIdeliNeS ..........cc.viiiiiiiiiiiii e 181
Enhancing the PTC WWGM Zuken PDM Adapter...........cooeuiiiiiiiiiiieiiii e 181
NX: Implementation of PTC Windchill File System ............cccoooiiiiii e, 181
NX: Map CAD Assembly Attribute to Usage Link Attribute.............ccoooiiiiiiiinnnn, 182
Page Level Data Management for TDO .........ccouuiiiiiiiiiiiiii e 183
PTC Creo Elements/Direct Modeling: Compare a Local Model in the PTC Creo

Elements/Direct Modeling Session with a Different Version in PTC Windchill ............ 183
PTC Creo Elements/Direct Modeling: Delay PTC Windchill Autonumbering of

(0] o] 1= o1 = J PP 184
PTC Creo Elements/Direct Modeling: Improved Performance for PDM Actions on

Small Sets of Objects in Large Workspaces .............ovviiiiiiiiiiiiiiiieii e 184
PTC Creo Elements/Direct Modeling: Improved Top Level Instance

ViISUANZAtION ... 185
PTC Creo Elements/Direct Modeling: Locking or Unlocking Objects in Workspace or

(671D Y o] o] [Tz 1 1] o RSP 186
PTC Creo Elements/Direct Modeling: Use Windchill Part Product Structure for BOM

Tables and Position Flags on Annotation Drawings ..............ccooiiiiiiiiiiiiiiiieieeeen, 186
PTC Creo Elements/Direct Modeling: Workgroup Manager Notifications for Objects

with Out-Of-Date Information with Respect to the Commonspace ................ccouneee.. 187
PTC Creo Elements/Direct Modeling, PTC Creo Elements/Direct Drafting: Enhanced

Format Conversion of the New Creo View Adapter and CAD Workers...................... 188
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PTC Creo Elements/Direct Modeling, PTC Creo Elements/Direct Drafting: Model

Manager to PTC Windchill Text Reference Mapping ........cooevvviiiiiiiiiiieeiiieeeeenn, 189
PTC Creo Elements/Direct Modeling, PTC Creo Elements/Direct Drafting: Open

Creo Elements/Direct Drawings in PTC Windchill with Modeling and Drafting Workgroup

1= g =T =T 189
PTC Creo Elements/Direct Modeling, PTC Creo Elements/Direct Drafting: Support

Attributes of Type Real Number with Units in the Workgroup Manager ..................... 190
PTC Windchill Workgroup Manager Documentation Consolidation and

RESITUCIUIING - ... e e e e e e eeeas 190

PTC Windchill Workgroup Manager Toolkit: New and Enhanced Toolkit API
Functions to Read Subfolder Structure, Enable Export From Workspace, Register or

Unregister Authoring Applications, and Access PTC Windchill File System............... 193
PTC Windchill Workgroup Manager Toolkit: Removing Dependency on PTC Libraries

FOF CATIA NV S e et e e e e 194
SolidWorks: Autonumbering of Mirrored Components ..............ccoeeeviiiiiiieeiiiieiiieeeies 194

SolidWorks: Enable SolidWorks BOM Item Number Propagation to Windchill

This section of the PTC Windchill 11.0 FO00 PTC Windchill New and Changed
for This Release describes the features from previous releases of PTC Windchill
Workgroup Manager that have changed or been removed, new features that have
been added, API changes, and changes in behavior, as well as provides references
to related documentation. PTC Windchill Workgroup Managers support the
integration of authoring engineering applications with PTC Windchill.
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Autodesk Inventor: Manage Spreadsheets
related to Inventor Models as CAD

Documents
Product: PTC Windchill Workgroup Manager for Autodesk Inventor

Benefit

Microsoft Excel spreadsheets that control multiple Autodesk Inventor models can
now be saved in PTC Windchill as CAD documents.

Additional Details

Previously, there was no support for managing Microsoft Excel spreadsheets
referenced by Autodesk Inventor models. Because of this, it was necessary for
customers to manage these spreadsheets separately, outside of PTC Windchill.
This enhancement allows these spreadsheets to be saved as CAD documents, as
part of the overall PTC Windchill Workgroup Manager for Autodesk Inventor
experience.

Autodesk Inventor, NX, SolidWorks:
Mapping Attributes with Unit Support

Product: PTC Windchill Workgroup Manager for Autodesk Inventor, PTC
Windchill Workgroup Manager for NX, PTC Windchill Workgroup Manager for
SolidWorks

Benefit

Now you can map CAD parameters with units to PTC Windchill global attributes
with units. In addition, Unit Conversion from CAD to PTC Windchill is also
supported.

Additional Details

Customers can now roll up mass properties for E-BOMs, and use these collected
mass properties for downstream business applications such as Integrated
Simulation and Testing. Mass properties supported by this enhancement are Mass,
Volume, Surface Area, and Center of Mass. If the value of a PTC Windchill unit
and a CAD model unit is not same, PTC Windchill automatically converts the
value.
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Autodesk Inventor, NX, SolidWorks: Out-

of-Date Notification

Product: PTC Windchill Workgroup Manager for SolidWorks, PTC Windchill
Workgroup Manager for NX, PTC Windchill Workgroup Manager for Autodesk
Inventor

Benefit

You can now keep a reference model up-to-date in a CAD session, and receive
notification from colleagues of upcoming changes to the model. This reduces
rework due to miscommunication, and allows customers to better work in a
concurrent environment.

Additional Details

Customers now have a mechanism to deliver information into the CAD tool when
the PDM status of data that is open in a CAD session has been changed by others
—most importantly, when the status is out-of-date or checked out by another user.
This enhancement “pushes” the information to users, eliminating the need to ask
for the information, as is the case today. Once notified, users can perform the
Update PDM Action on the selected object.

Autodesk Inventor, NX, SolidWorks:
Replace Assembly Components Without
Closing/Reopening Entire Assembly

Product: PTC Windchill Workgroup Manager for SolidWorks, PTC Windchill
Workgroup Manager for NX, PTC Windchill Workgroup Manager for Autodesk
Inventor

Benefit

You can replace out-of-date assembly components in session without closing and
then reopening the entire assembly. This enhancement decreases system and
operator processing time, thus enhancing productivity.

Additional Details

Previously, it was necessary to close an open assembly in order to replace out-of-
date components in the assembly, and then reopen the assembly all over again.
This was a time-consuming process that often resulted in productivity delays
when the assembly was reopened. Now this process is eliminated. Using the
Update PDM action, you can replace assembly components in the Local
Workspace with updated components while the assembly is open and in-work.
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CATIA V5: Abstraction Builder

Enhancements

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink,
PTC Windchill Workgroup Manager for CATIA V5

Benefit

The process for creating the CATIA V5 abstraction library has been simplified. By
providing an automated environment validation check for CATIA V5 abstraction
building and performing a runtime validation check, the time and effort required
to investigate issues is reduced.

Additional Details

The abstraction builder now automatically verifies prerequisites, including
installation of compatible versions of CATIA V5, CAA, RADE, and Microsoft
Visual Studio. Additional verifications take place when CATIA VS5 is registered
with PTC Windchill Workgroup Manager and when CATIA VS5 is run. These
checks ensure compatibility between the versions of PTC Windchill Workgroup
Manager and CATIA V5 that were used to build the abstraction library, and the
ones currently being used. If issues are detected, a message appears with
information about what needs to be corrected.

Once the abstraction library has been built, it must be placed in the installation
image location so that it is included in client installations. This location has
changed from previous releases.

CATIA V5: Asynchronous Download

Preference Option

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink,
PTC Windchill Workgroup Manager for CATIA V5

Benefit

Performance has been improved when loading and opening large CATIA V5
assemblies. Additionally, the response time for design mode requests has been
improved.

Additional Details

A new asynchronous option is available for the
wwgm.download.method.upon.open preference. When this preference is
setto async, CGR files and secondary files are downloaded first during
operations to add a CATIA V5 assembly to the workspace or open a CATIA V5
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assembly in CATIA V5 from the PTC Windchill commonspace. After those files
have been downloaded, primary content files (.CATPart and .model files) are
downloaded.

CATIA V5: Larger Toolbar and Menu Icons
in CATIA V5

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink,
PTC Windchill Workgroup Manager for CATIA VS

Benefit

To improve visibility, the PTC Windchill Workgroup Manager for CATIA V5 user
interface includes larger toolbar and menu icons for PDM actions.

Additional Details

The PTC Windchill Workgroup Manager for CATIA V5 icons are now the same
size as the native CATIA VS5 icons.
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CATIA V5: Performance Testing

Guidelines

Product: PTC Windchill, PTC Windchill PDMLink, PTC Windchill ProjectLink,
PTC Windchill Workgroup Manager for CATIA V5

Benefit

The performance benchmark test guidelines provide a method to measure and
evaluate the performance of CATIA V5 data management of your PTC Windchill
system.

Additional Details

By executing the benchmark test using the provided guidelines and comparing the
results to those measured in the PTC R&D lab, you can determine if your system
is performing within expected limits. PTC provides performance testing
guidelines, including a data set and test cases, that you can use to test performance
at your site.

For more information, see PTC Windchill Workgroup Manager for CATIA V5
Data Management Performance Benchmark Test, available at the following URL:
http://support.ptc.com/view?im_dbkey=167313.

Enhancing the PTC WWGM Zuken PDM
Adapter

Product: PTC Windchill Workgroup Manager for ECAD

Benefit

The handling of data by the PTC Windchill Workgroup Manager Zuken PDM
Adapter has been enhanced through the use of a new utility that zips the board-
related and schematic-related files for storage in PTC Windchill.

Additional Details

The list of these files is determined by a Zuken API. This ensures that the layout
and the schematic data are properly separated and in a way that is consistent with
how the Zuken tools expect to find them.

NX: Implementation of PTC Windchill File
System

Product: PTC Windchill Workgroup Manager for NX
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Benefit

The PTC Windchill File System is now implemented out-of-the-box for PTC
Windchill Workgroup Manager for NX. The PTC Windchill File System also
enables PTC Windchill support of the NX Reuse Library, a common repository for
locating reusable knowledge on an enterprise basis.

Additional Details

The PTC Windchill File System (WFS) exposes PTC Windchill as part of the
native file system, enabling the CAD application to access files in PTC Windchill
as though they were in folders on the local file system.

In the context of PTC Windchill, the KRX, CGM, and BMP files needed to fully
support the NX Reuse Manager features can now be managed in PTC Windchill.

WES is a component of, and is installed with, the PTC Windchill Workgroup
Manager client. WES exposes PTC Windchill as a set of folders on the file system
which mirrors the PTC Windchill Commonspace and Workspace folder structure
seen through the web browser. This folder structure allows the CAD tool to access
data in PTC Windchill as though it were files on the local file system. WFS
requires you to login to PTC Windchill, and adheres to PTC Windchill security
policies, so you will not be able view data through WFS that you cannot ordinarily
view in PTC Windchill. You can configure the PTC Windchill folder entry
location within your existing file system.

Now, WEFS is enabled out-of-the-box, Workspace Local Directory mode is
disabled, and the WFS installer is downloaded automatically. In WFS, the Local
Workspace replaces the Workspace Local Directory as the local repository for
CAD data.

NX: Map CAD Assembly Attribute to
Usage Link Attribute

Product: PTC Windchill Workgroup Manager for NX

Benefit

PTC Windchill Workgroup Manager for NX allows exposing Line Numbers and/
or Find Numbers from NX designs into the engineering BOM in PTC Windchill
as reference designators, which can be transferred to downstream business
applications such as ERP. Support for mapping NX assembly component
attributes to EPM Document Usage Link attributes helps the overall process for
traceability of components through the product life cycle from design to
manufacturing.
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Additional Details

The value of the attribute reads from the Instance context. The value is taken if it
was set at the component level of the direct parent assembly that is saved, or at the
part level. The NX Attribute applied to the Instance in the assembly is mapped to
the Usage Attribute having the same name in the PTC Windchill CAD structure.
Attribute Mapping is used to map the NX Attribute applied to the Instance in the
assembly to the Usage Attribute in the PTC Windchill CAD structure.

Page Level Data Management for TDO

Product: PTC Windchill Workgroup Manager

Benefit

Updates have been made to page level data management for Team Design Option
(TDO).

Additional Details

TDO 16.6 supports only hierarchical designs where the schematics are grouped
into blocks, and project integrators can assign work to users at the block level.
TDO 17.0 supports hierarchical as well as flat designs where the schematics are
broken into pages, and project integrators can assign work to users at the page
level. Flat designs give more flexibility to project integrators in assigning work to
users.

PTC Creo Elements/Direct Modeling:
Compare a Local Model in the PTC Creo
Elements/Direct Modeling Session with a

Different Version in PTC Windchill

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling

Benefit

You can now compare different versions of a model side by side in a PTC Creo
Elements/Direct Modeling session.
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Additional Details

This allows you to identify specific changes in the version history of a model. You
can also review changes made in the current Modeling session, or validate
externally modified and reimported models before checking them back into PTC
Windchill. To compare model versions in PTC Creo Elements/Direct Modeling:

1. Select a model or an object in the Structure Browser.

2. Right-click the selected model and click Windchill Workgroup Manager >
Compare Model Versions.

A load UlI, which is preset to display the different versions of the same model in
Windchill Commonspace, allows you to select the specific compare version and
load it into Modeling.

PTC Creo Elements/Direct Modeling:
Delay PTC Windchill Autonumbering of
Objects

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling
Benefit

You can set a preference to assign PTC Windchill numbers to PTC Creo Elements/
Direct Modeling objects only when you save the objects and not when you create
the objects.

Additional Details

This ensures that PTC Windchill numbers are not assigned to transient objects that
are created in a Modeling session but are not saved. Delaying PTC Windchill
autonumbering also improves performance in operations, such as Sheet Metal, that
create a large number of transient objects. It prevents the need to contact the PTC
Windchill server to assign each transient object with a PTC Windchill number.

PTC Creo Elements/Direct Modeling:
Improved Performance for PDM Actions
on Small Sets of Objects in Large

Workspaces

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling
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Benefit

Shorter response time of PDM actions through optimized and idle-time workspace
refresh with respect to server information (commonspace).

Additional Details

Previously, a workspace refresh was executed at the end of each PDM action. This
added a performance penalty to PDM actions that scaled with the number of
objects in the workspace. Now, the workspace refresh is postponed to the PTC
Windchill Workgroup Manager client idle period after completion of a PDM
action. The workspace refresh performance benefits from the featured object
display, which refreshes only those objects that are shown in the current view.

PTC Creo Elements/Direct Modeling:
Improved Top Level Instance

Visualization

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling

Benefit

Top level instances in PTC Windchill that are related to content objects which are
modified in a Modeling session, can be automatically checked in with the
modified content object. This ensures that PTC Creo View representations for the
related top level instances are regenerated by the PTC Windchill Visualization
Service, reflecting the correct geometry.

Additional Details

The behavior is controlled by the new Update Top Level Instances preference. Set
to No (default) or Iterate. The Manage Top Level Instances preference has a new
option, All, that allows you to request top level instance generation irrespective of
instance data changes.

Previously, PTC Creo View representations for top level instance objects were not
updated when related content objects underwent changes such as geometry
modifications. As a result, users only had the following options for reviewing
objects with top level instances:

» Inspect the Creo View viewables of the instance objects, showing correct
instance information (such as color or position), but with potentially outdated
geometry.

» Inspect the Creo View viewables of the content objects, reflecting the content
modifications correctly, but not using the instance information.
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PTC Creo Elements/Direct Modeling:
Locking or Unlocking Objects in
Workspace or CAD Application

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling

Benefit

Locking a workspace object gives it a read-only status in the workspace and in a
Creo Elements/Direct Modeling session. You can lock as well as unlock an object,
either from an active workspace in PTC Windchill Workgroup Manager or the
CAD application.

Additional Details

You may want to make an object read-only to:
* Avoid inadvertent modification

* Prevent the object from being saved

With PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling, users can locally modify models in the CAD session without checking
out the models. However, if designers want to prevent such inadvertent or
unwanted changes, they can set the Automatically lock objects added to workspace
preference to Yes, so that checked-in objects are automatically locked in the
Modeling session and the workspace.

From the PTC Windchill Workgroup Manager client, you can individually lock
instance or content objects to selectively prevent instance or content
modifications, respectively.

PTC Creo Elements/Direct Modeling: Use
Windchill Part Product Structure for BOM
Tables and Position Flags on Annotation

Drawings

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling
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Benefit

The new BOM Report action Export List to PTC Creo Elements/Direct Modeling
allows you to send a Windchill part BOM directly to a Modeling session that is
connected to PTC Windchill Workgroup Manager. You can then use the Windchill
part BOM to draw BOM tables or create position flags on Annotation drawings.

Additional Details

The new BOM transfer action is available in the embedded browser of the PTC
Windchill Workgroup Manager client for the following BOMs:

* Single-Level BOM

* Single-Level BOM with Notes

* Multi-Level BOM

*  Multi-Level BOM with Replacements

The columns configured in the BOM Report view determine the Windchill part
attributes that are sent to Annotation. The Annotation module comes with sample
BOM Table layouts (WGM-DIN, WGM-ISO, WGM-Custom) that you can
customize. You can also customize the list of Windchill BOM attributes that are
available for text reference assignment in the BOM table layout UI (user
interface).

PTC Creo Elements/Direct Modeling:
Workgroup Manager Notifications for
Objects with Out-Of-Date Information with

Respect to the Commonspace

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling

Benefit

PTC Creo Elements/Direct Modeling users now receive notifications for relevant
status changes of models, which are loaded in the CAD session; for example, a
new version checked in by another user triggers a notification.

Additional Details

Notifications are received as pop-up messages also shown in the PTC Windchill
Workgroup Manager client message area. Out-of-date information is reflected in
the Status column of the Modeling Structure Browser in Windchill view. With the
new ‘Out of Date’ filter, you can easily locate those models that need an update.
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Notifications are triggered periodically after a workspace refresh with respect to
server information (commonspace). For an immediate status check:

» To refresh an individual object or model:

1. Select a specific object in the Modeling Structure Browser.

2. Right-click the selected object and click Windchill Workgroup Manager >
Refresh.

* To refresh all models in the session, click File » Workgroup Manager » Refresh
All.

PTC Creo Elements/Direct Modeling, PTC
Creo Elements/Direct Drafting: Enhanced
Format Conversion of the New Creo View

Adapter and CAD Workers

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling, PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Drafting

Benefit

You can now automate the conversion of 2D drawings and 3D models into a
variety of standard and native geometry formats and additional viewing formats
using the PTC Windchill Visualization Service (WVS), enhanced PTC Creo View
adapter, and PTC Creo Elements/Direct CAD workers.

Additional Details

With enhancements to the PTC Creo View adapter for PTC Creo Elements/Direct,
you can now configure the Drafting and Modeling CAD workers to generate
additional file formats. Controlled by publishing rules, the PTC Windchill
Visualization Service (WVS) can automatically publish additional file formats,
which can be accessed from the Representations view in PTC Windchill.
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PTC Creo Elements/Direct Modeling, PTC
Creo Elements/Direct Drafting: Model
Manager to PTC Windchill Text Reference

Mapping

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling, PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Drafting

Benefit

For PTC Creo Elements/Direct drawings migrated from PTC Creo Elements/
Direct Model Manager to PTC Windchill, you can dynamically map PTC
Windchill attributes to Model Manager text references where applicable. This new
customization capability can help you to reduce the effort of manually changing
text references for a potentially large number of drawings migrated from Model
Manager to PTC Windchill.

Additional Details

You can enable text reference mapping for Model Manager and PTC Windchill
attributes with same names, or individually define the mapping of Model Manager
text references to specific PTC Windchill attributes using the following functions
or commands:

* For Modeling/Annotation, new LISP functions in the uwgm customize
2d file.

* For Drafting, new commands in the uwgm customize drft.m file.

PTC Creo Elements/Direct Modeling, PTC
Creo Elements/Direct Drafting: Open Creo
Elements/Direct Drawings in PTC
Windchill with Modeling and Drafting
Workgroup Manager

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling, PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Drafting
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Benefit

Drafting users can now work with drawings saved through the Modeling
Workgroup Manager, and Modeling (Annotation) users can open drawings
generated with Drafting and the Drafting Workgroup Manager.
Additional Details

Previously, there was a strict separation between the Drafting and Modeling
Workgroup Managers so that you could open PTC Creo Elements/Direct drawings
(.mi files with authoring application COCMOD or CODDRAFT) in the respective
CAD application (Modeling/Annotation or Drafting) only.

PTC Creo Elements/Direct Modeling, PTC
Creo Elements/Direct Drafting: Support
Attributes of Type Real Number with Units
in the Workgroup Manager

Product: PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Modeling, PTC Windchill Workgroup Manager for PTC Creo Elements/Direct
Drafting

Benefit

PTC Windchill Workgroup Manager for PTC Creo Elements/Direct Modeling
now enables you to exchange custom attributes of type real number with units
between PTC Windchill and Modeling or Drafting. If you use both Creo and PTC
Creo Elements/Direct with PTC Windchill, you can now capture common
parameters with units, such as weight, in both CAD applications, as well as map
them to the same custom attribute with units in PTC Windchill.

Additional Details

You can use attributes of type real number with units to display their values in
PTC Windchill as text references on Annotation and Drafting drawings. You can
customize the Structure Browser in Modeling to show, allow editing, and send
modified values back to PTC Windchill.

PTC Windchill Workgroup Manager
Documentation Consolidation and

Restructuring
Product: All PTC Windchill Workgroup Managers
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Benefit

Documentation for PTC Windchill Workgroup Manager is delivered in the PTC
Windchill Help Center available on your company’s PTC Windchill server.

Additional Details

With this enhancement, you no longer need to install a separate PTC Windchill
Workgroup Manager Help Center. This consolidation enables you to easily
navigate between PTC Windchill and PTC Windchill Workgroup Manager topics,
and take advantage of the PTC Windchill Help Center search.

You can access the PTC Windchill Help Center from the PTC Windchill
Workgroup Manager client using Help » Help Center:

PTC Windchill | Product Lifecycle Management | PTC (Active) - 0O x

File View Go Navigator Tools Window H

=) & 50 7 Help Center N

Common Folders Address | nttg:fvww.pte.cl Whats New? Open the Help Center - &
Technical Support Information o
About Windehil Workgroup Manager B g

PTC

PTC Windchill

Home > Product Lifecycle Management > PTC Windchill

In addition, the contents of the PTC Windchill Workgroup Manager
documentation have been reorganized to consolidate basic information that applies
to all CAD applications in one section. Installation documentation has been
consolidated in the PTC Windchill Workgroup Manager Installation Guide,
available from the product root directory and on the Reference Documents page
at: https://support.ptc.com/appserver/cs/doc/refdoc.jsp.

Highlights of the reorganization include:

» The introductory material describes basic concepts that are applicable to all
integrations that use PTC Windchill Workgroup Manager. It includes the
overview, getting started, and common information about PTC Windchill
preferences.

* Now, PTC Windchill Workgroup Manager is installed using a new dedicated
installer. The Installation section has been removed from the individual PTC
Windchill Workgroup Manager guides, and has been consolidated in the PTC
Windchill Workgroup Manager Installation Guide, available from the product
root directory and on the Reference Documents page at: https://support.ptc.
com/appserver/cs/doc/refdoc.jsp.
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» For each integration, the top page of the section in the PTC Windchill Help
Center provides quick links to the major sections for this application:

A Integration with Other Applications

Managing CAD Data

Managing CAD and Part Structures in Windchill

@ Using Creo Parametric with Windchill

=) Windchill Workgroup Manager Help Center Overview
Introduction to Windchill Workgroup Manager
Autodesk Inventor
AutoCAD
CADDS 5
CATIA V5
Creo Elements/Direct Drafting
Creo Elements/Direct Modeling
Creo Illustrate
Creo Schematics
ECAD
Cadence Design Team Option
Arbortext IsoDraw
Mathcad
NX
SolidWorks
€ Windchill Workgroup Manager Toolkit

* A PDF version of the PTC Windchill Workgroup Manager guide for each
application is also available on the Reference Documents page at: https://

support.ptc.com/appserver/cs/doc/refdoc.jsp. The PDF version contains only
information specific to your integration.
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PTC Windchill Workgroup Manager
Toolkit: New and Enhanced Toolkit API
Functions to Read Subfolder Structure,
Enable Export From Workspace, Register
or Unregister Authoring Applications, and
Access PTC Windchill File System

Product: PTC Windchill Workgroup Manager Toolkit

Benefit

New and enhanced PTC Windchill Workgroup Manager Toolkit API functions
enable the following operations: programmatically (automatically) read PTC
Windchill folder and subfolder structure information, programmatically export
objects from workspace to local file system, register or unregister authoring
applications, access to PTC Windchill File System, and the ability to copy or
delete files in the PTC Windchill File System.

Additional Details

A new API function “UwgmFolderReader” is introduced to programmatically
read PTC Windchill folder structure information.

~ Note

The API function UwgmFolderReader only reads the folder and subfolder
structure or information. It does not read the contents of the folder.

A new API function enables you to programmatically export objects from
workspace to the local file system.

A new API function registers and unregisters authoring applications, so you can
ensure that users configure their clients correctly. The API also enables you to list
all registered authoring applications.

A new API function is introduced so that PTC Windchill Workgroup Manager
Toolkit has access to the PTC Windchill File System and can copy or delete files
in the PTC Windchill File System.
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PTC Windchill Workgroup Manager
Toolkit: Removing Dependency on PTC
Libraries for CATIA VS

Product: PTC Windchill Workgroup Manager Toolkit

Benefit
Removing dependency on PTC libraries for CATIA V5-side customization.

Additional Details

To remove dependencies on PTC libraries, from the make (.mk) file, the following
library files have been removed:

* baselibmtz.lib
* cipsoapmtz.lib
* cipstdmtz.lib

* rtlcoremtz.lib

The signature of the method that could be invoked through PTC Windchill
Workgroup Manager Toolkit was modified to use only standard ‘stl’ types, as
shown in the following example: void method to call (const
map<wstring,wstring>& in, map<wstring,wstring>& out).

SolidWorks: Autonumbering of Mirrored

Components
Product: PTC Windchill Workgroup Manager for SolidWorks

Benefit

Parts created using the SolidWorks Mirror Components command are allocated
autonumbers in the same way as parts created using File » New in SolidWorks.
Once the autonumber has been applied to the mirrored component, the new part
can be uploaded and checked in like any other file.

Additional Details

Previously, when PTC Windchill PDMLink autonumbering was enabled, new
components created using the Insert » Mirror Components » Opposite Hand
Version command in SolidWorks were not autonumbered. This enhancement
applies autonumbers to mirrored components, and the new part can be uploaded
and checked in like any other file. When there are multiple mirrored files (for
example, in the mirroring of an assembly) all files created with Opposite Hand
Version are saved with PTC Windchill autonumbering.
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~ Note

PTC Windchill autonumbering is not provided for Derived Configurations or
suppressed Mirror Components as part of this enhancement.

SolidWorks: Enable SolidWorks BOM

Item Number Propagation to Windchill
Product: PTC Windchill Workgroup Manager for SolidWorks

Benefit

Expose Line Numbers or Find Numbers from SolidWorks designs into the
engineering BOM in PTC Windchill as reference designators, which can be
transferred to downstream business applications such as ERP. Support for
mapping SolidWorks BOM Item Number information to EPM Document Usage
Link attributes helps the overall process for traceability of components through
the product life cycle from design to manufacturing.

Additional Details

This enhancement propagates the BOM item number information in SolidWorks
to “Find Number” and/or “Line Number” of a Part Structure in PTC Windchill. In
this downstream process, the BOM item information in SolidWorks components is
propagated to the CAD Document Uses Link Attribute.

When a SolidWorks assembly is saved, component attributes are assigned to each
component separately.

The name of an attribute on the CAD Document Uses Link that should be copied
to the Part Usage’s Find Number or Line Number is defined in PTC Windchill
Preference Management. Navigate to EPM Service Preferences > Build Service
Preferences > Find Number Attribute (or Line Number Attribute) and define the
attribute in the Value field.
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